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About this document

© Sectra Imtec AB, Sweden, 2006

Disclaimer

Sectra Imtec AB is not responsible for problems caused by changes in the operating
characteristics of the computer hardware or operating system, which are made after
the delivery of the software, or for problems that occur as a result of the use of Sectra
software in conjunction with non-Sectra software other than the ones explicitly
covered in this documentation. For a complete description of warranty, refer to the
End User License Agreement supplied with the Sectra PACS product.

Feedback

As part of our commitment to provide the highest quality products and services, we
would like to encourage feedback on the quality of this documentation.

If you think we can improve this document in any way, then please send your
suggestions to <info.imtec@sectra.se>.

iiIDS5, Version 11.1, December 2006 About this document



Contents

About this document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  ii

1 Disclaimer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ii

2 Feedback . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ii

1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

1.1 Intended use . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1.2 Precautions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

1.3 General safety regulations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

1.4 Getting help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

1.5 About IDS5 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

1.6 Related documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2 Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

2.1 What's new in IDS5 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

2.2 Starting IDS5 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

2.3 Concurrent user limit warning . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

2.4 Exiting IDS5 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

2.5 Changing Password . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

3 System Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

3.1 The Information Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

3.2 The Matrix Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

3.3 The Image Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

3.4 The Quick Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

3.5 The Print Previewer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

3.6 The Queue Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

4 Key Concepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

4.1 System, Role & User . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

4.2 Worklists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

4.3 Default Display Protocols (DDP) . . . . . . . . . . . . . . . . . . . . . . . . . . 21

4.4 Teaching Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

4.5 Stacks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

4.6 Scheduled Demonstrations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

4.7 Collections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

4.8 Key Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

iiiIDS5, Version 11.1, December 2006 Contents



4.9 Concurrent User Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

4.10 Roaming Desktop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

5 Using the Information Window . . . . . . . . . . . . . . . . . . . . . . . . . .  24

5.1 Working with Worklists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

5.2 Working with Patients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

5.3 Working with Examinations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

5.4 Mismatch handling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

5.5 Scanned documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

5.6 Import and export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

6 Using the Matrix Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  73

6.1 Matrix Window Organization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

6.2 Arranging Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

6.3 Adjusting Image Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

6.4 Applying a presentation (manual or DDP) . . . . . . . . . . . . . . . . . . . . 82

6.5 Creating a DDP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

6.6 Creating a Manual Presentation . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

6.7 Working with text notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

6.8 Deleting images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

7 Using the Image Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  95

7.1 Image Window Organization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

7.2 Image symbols . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

7.3 Operations on Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

7.4 Operations on Stacks, Collections and Multiframe Sequences . . . . . . 109

7.5 Key Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

7.6 Synchronizing Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

7.7 Adjust images individually . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

7.8 Performing Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

7.9 Putting Annotations in an Image . . . . . . . . . . . . . . . . . . . . . . . . . . 125

7.10 Overlay plug-ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

7.11 Navigating among Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

7.12 Fetching Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

7.13 Image Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131

7.14 Viewing Virtual 3D Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

7.15 Image Addition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

7.16 Slab view . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

7.17 MPR - Multiplanar reconstruction . . . . . . . . . . . . . . . . . . . . . . . . . 137

7.18 3D - Volume rendering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137

7.19 The NM Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137

7.20 Color Palettes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

ivIDS5, Version 11.1, December 2006 Contents

Contents



7.21 Clinical Applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

7.22 Mammography screening . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

7.23 Mammography CAD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141

7.24 DICOM Presentation States . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

7.25 Compressed images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144

8 Using the Quick Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145

8.1 Special Commands in the Quick Window . . . . . . . . . . . . . . . . . . . . 145

9 Using the Stack Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  147

10 Additional Functionality . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  151

10.1 Park and restore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151

10.2 Printing images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151

10.3 Reject analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154

10.4 Dimming windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157

11 Sample Workflows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  159

11.1 A technician Prepares a New Examination . . . . . . . . . . . . . . . . . . . 159

11.2 A radiologist Views a Case . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160

11.3 A radiologist Views a Mammography Case . . . . . . . . . . . . . . . . . . . 161

12 Setting Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163

12.1 Configuration structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163

12.2 Configuring Menus and Toolbars . . . . . . . . . . . . . . . . . . . . . . . . . 164

12.3 Configuring General Properties . . . . . . . . . . . . . . . . . . . . . . . . . . 166

12.4 Configuring Image Display Properties . . . . . . . . . . . . . . . . . . . . . . 169

12.5 Configuring Image Tools Properties . . . . . . . . . . . . . . . . . . . . . . . 171

12.6 Configuring Stack Viewing Properties . . . . . . . . . . . . . . . . . . . . . . 175

12.7 Configuring Windows Properties . . . . . . . . . . . . . . . . . . . . . . . . . 176

12.8 Configuring Search Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . 179

12.9 Configuring License Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . 181

12.10 Configuring Interaction Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . 182

12.11 Configuring exam type specific settings . . . . . . . . . . . . . . . . . . . . . 183

12.12 Configuring dictation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184

A What's new IDS5 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  186

A.1 What´s new 11.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186

B Command short-cuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  196

B.1 General short-cuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196

B.2 Information window short-cuts . . . . . . . . . . . . . . . . . . . . . . . . . . . 196

B.3 Matrix window short-cuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

B.4 Image window short-cuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

vIDS5, Version 11.1, December 2006 Contents

Contents



B.5 Quick window short-cuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200

B.6 Stack Tool short-cuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202

C Workstation test specification IDS5 . . . . . . . . . . . . . . . . . . . .  203

C.1 Disclaimer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203

C.2 Test information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203

C.3 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204

C.4 Testing instructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205

C.5 Comprehensive tests . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 206

C.6 Workstation specific tests . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 208

C.7 Testing additional services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215

C.8 Testing auxiliary equipment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 218

viIDS5, Version 11.1, December 2006 Contents

Contents



1 Introduction

The following topics are included in this chapter:

■ Intended use

■ Precautions

■ General safety regulations

■ Getting help

■ About IDS5

■ Related documents

The IDS5 User's Guide provides references and important information on how to
use IDS5 effectively. This manual is therefore intended for end users of the product,
such as radiologists, radiological technicians and/or nurses.

In order to make best use of this User's Guide, we strongly recommend that you
read and familiarize yourself with it in its entirety.

1.1 Intended use

This section contains description of intended purpose as required by the Medical
Device Directive 93/42/EEG for the European market, also known as Indications
for Use as required in the Quality Systems Regulation 21 CFR Parts 808, 812, and
820 for the American market:

The Sectra IDS5 device is intended for the manipulation and displaying of medical
images, including mammograms.

It can show images from different modalities and interfaces to various image storage
and printing devices using DICOM or similar interface standards. Device options
make possible mammography reading, telecommunications; fast demonstration;
prosthesis CAD; 3-D and angiography, etc.; and teleconferencing. Lossy compressed
mammographic images are not intended for diagnostic review. Mammographic
images should only be viewed with a monitor approved by FDA for viewing
mammographic images.

Typical users of this system are trained professionals, including but not limited to
physicians, radiologists, nurses, medical technicians, and assistants.
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1.2 Precautions

For instructions about safe use of this product, please refer to the section 1.3 General
safety regulations.

Important: If any changes are made to the workstation where IDS5 is running, or its
environment, you must verify that IDS5 still works well. Changes include the
installation of e.g. other software applications, operating system updates or
hardware devices. The verification must be done according to the appendix C
Workstation test specification IDS5. The product's CE Marking on European
Conformity of Safety becomes invalid if this verification is not performed.

1.3 General safety regulations

Please observe the following important safety points when using Sectra products:

• Make sure you follow the recommendations provided by the supplier of all
hardware equipment that is used together with Sectra products.

• It is essential that you understand how to use the products properly before using
it for any patient examinations. Only use the products for applications for which
you have been properly trained. Do not use the products for any purpose other
than those for which they are intended.

• Do not use the products with any other products except for those that the
supplier of your PACS recognizes as compatible.

• Operation of the products without proper training, for unintended purposes or
with incompatible equipment could lead to fatal or other serious personal injury.

1.4 Getting help

Sectra IDS5 provides powerful online and context sensitive help at your fingertips.
These resources are described here.

1.4.1 Online help

You can, at any time, access this user's guide online. In the online help you will find
all the documentation about the application.

Using online help

1. From the Help menu, select Help.

• Contents - The contents tab shows a tree view of the online help. It allows
for drilling down from the top level chapters to the underlaying sections.

• Index - The index tab lists all section headings and index terms
alphabetically.
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• Search - The search tab allows searching for any word in the online help.
Enter the word or phrase and click List Topics to get a list of all
occurrences. E.g. if you do a full-text search on the word "report," every
topic that contains the word "report" will be listed.

Note: All languages do not support all help functions.

1.4.2 Context sensitive help

By selecting theOn context command from theHelpmenu you can get help with
a specific command. When you select On context the mouse pointer will have a
question mark attached to it. This indicates that you now are in help mode. When
you click on a command, instead of executing the command, the reference manual
will open at the location where the command in question is documented.

1.5 About IDS5

Warning: Note for the United States: Federal law restricts this device to sale by or on the
order of a physician.

IDS5 (Image Display System, version 5) is the name of a product family. The IDS5
products are multi-modality viewing software for viewing and handling medical
images.

IDS5 operates under Windows 2000 and Windows XP.

Read about hardware requirements for IDS5 in the System Requirements Sectra
PACS [2] document.

You can find more specific information about this IDS5 Workstation by selecting
theAbout... command from theHelpmenu. The pop-up dialog shows information
mostly useful for the Sectra support staff:

• Version shows the current software build number that this IDS5 is running.

• Year of Release shows in what year this IDS5 was released.

• Installed modules modules shows which modules are installed on this IDS5.

1.5.1 Products

This guide covers the following IDS5 products:

IDS5/dx.net A multi-modality software designed for use by radiologists, i.e.
mainly for primary viewing and reporting. IDS5/dx.net usually
runs on a powerful PC workstation with two, three, or four
monitors.

IDS5/mx.net A multi-modality workstation optimized for primary reading of
mammography images. IDS5/mx.net usually runs on a three
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monitor system, with two high resolution monitors for the
images.

IDS5/qa.net Designed to be a capable workstation for the radiology
technician to perform quality assurance, image manipulation,
and image arrangement. The Sectra PACS workstations feature
a hanging concept where image manipulation and arrangement
are stored to provide efficient reading by the radiologist.

IDS5/mqa.net Designed to be a capable mammography workstation for the
radiology technician to perform quality assurance, image
manipulation, and image arrangement. The Sectra PACS
workstations feature a hanging concept where image
manipulation and arrangement are stored to provide efficient
reading by the radiologist.

IDS5/cl.net An advanced review workstation designed for use by clinic
assistants or nurses. It is typically an IDS5/dx.net with limited
functionality, i.e. no archive access, but access only to relevant
pre-determined images. It provides basic yet fast viewing.

IDS5/doc.net Used for scanning documents into the PACS. As it has the same
user interface as the other IDS5 products, it can easily be
incorporated in the hospital's workflow.

IDS5/home Intended for the radiologist's who works from home. Through
either pushing or pulling images the radiologist can use his home
computer for full quality diagnostic review.

IDS5/send Used to send radiology examinations to other facilities. For
instance, a satellite clinic that produces images but performs no
reviews can use IDS5/send to send the images for review at a
central hospital.
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1.5.2 Clinical Applications

For special needs, purpose-built Clinical Applications are available that integrate
with IDS5. You should only use Clinical Applications from Sectra, or 3rd party
vendors who are members of the Clinical Solutions Network™.

Disclaimer: Sectra takes no responsibility for the use of Clinical Applications from 3rd Party
Vendors, as these are not part of the Sectra IDS5 Workstation. Clinical Applications
from 3rd Party Vendors are software products activated from IDS5 workstations.
Clinical applications are normally started from the Clinical Applications sub-menu
in the right mouse button pop-up menu in the IDS5 image window.

The previously described procedure for starting Clinical Applications is only valid
for the default configuration of IDS5. However, it is possible for a user or WISE
administrator to change the layout of the user interface, thereby enabling other
options for starting Clinical Applications.

1.5.3 Speech Applications

The Sectra IDS5 Workstation can be used together with speech recognition
applications from 3rd party vendors.

Disclaimer: Sectra takes no responsibility for use of speech applications from 3rd party vendors,
as these are not part of the Sectra IDS5 Workstation. Speech applications from
3rd party vendors are software products that are started as separate applications
under Windows.

1.6 Related documents

[1] System Administrator's Guide IDS5

[2] System Requirements Sectra PACS

[3] Installation Guide IDS5

[4] Reference Manual IDS5

[5] Release Notes IDS5
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2 Getting Started

The following topics are included in this chapter:

■ What's new in IDS5

■ Starting IDS5

■ Concurrent user limit warning

■ Exiting IDS5

■ Changing Password

This chapter deals with how to start and exit the IDS5 application.

2.1 What's new in IDS5

Let us introduce version 11.1 of Sectra PACS. For information about the most
important new features in release 11.1 of Sectra PACS, as compared to 10.2, see
appendix A What's new IDS5.

2.2 Starting IDS5

Running the IDS5 Setup program, Setup automatically creates a new program group
and new program items in the Windows® Start menu. You are then ready to start
IDS5.

To start IDS5

1. From the Start menu, select the Sectra program group and click IDS5. The
screen shot below shows the Sectra program group and the IDS5 icon.
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The Sectra program group and icons.

2. Click the IDS5 icon to start the application. You will be presented with the
IDS5 login dialog. The login dialog box is shown below.
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The login dialog.

There are several different ways of performing a login to the IDS5. The standard
way of logging in, also called manual login, is to have a username and password.
If a WISE/lock security device is connected to your Workstation, it may be
possible to use other login devices, i.e. a card or fingerprint reader.

To perform a login

1. In the User name field, type your user name.

2. In the Password field, type your password.

3. Click the OK button.

Note: You can reset your preferred language to the default language and log in at
the same time by holding down the SHIFT key and click OK.

The IDS5 Information Window will be opened. If you are using a WISE/lock

security device, click the checkmark button to switch to WISE/lock login.

If IDS5 is configured to use a fingerprint reader, the login dialog box will appear
as follows (see below).
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The fingerprint login dialog.

To perform a fingerprint login

1. Place your finger on the fingerprint reader. If you do not want to login with
your fingerprint click theCancel button to switch to the standard login dialog.

If your fingerprint is matched successfully the IDS5 Information Window will
appear. If it does not match, you can either choose to try again, do an enrollment
of your finger, or switch to password login. Sometimes a fingerprint does not
match because your finger, or the fingerprint reader is dirty. Clean them both
and try again.

To enroll your fingerprint

Enrolling your fingerprint involves placing your finger on the fingerprint reader
three times in order to create a generalized fingerprint reading. This is done in
order to achieve a more accurate reading and reduce image noise.

1. Apply your finger on the fingerprint reader and lift it when IDS5 tells you to.
Repeat two more times.

2. IDS5 has made three different fingerprint records and will now try to create a
single generalized one.

3. If the generalization fails, return to step 1.
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4. If the generalization is successful, you can verify your enrolled fingerprint by
typing your user name and password.

2.3 Concurrent user limit warning

If the warning: "Usage limits have been exceeded for some concurrent users licenses.
The following licenses could not be fetched from the server:" is shown, one of the
two following scenarios has occurred:

1. There is no basic product available, e.g. all available licenses for the product
you have requested are currently being used by your colleagues. Please wait
until a colleague logs out or contact your system administrator.

2. Not all add-ons are available, e.g. all available licenses for those particular
add-ons are currently being used by your colleagues. You can still work with
the basic product but not with the unavailable add-ons. For the add-ons to be
available please wait until a colleague logs out or contact your system
administrator.

For further information please refer to section 4.9 Concurrent User Engine,
section 4.10 Roaming Desktop and section 12.9 Configuring License Properties.

2.4 Exiting IDS5

When you have finished working you normally perform a logout from IDS5 to give
other users access to the Workstation. A logout can also occur automatically if the
system has been idle for an extended period of time or if you have logged in to
another workstation somewhere else.

To perform a logout

1. From the File menu, select Logout.

The login dialog appears.

Usually there is no need to exit IDS5. However, if you are installing new
equipment, or in cases of system errors it might be necessary to quit the entire
application.

To exit IDS5

1. From the File menu, select Logout.

2. In the login dialog, click Exit.

You will return to Windows.
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2.5 Changing Password

To change your password

1. From the File menu, select Change password....

2. In the Change Password dialog, enter the old password, the new password
twice and then click OK.

You have now changed your password.

Note: The following characters are prohibited in passwords.

space"'`)(;¨=^><&|\
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3 System Overview

The following topics are included in this chapter:

■ The Information Window

■ The Matrix Window

■ The Image Windows

■ The Quick Window

■ The Print Previewer

■ The Queue Window

This section provides an overview of the different windows in the IDS5 application,
describes what kind of information the different parts of the windows show, and
illustrates the tasks that can be performed.

3.1 The Information Window

The Information Window enables you to view all information, apart from the
full-size images, for any patient in the PACS.

The Information Window is primarily used for handling the higher layers of the
data structure used by IDS5, i.e. worklists, patients, requests, and examinations.
Retrieval of examinations from the archive is also done using the Information
Window.

The main purpose of the Information Window is to provide an overview of the
current worklist, and to select patients for image viewing.

The figure below shows the main elements of the Information Window.
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The Information Window.

The Information Window consists of the following elements:

• Menubar (1) — Commands are available in drop-down menus on the menubar.

• Toolbar (2) — The configurable toolbar contains icon shortcuts to some of the
commands available in the drop-down menus on the menubar.

• Worklist View (3) — Displays all available worklists.

• Patient List (4) — Displays all patients for the currently available worklist.

• Examination List (5) — Displays examinations for the currently selected patient.

• Series List (6) — The series of images for the currently selected examination
are represented by thumbnails in the series list. Double-clicking on a thumbnail
opens the Quick Window, displaying a full screen version of the thumbnail
image.

• Report View (7), Request View (8) — Information for the request which
corresponds to the currently selected examination, is displayed in the extreme
right of the window. Electronic and scanned requests are shown here in the
request view, and all reports for the request are shown in the report view.
Double-clicking on a scanned request opens a fullscreen version of the scanned
document.

• Fetching RIS data status (9) — The status bar shows when RIS data is being
fetched.

• Preload status (10) — The status bar shows when preload of images is in
progress.
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3.2 The Matrix Window

The Matrix Window is used for organizing the relevant images for a patient. It is
also convenient for obtaining an overview of the images in the examination request.

The figure below shows the main elements of the Matrix Window.

The Matrix Window.

The Matrix Window consists of the following elements:

• Menubar (1) — Commands are available in drop-down menus on the menubar.

• Toolbar (2) — The configurable toolbar contains icon short cuts to some of
the commands available in the drop-down menus on the menubar.

• Patient Text View (3) — This area shows the personal ID, name and date of
birth for the current patient.

• Matrix (4) — Below the patient text view and the miniature screens is the matrix.
The matrix consists of a number of rows, one for each examination. Each row
begins with an examination text view, showing some data about each examination.
Series icons are located to the right of the examination text view and each
represents one series in the examination. At the bottom and right side of the
matrix there might be scrollbars to allow scrolling in the matrix, if some icons
do not fit on the screen. Note: If examination wrapping is used, the series icons
may be wrapped onto several rows within each examination. However all series
icons within a single examination should be regarded as located on the same
matrix row, even though they may be wrapped onto several physical rows. To
learn more about configuring examination wrapping, please refer to section 12.7
Configuring Windows Properties.

• Collapsed exams (5) — Examinations which are not included in the presentation
(according to the DDP or manual presentation) are collapsed.
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• Miniature screens (6) — The miniature screens symbolize the screens of the
computer where the radiologist will view the images for this case.

• Presentation Selector (7) — This drop-down menu shows the currently selected
DDP or manual presentation.

• Recycle bin and Reject bin (8) — The recycle bin is used for permanently
deleting images. The reject bin is used for deleting images from this examination
but allowing the rejected images to be analyzed at a later time.

Important: For information on warning symbols next to the presentation selector, see
section 6.4 Applying a presentation (manual or DDP).

3.3 The Image Windows

The Image Windows are used by the radiologist or clinician for the actual clinical
viewing of the images. Images can be manipulated in an Image Window and a
number of images can be displayed at once in different formats.

The figure below shows the main elements of the Image Window.

An Image Window.

An Image Window consists of the following elements:

• Menubar (1) — Commands are available in drop-down menus on the menubar.

• Toolbar (2) — The configurable toolbar contains icon short-cuts to some of
the commands available in the drop-down menus on the menubar.

• Series in stack mode (3) — this partition shows a series of images in stack mode
with a scanogram in the bottom right corner of the image. The visible image
is denoted in the scanogram by a white line.
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• Series in tile mode (4) — This partition show a series of images which has been
tiled (2x2), with a scanogram in the bottom right corner. The visible images are
denoted by white lines in the scanogram.

• Zoom to fit (5) — The size of this image has been zoomed to fit the partition.

• Zoomed with pan overlay (6) — This partition shows a section of the image
which has been enlarged using the zoom function. The rectangle in the lower
right corner represents the entire real image with the viewport or visible area
of the image (a smaller rectangle) superimposed upon it.

The Image Window can be partitioned in different ways. Supported partitions are
1x1, 1x2, 1x3, 2x1, 2x2, 2x3, 3x1, 3x2 and 3x3. The 1x1 partition means that only
one image appears on the screen. A 1x2 partition means that two images appear side
by side on the screen, i.e. that the window comprises two parts. The figure above
shows a 2x2 partitioning. It can be configured to toggle between the current partition
mode and 1x1 mode by using a mouse double-click combination. Read more about
this in section 12.5 Configuring Image Tools Properties.

Important: For information on warning symbols next to the presentation selector, see
section 6.4 Applying a presentation (manual or DDP).

3.4 The Quick Window

The Quick Window is the window that pops up when you double-click on an
image-thumbnail in the Information Window, or an image-icon in the Matrix
Window (unless you have configured the Image window to be opened for these
operations). The Quick Window is used for applying settings, such as grayscale
settings, on a single image.

The figure below shows the main elements of the Quick Window.
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The Quick Window.

The Quick Window consists of the following elements:

• Menubar (1) — Commands are available in drop-down menus on the menubar.

• Toolbar (2) — The configurable toolbar contains icon short-cuts to some of
the commands available in the drop-down menus on the menubar.

• Image Display (3) — The selected image is shown in the remainder of the
display.

Using the right mouse button, you can select various actions to perform on the
image. Any action will then be performed simultaneously on the image's icon in the
Matrix window.

3.5 The Print Previewer

The main purpose of the Print Previewer is to show what the print-out will look
like when printed and it allows you to effectively and precisely control your
print-outs. This facility lets you select a suitable partitioning, i.e. how many rows
and columns with images the print-out should have. It also enables you to perform
an automatic partitioning based on the modality of the first image. In the Print
Previewer most of the image window commands can be performed on each separate
image, like zooming, cropping, setting grayscale, flipping and rotating the image.

The figure below shows the main elements in the Print Previewer Window.
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The Print Previewer.

The Print Previewer consists of the following elements:

• Menubar (1) — Commands are available through drop-down menus from the
menubar.

• Toolbar (2) — The configurable toolbar contains icon short-cuts to some of
the commands available through the drop-down menus on the menubar.

• Printer selection box (3) — Here you select which printer to use.

• Image area (4) — This is the most important part of the Print Previewer and is
where the image parts are shown. The image area is a miniature of the real
print-out.

18IDS5, Version 11.1, December 2006 System Overview

The Print Previewer 3.5



• The Print Previewer also has a status bar showing printer status (5), queue status
(6), auto status (7), and the name of the current printer (8).

• The configure button (9) makes it possible to configure your Windows printer.

The Print Previewer can be partitioned in different ways. Supported partitions are
everything from 1x1 to 5x5. The 1x1 partition means that only one image appears
on the screen. A 1x2 partition means that two images appear side by side on the
screen, i.e. that the window comprises two parts.

3.6 The Queue Window

The Queue Window is used for viewing the progress of certain tasks, like sending
teleradiology and archiving. It can also be used to retry jobs that have failed and to
cancel jobs.

The figure below shows the main elements of the Queue Window.

The Queue Window.

The Queue Window consists of the following elements:

• Queue tabs (1) — This is where you select which queue to view. Depending on
how the system is configured and set up, one or several queues will be available.
E.g. Teleradiology send, IDS5/home, Archive, Archive Compression, Archive
retrieve, Prefetch.

• Progress status selection (2) — Statuses for the jobs that are displayed in queue.

• Command buttons (3) — This is where you select to retry or stop certain jobs
in a queue.

• Refresh button (4) — Info about each queue is fetched with this button. Only
the currently showing queue will be updated.
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4 Key Concepts

The following topics are included in this chapter:

■ System, Role & User

■ Worklists

■ Default Display Protocols (DDP)

■ Teaching Files

■ Stacks

■ Scheduled Demonstrations

■ Collections

■ Key Images

■ Concurrent User Engine

■ Roaming Desktop

This section describes some of the key concepts in IDS5.

4.1 System, Role & User

The user concept in IDS5 comprises three levels: system, role, and user levels.
Objects such as worklists and presentations are connected to one of these levels.

Connecting objects to a user means that only that user can view the object, and the
object is not shown when another user is logged in to IDS5.

A user can be part of one or more roles, i.e. groups of users. Role objects can be
accessed by users that are part of that role, but not by other users. Rights to perform
certain tasks are given at role level. The set of rights for you as a user is the sum
(union) of rights for all your roles.

All users belong to the system level role. A system level object will therefore be
available for everyone.

Configurations are often connected to one of these three levels, e.g. the settings in
the Options dialog. Normally a user can only change his personal settings. If there
are conflicting settings, the User level configurations override role level
configurations, and the role level overrides the system level. For users that are part
of several roles, it is necessary to define the "Preferred role". If several role
configurations conflict, the configuration of the preferred role will be used. All user
and role settings are configured in WISE/tools by a system administrator.
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4.2 Worklists

A worklist is a set of examinations that a User is to work with. For instance, it could
be the set of cases that a radiologist is assigned to read. Which examinations are
included in a worklist is defined by a search criteria. For example, a worklist may
consist of all examinations originating from a specific modality.

Note: A worklist is dynamic, i.e. examinations may be added or removed over time.

Example: If the search criteria for a worklist is set to "modality is CT" all CT
examinations will be added to the worklist. If a new CT examination is added to the
PACS, this examination will automatically be included in this worklist.

You may sometimes see a reference to a "matched" examination. Matched
examinations in worklists are examinations that match the specific search criteria.

4.3 Default Display Protocols (DDP)

Default display protocols (DDPs) are used to automatically arrange images according
to your hospital's preferred layout principles. You will discover that DDP's will save
a lot of time that would otherwise be spent manually arranging images.

A DDP is a template, or a set of rules, that define which images should be displayed,
which settings should be used for these images, and which other examinations should
be displayed along with the current examination.

A DDP consists of the following components:

• Examination display choice — The DDP determines which examinations to
display together with the base examination. The base examination is usually the
most recent examination, and is used by the IDS5 to select the appropriate
DDP. Other examinations which are to be displayed are identified by
examination type and chronology. The order of examinations is not part of a
DDP, as examinations always are presented in chronological order.

• Number of monitors — Using a DDP makes it possible to define the number
of monitors used to display the images. When the IDS5 selects a DDP it first
checks the number of physical monitors on the Workstation, and where possible,
selects a DDP that uses the same number of virtual monitors.

• Hangings — A hanging is the arrangement of images on the screens, and is
comparable to image hangings on a light box. Apart from screen partitioning,
image settings are also part of the hanging. There can be several hangings for
each case. The full on-screen arrangement of a case, i.e. the group of hangings,
is called a presentation. Since the output of a DDP is a presentation, a DDP
automatically generates a full on-screen arrangement.

• Image/Series settings — You can determine the settings for images and for
series of images, within a DDP. Such settings include window settings, zoom
status, tile mode, choice of initial image, and whether or not a scanogram should
be displayed, etc.
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4.4 Teaching Files

Many radiologists today have a teaching file that consists of interesting examinations
used for educational purposes. When reading a particularly interesting case during
the course of normal work, the radiologist simply adds the examination to a teaching
file.

Another use of teaching files is at demonstrations. In many clinical situations,
demonstrations are a vital part of the radiologist's and the clinician's work.
Examinations performed in a radiology department are regularly displayed and
discussed by various medical professionals. In this case you use a teaching file with
the examinations to be discussed.

The difference between a teaching file and an ordinary worklist is that teaching files
are static, i.e. they are not based on any search criteria. Individual examinations have
to be explicitly added to a teaching file.

4.5 Stacks

In IDS5 a stack is a number of images taken on the same occasion by the same
modality. These images are handled together and are often treated as one single
image. For more information on stacks please see section 7.4 Operations on Stacks,
Collections and Multiframe Sequences.

4.6 Scheduled Demonstrations

To provide even more support for clinical demonstrations, it is possible to create
scheduled demonstrations. These are similar to ordinary teaching files in that they
are static, i.e. they are not based on any search criteria. Individual examinations have
to be explicitly placed in a scheduled demonstration.

A scheduled demonstration is more like a calendar than a single list of examinations,
as it can contain several occasions specified at certain dates and times. In addition,
the scheduled demonstration may have a schedule associated with it, for periodic
demonstrations. A schedule makes it easier to add examinations to a demonstration,
since the scheduled demonstration can guide the user to the next occasion according
to the schedule.

4.7 Collections

In IDS5 a collection is also a number of images, but here the images are selected
and assembled by the user. There are many similarities between stacks and
collections, but also some important differences. For example, a collection does not
normally have a scanogram associated with it.
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4.8 Key Images

In IDS5, the concept of Key Images can be used to mark important or interesting
images. Therefore, when viewing images you can use special commands to quickly
navigate among key images.

4.9 Concurrent User Engine

The Concurrent User Engine server add-on package enables every Sectra workstation
in the PACS to work according to a concurrent user model. This means that the
Concurrent User Engine will keep track of the number of simultaneous users and
allows all workstations in the PACS to start different types of IDS5.

4.10 Roaming Desktop

The Concurrent User Engine allows for a Roaming Desktop concept which presents
the same desktop to you regardless of which workstation you log on to. You will
get access to the same information, the same set of tools and settings as you are used
to. For example whenever a user of the role "technician" logs on an IDS5/qa.net
will start, if a user of the "radiologist" role logs on an IDS5/dx.net will start.
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5 Using the Information Window

The following topics are included in this chapter:

■ Working with Worklists

■ Working with Patients

■ Working with Examinations

■ Mismatch handling

■ Scanned documents

■ Import and export

The Information Window gives you an overview of all the information stored in
the PACS. To make it easier to find information about a certain type of patient,
you can create worklists that contain patients that match a certain search criteria.
You can browse through the examinations for each patient, look at requests and
reports, fetch images from the archive, etc.

This section provides information about how to use the functionality offered by the
Information Window to handle patient information in an effective manner.

5.1 Working with Worklists

All worklists and folders are displayed in the worklist view, see the figure below.
There are four categories of worklists:

• System worklists — These worklists and folders are common to all users. There
can also be a "Mismatched" worklist here. All examinations that can not be
matched against the RIS will end up here, see section 5.4.2 The "Mismatched"
worklist. Note that this worklist can only be seen in IDS5/dx.net, IDS5/qa.net
and IDS5/home.

• Role worklists — These worklists and folders are common to the users in your
role. There is a subfolder for each role that each user belongs to.

• User worklists — These worklists and folders are personal for the current user.

• Temporary worklists — Temporary worklists and search worklists will appear
here.

By double-clicking on a folder, the worklists in that folder are either expanded or
collapsed. In the figure below all folders are expanded. Select a worklist/folder by
clicking on it with the left mouse-button. The worklist/folder is then highlighted.
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The worklist view.

5.1.1 Creating a new worklist

Worklists are specified by a search criteria. All examinations that match the search
criteria will be placed in the worklist. The search criteria are specified in the Worklist
dialog box (see figure below).
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The Worklist dialog.

The Worklist dialog box consists of the following elements:

Servers Displays the available servers that can be searched.
The local WISE server is selected as the default. Click
on the servers you want to search.

Restriction The system administrator can impose restrictions that
prevent you from performing certain kinds of searches.
Any restriction is displayed in the restriction field.

Worklist definition Displays the current search criteria, in the form of a
tree structure. You enter a new criterion by clicking
theNew crit. button. A criterion input dialog appears,
where you enter the attribute (e.g. "Modality"), the
relation (e.g. "is"), and the value to compare with
(e.g. "CT"). Criteria can be grouped, this means that
a number of criteria are associated with a condition
that states "Match all criteria in group" or "Match any
criterion in group" (also known as AND and OR
operations). Adding a group is done by clicking the
New group button. New groups or criteria are always
added within the currently selected group. You can
organize the tree further by drag-and-drop of groups
or criteria. The currently selected group's condition
can be changed by the radio buttons Match all in
group and Match any in group above the tree box.
You can edit a criterion by double-clicking on it or
by clicking the Edit button. Clicking the Delete
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button removes the currently selected criterion or
group. TheClear all button clears the whole criteria.

Example: There is one group with the two criteria "Modality is CT" and "Modality
is MR" and the Match any in group radio button is checked for that group. In
addition, there is a criterion at root level that states "Examination age is less than
1 week". The Match all in group radio button is checked for the root level. This
definition will generate a worklist with examinations that are less than one week old
and either from a CT or an MR.

Be as specific as possible when defining the worklist. Imprecise criteria like "Body
part contains a" is cumbersome for the server to process. If such a worklist is used
often, it may affect the performance of the entire PACS. You should also avoid
worklist definitions containing only criteria with the comparators "contains", "is
not", "is not current user", "is defined" and "is undefined".

The comparator "is defined" means "has a value", or in other words "is not empty".
The comparator "is undefined" of course means the opposite. The comparator "is
not" is interpreted as "is defined, but is not equal to". In other words, an attribute
that has no value will not match an "is not" criterion. To find such examinations,
combine with an "is undefined" criterion. This is also the case with the comparator
"is not current user", which is interpreted as "is defined, but is not equal to the login
name of the currently logged in user".

Example: A criterion "Body part is not HEAD" will return all examinations that
have a defined value, that is not equal to HEAD. To also find the examinations that
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have no value at all for the body part attribute, the criteria should be "Body part is
not HEAD OR Body part is undefined".

Note: When using Archive Status as the search criteria, the displayed archive status
may differ from that chosen in the query. This is due to the way the IDS5 presents
archive status for an examination. If, for example, both an original and a copy of
an examination are available, IDS5 will set Archive Status to "Original" since "Original"
has higher priority than "Copy". The available Archive Status values are, ordered
by priority (highest priority first):

• Retrieving

• Sending

• Queued

• Failed

• Warning

• Original

• Archived

• Copy

• Undefined

Furthermore, when searching all examinations with a certain Archive Status,
preferably use additional criteria to narrow down the search. Otherwise the number
of hits will most certainly be too great. A suitable search expression could for
instance be "Archive Status is Original AND Date and Time is less than
10/28/2003 AND RIS Status is Signed".

To create a worklist

1. From the Tools menu, click Worklists and New Worklist....

The Worklist dialog appears.

2. Select which servers you want to search. The local WISE server is selected as
default, but you can change this by clicking on the servers you want to search.

3. Specify the search criteria.

4. Click the Save as button to save the worklist.

The Save as dialog appears.

5. Type in a name for the new worklist.

6. Select whether the worklist should be saved for personal, role or system use by
clicking in the drop-down list. Note that if you do not have permission to save
for role or system use, these alternatives will not be displayed in the drop-down
list. Note also that the name of the new worklist has to be unique, i.e. there
cannot be two worklists with the same name, on the same level, under for
example "System worklists".
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7. Click the Save button.

The new worklist will be saved and displayed in the Worklist View.

5.1.2 Creating reject worklists

Note: To be able to create, edit or use reject worklists, you must have the Reject Analysis
Package license and the Reject Analyze Series permission. This permission is
available on a per role basis and can be configured in WISE/tools by your system
administrator.

There are two special cases of a dynamic worklist applicable for sites employing
section 10.3 Reject analysis. These worklists work exactly the same as other dynamic
worklists, as described above, with the following addition:

Rejected worklists Only lists examinations containing rejected
series, i.e. lists examinations that have one or
several series with reject status Rejected new
or Rejected analyzed. There is also the
additional optional search criterion "reject
reason". These are useful e.g. for teachers to
illustrate how images should not be taken.

Reject analysis worklists Only lists examinations containing rejected
series that are to be analyzed, i.e. lists
examinations that have one or more series with
reject status Rejected new. There is also the
additional optional search criterion "reject
reason". These are used when performing
reject analysis.

To create a reject worklist

1. From the Toolsmenu, clickWorklists and New rejected worklist... or New
reject analysis worklist....

2. In the Worklist dialog you define your worklist just as for ordinary worklists.
Additionally you can also search, or exclude, specific reject reasons. Most likely
you do not want to see images that are soft deleted (reject reason "Soft delete").
This is achieved by adding the requirement "reject reason NOT EQUAL Soft
delete".

3. Click the Save as button to save the worklist.

4. Type in a name for the new worklist.

5. Select whether the worklist should be saved for personal, role or system use by
clicking in the drop-down list. The worklist will only be visible to users with
the proper permissions, see above.

6. Click Save.

The new worklist will be saved and displayed in the worklist view.

29IDS5, Version 11.1, December 2006 Using the Information Window

Working with Worklists 5.1



5.1.3 Creating a Teaching File

There is a second type of worklists called Teaching files. These worklists are static,
i.e. they are not based on search criteria. For an examination to be part of a teaching
file it has to be explicitly placed there. Teaching files, for example, can be used to
store interesting examinations.

To create a new teaching file

1. From the Tools menu, click Worklists and New Teaching File.

The New teaching file dialog appears.

2. Type a name for the new teaching file.

3. Select whether the worklist should be saved for personal, role or system use by
clicking in the drop-down list. Note that if you do not have permission to save
for role or system use, these alternatives will not be displayed in the drop-down
list. Note also that the name of the new teaching file has to be unique, i.e. there
can't be two teaching files with the same name, on the same level, under for
example "System worklists".

4. Click the Save button.

The new teaching file will be saved and displayed in the Worklist View.

There are several ways of adding one or more examinations to a teaching file. If an
examination is added from the Matrix or Image windows, a specific teaching file
presentation will be created automatically. This is not the case when adding an
examination from the Information window (Patient or Examination lists).

1. The easiest way to add one or more examinations is to use the Examination list.

2. It is also possible to add all worklist examinations (i.e. examinations that match
the worklist criteria) for a number of patients, to a teaching file.

3. It is also possible to add the current base examination to a teaching file while
viewing it in the Matrix or Image windows. In this case, the current presentation
of the images will also be saved as a specific teaching file presentation, see
section 6.6 Creating a Manual Presentation.

To add an examination to a teaching file (Examination List)

1. Select the examinations you want to add in the Examination list. By pressing
the CTRL key, several examinations may be selected at the same time.

2. From the Examination list pop-up menu, select Add to teaching file.

The Add exam dialog appears.

3. Select the teaching file where you want to save the examinations.

4. Click the Add button. The selected examinations will be added to the selected
teaching file.
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To add all worklist examinations to a teaching file

1. Select the patients whose worklist examinations you want to add to the Patient
list.

2. From the Patient list pop-up menu, select Add examination to teaching file.

The Add exam dialog appears.

3. Select the teaching file where you want to save the examinations.

4. Click the Add button. The worklist examinations will be added to the selected
teaching file.

To add the current base examination to a teaching file

1. Select Add base to teaching file from the Matrix or Image window toolbar
(or Tools menu).

The Add exam dialog appears.

2. Select the teaching file where you want to save the examination.

3. Click the Add button.

The examination will be added to the selected teaching file, and a teaching file
presentation will be created.

5.1.4 Creating a Scheduled Demonstration

There is a third type of worklist that is called Scheduled demonstration. These
worklists are static, i.e. they are not based on search criteria. For an examination to
be part of a scheduled demonstration it has to be explicitly placed there. This type
of worklist is similar to a calendar that contains entries on specific dates and times.
Each entry works much like an ordinary teaching file in that it stores examinations
statically. Scheduled demonstrations are well-suited for clinical demonstrations
which follow a schedule.

To create a new scheduled demonstration

1. From the Tools menu, click Worklists and New Scheduled demonstration.

The New scheduled demonstration wizard appears.

2. Type in a name for the new scheduled demonstration.

3. Select whether the worklist should be saved for personal, role or system use by
clicking in the drop-down list. Note that if you do not have permission to save
for role or system use, these alternatives will not be displayed in the drop-down
list. Note also that the name of the new scheduled demonstration has to be
unique, since there cannot be two scheduled demonstrations with the same
name on the same level under for example "System worklists".

4. You may type something in the Room field.

5. You may type something in the Note field.
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6. Click the Next button.

7. Enter the schedule for this worklist by selecting any number of days, selecting
the time and responsible radiologist. Select whether the worklist schedule applies
to every week, odd weeks or even weeks.

8. Click the Next button.

9. A list of referring units is shown. Checkmark all referring units that are likely
to send patients that could be added to this scheduled demonstration.

10. Click the Next button.

11. The freeze time specifies how many hours before the demonstration actually
takes place it is possible to add examinations to it. The default value is zero.

12. Click the Finish button.

The new scheduled demonstration is saved, and will be displayed in the Worklist
View.

There are several ways of adding one or more examinations to a scheduled
demonstration. If an examination is added from the Matrix or Image windows, a
specific demonstration presentation will be automatically created. This is not the
case when adding an examination from the Information Window (Patient or
Examination lists).

1. The easiest way to add an examination is to use the Examination list.

2. It is also possible to add all worklist examinations (i.e. all examinations that
match the worklist criteria) for several patients, to a scheduled demonstration.

3. It is also possible to add the current base examination to a scheduled
demonstration while looking at it in the Matrix och Image windows. In this
case, the present presentation will be saved as a demonstration presentation,
see section 6.6 Creating a Manual Presentation.

To add an examination to a scheduled demonstration (Examination list)

1. Use the Examination list to select the examinations you want to add to the
scheduled demonstration. By holding down the CTRL key you can select several
examinations at the same time.

a. Select Add to: NAME (DATE) from the Examination list pop-up menu
under the sub-menu Scheduled demonstration. There might be several
menu items of this kind in the menu. NAME is the name of the scheduled
demonstration, and DATE is the date to which the examinations will be
added. The date is calculated as the next following date according to the
schedule of the demonstration worklist. These dynamic shortcuts are only
available for those scheduled demonstrations that have the same referring
units as any of the selected exams.

b. Select Add to other demonstration from the Examination lists pop-up
menu under the sub-menu Scheduled demonstration. A dialog window
will open where you may select any scheduled demonstration and date.
The calendar in the dialog box shows you what dates are valid according
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to the schedule. Click Add to to add examinations to the chosen
demonstration at the chosen date.

To add all worklist examinations to a scheduled demonstration

1. In the Patient list, select the patients whose worklist examinations you wish to
add to the demonstration. By holding down the CTRL key you may select
several patients at the same time.

a. Select Add to: NAME (DATE) from the Patient list pop-up menu under
the sub-menu Scheduled demonstration. There can be several menu items
of this kind. NAME is the name of the scheduled demonstration and DATE
is the date to which the examinations will be added. The date is calculated
as the next following date according to the schedule of the demonstration
worklist. These dynamic shortcuts are only available for those scheduled
demonstrations that have the same referring units as any of the selected
exams.

b. Select Add to other demonstration from the Patient list pop-up menu
under the sub-menu Scheduled demonstration. A dialog window will open
where you may select any scheduled demonstration and date. The calendar
in the dialog box shows you what dates are valid according to the schedule.
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Click Add to to add the examinations to the chosen demonstration on the
chosen date.

To add the current base examination to a scheduled demonstration

1. a. In the Matrix or Image window toolbar (or Tools in the menubar), select
Add base examination to scheduled demonstration.

A dialog window will open where you may choose any scheduled
demonstration and date. The calendar in the dialog shows you what dates
are valid according to the schedule. Click Add to to add the examinations
to the chosen demonstration on the chosen date.

b. In the Image window menubar (Tools), chooseAdd base exam to: NAME
(DATE). In the Tools menu there might exist several menu items of this
kind. NAME is the name of the scheduled demonstration and DATE is
the date to which the exams will be added. The date is calculated as the
next following date according to the schedule of the demonstration worklist.
These dynamic shortcuts are only available for those scheduled
demonstrations that have the same referring units as any of the selected
exams.

There are several ways of moving one or many examinations to another scheduled
demonstration, or to another occasion within the same scheduled demonstration.

1. The easiest way is to use the Examination list.

2. It is also possible to move all worklist examinations (i.e. all examinations that
match the worklist criteria) for a number of patients, to another scheduled
demonstration.

To move an examination to another scheduled demonstration using Examination
list

1. In the Examination list, select the examinations you wish to move from this
scheduled demonstration to another scheduled demonstration. By holding down
the CTRL key you may select several examinations at the same time.

a. Select Move to next occasion from the Examination list pop-up menu
under the sub-menu Scheduled demonstration. The date is calculated as
the next following date from the current occasion according to the schedule
of the demonstration. The selected examinations, and any demonstration
specific presentations, will be moved to the next occasion.

b. Select Move to other occasion from the Examination list pop-up menu
under the sub-menu Scheduled demonstration. A dialog window will open
where you may select any scheduled demonstration and date. The calendar
in the dialog shows you what dates are valid according to the schedule.
Click Add to to move the examinations and any demonstration specific
presentations to the chosen demonstration on the chosen date.
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To move all worklist examinations to another scheduled demonstration

1. In the Patient list you select the patients whose worklist examinations you wish
to move from this scheduled demonstration to another scheduled demonstration.
By holding down the CTRL key you may select several patients at the same
time.

a. Select Move to next occasion from the Examination list pop-up menu
under the sub-menu Scheduled demonstration. The date is calculated as
the next following date from the current occasion according to the schedule
of the demonstration. The selected patients´ worklist examinations, and
any demonstration specific presentations, will be moved to the next
occasion.

b. Select Move to other occasion from the Patient list pop-up menu under
the sub-menu Scheduled demonstration. A dialog window will open where
you may select any scheduled demonstration and date. The calendar in the
dialog shows you what dates are valid according to the schedule. ClickAdd
to to move the patients´ worklist examinations and any demonstration
specific presentations to the chosen demonstration on the chosen date.

To navigate between scheduled demonstration occasions

Whenever a scheduled demonstration is selected in the worklist tree, a navigation
bar becomes visible just above the patient list. The navigation bar shows information
such as the date and time of the currently selected occasion.

1. There are two ways of jumping to another occasion within the same scheduled
demonstration. The easiest way is to use theNext and Previous buttons. They
will load the next or previous occasion within the scheduled demonstration.

Alternatively you can use the Overview button. This button opens a calendar
dialog box where you can quickly see on what days examinations were added.
Those are shown in style face digits. Select a date and click OK to jump to the
first occasion on that day.
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The scheduled demonstration navigation bar.

5.1.5 Editing a worklist

To change the search criteria for a worklist

Sometimes you may want to change the search criteria for a worklist. For example,
you may want to add all patients to an existing worklist where the modality is a MR.

1. Select the worklist whose search criteria you want to change.

2. From the Worklists pop-up menu, select Edit worklist....

The Worklist dialog appears.

3. Edit the search criteria.

4. Click the Save button to save changes. Note that the search criteria for the old
worklist will be overwritten. If you want to create a new worklist click the Save
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as button. This will bring up the Save as dialog box in which you can specify
a new name for the worklist.

Note: It is not possible to edit the "Mismatch" worklist under "System worklists".

Tip: Edit worklist... is available not only for ordinary worklists, but also for
scheduled demonstrations.

Tip: Selecting Edit worklist... for a scheduled demonstration opens a wizard which
guides you through the different settings available for a scheduled
demonstration. The wizard is exactly the same as when a scheduled
demonstration is created.

5.1.6 Removing a worklist

To remove a worklist

1. Select the worklist in question and click Delete from the Worklists pop-up
menu.

Note: Deleting a scheduled demonstration deletes the entire list, not just that
occasion!

5.1.7 Creating a new subfolder

To create a new subfolder

You might want to add subfolders to be able to rearrange and group your worklists.
For example you might want to put all your worklists containing stacks under a
subfolder called "Stacks".

It is not possible to add subfolders to "Temporary worklists" or "Role worklists".
You can only add a subfolder to "System worklists" or to a role if you have
administrator privileges.

1. Select the folder where you want to create the new subfolder.

2. From the Worklist pop-up menu, select New folder....

The New folder dialog box appears.

3. Type in a name for the new subfolder. Note that the name of the subfolder
must be unique.

4. Click the OK button.

The new subfolder is saved and will be displayed in the Worklist View.
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5.1.8 Removing a folder

To remove a folder

1. Select the folder and click Delete in the Worklists pop-up menu.

Note: The category folders, e.g. the "System worklists" folder, can never be deleted,
nor can the folders for each role be deleted. All other folders can be removed,
but you must have administrator privileges to delete folders under "System
worklists" or those under a role.

5.1.9 Moving worklists or folders

To move a worklist or a subfolder

By drag and drop you can move either worklists or subfolders (with all their contents)
to other folders. However, you can not move worklists or folders as you wish, which
the following restrictions describe.

• You cannot move a top folder, e.g. the "System worklists" folder.

• You cannot move a role folder.

• You cannot move one of the following worklists: "Mismatched", "Temporary"
or "Search".

• You cannot move anything to or under "Temporary worklists".

• You can freely move folders and worklists under "System worklists" if you have
administrator privileges.

• You can freely move folders and worklists under each role, if you have
administrator privileges.

• You can freely move folders and worklists under "User worklists".

1. Drag the worklist or folder that you want to move and drop it on the destination
folder.

The worklist or folder is moved to its new location.

5.1.10 DICOM Query/Retrieve

A DICOM Query/Retrieve (Q/R) server can be queried for information in the same
way as a WISE server, by including it in either or both server fields in the worklist
definition. Since image retrieval from Q/R servers is potentially very slow, images
are not fetched to the workstation until explicitly requested. Images that are available
but which have not yet been fetched, are represented by the text “Remote image”
in the Matrix and Image windows.
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To initiate fetching of delayed images

1. Select Fetch remote (see Reference Manual IDS5 [4]) from the Examination
list pop-up menu in the Information window, or from the Examination pop-up
menu in the Matrix window.

Images that are in the process of being retrieved are represented by the text
“pending“. If needed, refresh the Matrix window when all images have been
fetched to sort the images in the right order.

Q/R servers may also be queried using Advanced search, by selecting the Q/R server
in one or both server fields in the advanced search dialog box. The thumbnails of
examinations found on the Q/R servers are black, as the images only are located on
the remote server. To initiate a retrieve of the images, open the Matrix window,
and select Fetch remote, or import the examination using the pop-up menu command
Import in the Information window.

5.2 Working with Patients

The patient list displays all patients in a worklist. From the patient list you can select
a patient and view all examinations for that patient. The examinations will be
displayed in the examination list (see section 5.3 Working with Examinations). By
double-clicking on a patient you can bring up the images for the first examination
with a DDP applied (this is the same as selecting the patient and clicking Open
Images from the View-menu).

The figure below shows the main elements in a Patient List.

The Patient List.
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The patient list consists of the following elements:

Note: Your local configuration may not show some columns on the screen, and their
order may vary.

• STAT column — This is the column on the far left. The column has a red dot

if any of the cases (matched examinations) for the patient are STAT
examinations, i.e. examinations with high priority. In the figure above, Diana
Donovan and James Jones have the STAT mark set.

• Patient ID — The personal ID of the patient.

• Patient name — The patient's name.

• Patient birthdate — The patient's date of birth.

• RIS ID — Indicates the patient's ID in the connected RIS system, if it exists.

• Sex — The patient's sex.

• Examination columns — In addition to values that describe a patient, the list
can also be configured to show information about examinations. The value that
is shown on the patient level is the value for the first examination that matches
the worklist. See section 5.3 Working with Examinations for more information
on these coloumns.

• Filter fields — These are shown is the row below the column headings. In this
row you can type filter criteria that make it easier to locate a certain type of
patient. You can learn how to filter patients in To filter patients.

To perform a search

A search can be performed when you are looking for examinations that fulfill a
specific search criterion. For example you may want to look for examinations
performed on a certain modality.

1. In the Edit menu or the toolbar, click Search....

The Search dialog appears above the Patient list.
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2. Specify the search criteria. A search criteria has three parts; attribute, relation
and value as described in the "Worklist definition" list item in section 5.1.1
Creating a new worklist.

3. Click the Search button.

4. A cancel dialog is displayed. Click on the Cancel button to end the search.

A search is performed on the local WISE server, and all examinations that match
the search criterion will be placed in a temporary worklist under the Search
results node in the Worklist view. This worklist will be selected automatically.
The search dialog can be closed by clicking the Search toolbar button.

To perform an advanced search

Sometimes you may want to search the entire database for examinations that fulfill
several different search criteria. For example you may want to look for examinations
from a specific referring unit performed on a certain modality. In these cases you
perform an advanced search.

1. From the Edit menu, click Advanced search....

TheAdvanced search dialog appears. This dialog is very similar to the Worklist
dialog.

2. Add search criteria in the same way as in theWorklist dialog which is described
in section 5.1.1 Creating a new worklist.

3. Click the Search button.

4. A cancel dialog is displayed. Click on the Cancel button to end the search.

All examinations that match the search criteria will be placed in a temporary
worklist under the Search results node in the Worklist view. This worklist will
be selected automatically.

To perform an extended patient search

This feature is used to search other servers for additional examinations concerning
the selected patient(s).

1. Select the patients you want to search for in the patient list and click the right
mouse-button to bring up the patient pop-up menu.

2. From the pop-up menu, click on Extended patient search.
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All examinations found for the selected patients will be placed in a temporary
worklist under the Search results node in the Worklist view. This worklist will
be selected automatically.

Tip: You can configure the extended patient search function to determine which
servers to search, and which search criteria are to be used when searching
for the patients. The configuration is composed in the Options dialog, which is
opened by selecting Options from the Tools menu.

To sort a patient

If a worklist contains many patients it can be convenient to sort the list to make it
easier to locate a specific patient. The patients can be sorted by Patient ID, Patient
name, Patient birthdate or RIS ID, i.e. the columns in the patient list.

1. To sort a column, click on the column heading. Clicking the same column
heading again, reverses the sort order.

To filter patients

By specifying filter criteria you can limit the patients viewed in the patient list to
only those that match the criteria.

1. Specify a criteria by typing text in the filter fields.

A field matches a certain criteria if it begins with that letter combination.
Filtering is not case sensitive.

Tip: Typing JO in the patient name column will match all patients whose name
begins with the letters "JO", "Jo", "jo" or "jO". Matching names are for example
"John Smith" and "Joe West".

Wildcards can be used to make a more general selection. There are two
wildcard characters, * which matches an arbitrary number of characters and
? that matches exactly one character.

*JO matches all items containing "JO". ?JO matches all items with a "J" as
the second letter and a "O" as the third.

Tip: Text can be entered in several filter fields, i.e. for several columns. Filtering is
executed as soon as anything is entered.

To remove a patient from a teaching file

1. Select the patient (or patients) in question from the Patient list pop-up menu,
and click Remove patient from teaching file.

To remove a patient from a scheduled demonstration

1. Select the patient (or patients) in question from the Patient list pop-up menu,
and click Remove patient from scheduled demonstration.
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5.3 Working with Examinations

The Examination List displays all the examinations for the patient currently selected
in the Patient List. Various status information can be viewed for each examination.
For example, the date and time when the examination was performed, on which
modality the images were taken, and the such like.

When you select a patient, the Request View, Report View and Series List will be
automatically updated. The Request View will show the electronic or scanned
requests corresponding to the selected examination. The Report View shows all
reports for the request, and the Series List will show thumbnails of all images in the
examination.

By double-clicking an examination you can quickly see its related images. A DDP
or manual presentation will be applied (see section 6.4 Applying a presentation
(manual or DDP)) in the same manner as when you click Open images from the
View menu.

The style of the text in the patient list is used to give various kinds of information.
The following notation is used:

Bold text— Text displayed in bold style is used to denote examinations that match
the worklist search criteria.

Italics — Text displayed in italics indicates that the examination is in the archive.

Gray text — Text displayed in gray indicates that the examination was once part of
(i.e. matched) the worklist, but not any longer.

The Examination list is shown in the figure below.

The Examination List.
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The examination list consists of the following elements:

Note: Due to local configuration some columns may not be visible on your screen, and
their order may vary.

• Examination state — The column on the far left. This column displays a worklist

icon if the examination matched the worklist search criteria, and a red dot

if it is a STAT examination, i.e. an examination with high priority. The two

icons can be combined if the examination is both a STAT examination and
matches the search criteria.

• Display state — The second column from the left. The current examination,
that is to say the examination that is the base for what is displayed in the Image

and Matrix windows, is denoted by an arrow (the base examination). It is
possible to set another examination as base examination by double-clicking on
it. The other examinations that are included in the current presentation have

checkmarks in this column. These checkmarks are always synchronized with
the expanded examination rows in the Matrix Window. It is possible to click in
this column to remove or add a checkmark.

• RIS information state — The third column from the left. Normally, when
images are taken at a modality, RIS data is automatically transferred to the
workstation. If the radiology department doesn't have a RIS or the RIS
connection is down, RIS values may have to be entered manually on the modality
producing the images.

Note: Entering information manually is a potential source for errors.

The image import will check that the patient and request data matches. If a

mismatch occurs, this is indicated by a warning icon in this column. If the
RIS was not available when the image import took place it is indicated by another

icon in the same column. The functionUpdate FromRIS on the Examination
List pop-up menu should then be executed to verify the data. There is also the
case when the PACS has been informed of an examination that is scheduled to
take place some time in the future. Such an examination is indicated with a clock
icon in the third column.

• Accession no — The accession number, i.e. the ID of the examination. In some
countries, where several examinations may be performed for each request, this
is the ID of the request.

• Archive status — The archiving status for the examination.

• Body part — The body part that has been examined.

• Comments — Any comments about the examination.

• Date and time — The date and time when the examination was performed.

• Description — A description of the examination.

• DICOM Study ID — The DICOM Study ID tag, extracted when the
examination was imported into the PACS.

• Examination code — A code that denotes the type of examination.
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• Examination age — The time from when this examination was performed.

• Examination ID — The ID of the examination. Typically used when the
Accession no column contains the ID of the request.

• Import status — The error code, if any, from the examination's import into the
PACS.

• Institution name — The institution where the examination was performed.

• Modality — Specifies on which modality the images in the examination were
taken.

• Physician name — The name of the physician that performed the examination.

• Reading radiologist — The radiologist that has read/is to read the images.

• Referring unit — The clinic that requested the examination.

• RIS state — The status of the examination in the RIS.

• Server — The name of the server where this examination is stored.

• Station name — The physical station where the examination was performed.

• Status — The status of the examination in the PACS.

• Storage — The type of storage for the examination.

• Study Instance UID — The DICOM Study Instance UID tag, extracted when
the examination was imported into the PACS.

To add an examination

1. Select the examination and selectNew examination from the Examination List
pop-up menu. Enter the appropriate Accession number and Examination ID
(or leave them as <Automatic>) and click Search. Neither the Accession number
nor the Examination ID may contain comma (",") characters.

If the chosen combination of Accession number and Examination ID is unique,
no examination is found and a message stating this fact is shown. Click Create
to create a new examination. The new examination will be displayed in the
Examination List

To delete an examination

1. Select the relevant examination and select Delete online examination in the
Examination List pop-up menu. Note that the examination will be irretrievably
lost, i.e. it will be impossible to retrieve this examination ever again.

If the examination has been archived or scheduled with HL7, only images in
the workstorage unit (online) will be deleted. An archived examination cannot
be deleted from the archive. To delete a scheduled HL7 examination fully, it
must be canceled, see To cancel an examination scheduled with HL7.
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To cancel an examination scheduled with HL7

1. Select the relevant examination and select Cancel scheduled examination in
the Examination List pop-up menu.

2. If the examination contains images, you will be asked to verify that you want to
cancel the examination and delete the online images from the workstorage unit.
An archived examination cannot be deleted from the archive. Click the
appropriate button.

5.3.1 Adding a report to an examination

It is possible to add a report to an examination. This is a useful feature if, for example
you want to add comments about the examination. If the required 'license bits' are
present, it is also possible to sign the Report.

To add a report to an examination

1. Select the examination for which you want to add a report.

2. From the Report View pop-up menu, click Create new report.

3. Fill in the Text field.

4. Click Save to save the report, and sign it later. Alternatively click Sign to both
sign and save the report, see below.

The report is saved on the server.

To sign a report

1. Select the examination for which you want to sign a report, and select the report
you want to sign.

2. Click Sign.

3. A Signature dialog is displayed requiring you to authenticate yourself. For more
details on authentication see To perform a login.

4. Click OK to sign the report.

The report is saved on the server in 'signed' mode.

Note: Special privileges are required in the IDS5 system in order to be allowed to
sign a report. If you try to sign without the necessary permission, an Error
dialog box will be displayed, and the signing process interrupted.

Note: The following symbol indicates that the report contains voice clips that the

current workstation cannot play: . The symbol is displayed to the right of
the Sign button.

To edit a report

It is possible to edit a report if it has been saved without a signature.
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1. Select the examination for which you want to modify a report, and select the
report you want to modify.

2. Select Edit report in the pop-up menu of the Report view.

3. Edit the report text.

4. Click Save to save the report, or click Sign to sign and save the report. Click
Cancel to undo the changes.

5.3.2 Setting state for an examination

There are several types of state information that can be set for one or several
examinations. These includes:

• Setting and resetting STAT.

• Setting status.

• Setting Reading Radiologist.

• Changing archive status from Copy to Original.

A STAT examination is an examination that requires immediate attention, and has
the highest possible priority. As with film radiology, this urgency was denoted by
a red sticker on the examination. In IDS5 a digital STAT mark can be set (attached)
and reset (removed) on an examination. A STAT examination is indicated with a

red dot in the Examination list. It is possible to configure the workstation so that
an alert message is displayed when a STAT mark is set.

To set/reset STAT for an examination

1. Select the examination for which you want to set STAT.

2. From the Examination list pop-up menu, select Set STAT for setting the
STAT tag or Reset STAT for resetting the STAT flag.

In the Examination list the STAT indicator will be displayed or removed
depending on whether STAT was set or reset.

After working with an examination, it may be necessary to change its status to
indicate that it has been dealt with. Which status codes can be set depends on
your workstation configuration Typical states are "Read" or "Dictated". Status
can be set on single examinations, or groups of worklist examinations (i.e.
examinations matching the worklist search criteria).

To set the status for examinations

1. Select the examination(s) for which you want to change status.

2. From the Examination list pop-up menu, select Set status and select the new
status, or select Next status to advance the status one step.

The new state will be displayed in the "Status" column of the Examination list.
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There is also a set of “smart” commands for setting the next status (see Reference
Manual IDS5 [4]). When applied in a worklist that selects examinations based
on their status, these commands advance the status of the affected examination(s)
to the status following the one selected by the worklist, regardless of the present
status for the examination. This means that the command may be applied any
number of times and will still leave the examination in the next status, counted
from that selected by the worklist. This function reduces the risk of mistakes
in accelerated workflows (such as screening). When applied in a worklist that
does not specifically select a status, the “smart” commands work in the same
way as the ordinary next-state commands.

You can specify who is going to be the reading radiologist for an examination.
This can be useful, for example, if you want to create worklists for each
radiologist in a department. By specifying a search criteria like "Reading
Radiologist is Adam Smith" the radiologist Adam Smith will see only those
examinations that have been assigned to him.

To set status for a group of worklist examinations

1. Select the patients for which you want the worklist examinations to change
status.

2. From thePatient list pop-up menu, select Set status and choose the new state,
or select Next status to advance the status one step.

To set Reading Radiologist for an examination

1. Select the examination for which you want to set the reading radiologist.

2. From the Examination list pop-up menu, select Reading radiologist....

A dialog appears displaying all users in the WISE database.

3. Select the reading radiologist from the list.

4. Click the OK button.

To set the current user as the reading radiologist

1. Select the examination for which you want to set the reading radiologist.

2. From the Examination list pop-up menu, select Set me as reading
radiologist....

The reading radiologist will be displayed in the "Reading radiologist" column
of the Examination list.

Changing the archive status from Copy to Original

1. Select the examination for which you want to change the status from Copy to
Original.

2. From theExamination list pop-up menu, select Set archive status toOriginal.

A dialog appears where you are asked to verify that you want to change the
archive status.
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3. Click the Yes button.

Changing the archive status this way can only be done for examinations with
archive status Copy. For all other cases, the command is inactivated.

5.3.3 Properties

To view/modify properties of an examination

1. Select the examination and selectProperties... in theExamination list pop-up
menu.

A dialog will be displayed where you can change some of the attributes.

If you are not an IDS5 administrator you cannot change any attributes in the
dialog, and all fields will be displayed in gray (see figure below). When modifying
patient and examination data, please note that correct data is of crucial
importance.

Properties dialog.

5.3.4 Storing and retrieving examinations

Images can be stored in three locations, namely: on the workstation, in the
workstorage unit (online), and in the archive. All examinations are stored indefinitely
in the archive. The workstorage unit normally stores the last few days production
of images so that they can be retrieved quickly. When displaying images on the
workstation, the images are retrieved from the workstorage unit and copied to the
workstation. The figure below illustrates the relationship between the different
storage locations.
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Storage locations.

The workstation (1) stores the images that are currently being viewed. The
workstorage unit (2) typically stores images for the last few days of production; and
the archive (3) stores all images that have been imported to the PACS.

It may take a few minutes to retrieve an examination from the archive, longer for
archives using tapes or removable disks as storage medium.

By looking at the archive column in the Examination list you can view the current
archive status for an examination. An examination can have the following archive
status:

Original The examination is an original and has not yet been archived.

Copy The examination is a copy of another examination in the
workstorage unit.

Queued The examination is being queued for archiving.

Archived The examination has been put in the archive.

Retrieving The examination is being retrieved from the archive.

Warning The examination is incomplete due to a failed retrieval attempt.

To store an examination in the archive

1. Select the examination or examinations you want to store in the archive.

2. From theExamination list pop-up menu, clickArchive and select which archive
you want to store the examination(s) in.

The examination(s) are now copied to the archive.

Note: To be able to look at images that have been stored in the archive, you must
first retrieve them from the archive.

To retrieve an examination from the archive

1. Select the examination or examinations you want to retrieve from the archive.
Note that only examinations that have status "Archived" or "Warning" can be
retrieved.
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2. From the Examination list pop-up menu, click Retrieve from archive.

The examination(s) are then transferred to the workstorage unit (online). The
archive status of the examination(s) will change from "Retrieving" to "Archived"
or "Warning" depending on the result of the operation. You may need to click
Refresh to see the changes.

Note: If an examination gets the archive status "Warning", the retrieval was not
entirely successful and the examination is incomplete. In this case you may
retry to retrieve the examination from the archive, but should inform the system
administrator.

5.4 Mismatch handling

During import operations, the examinations are mapped to existing data in both
the PACS and the RIS (if one is connected). A number of conflicts may occur during
this process. A common fault is that the specific Request ID is already connected
to another patient. These conflicts are called mismatches. The reason is often that
a manually entered ID is incorrect. The conflict is handled by using theExamination
administration tool, see section 5.4.1 Correcting mismatches.

The same type of errors may exist, even though no mismatch is detected. This
happens when the erroneous data does not conflict with existing data. The remedy
is the same.

The mismatched examinations are only visible in the built-in "Mismatched" worklist,
see below. Another problem is when the RIS is unavailable during import. Data is
normally validated through the RIS at that time. If no validation was possible, the

examination will get the import status "Missing RIS info", shown as the symbol in
the Examination List. To update the examination with data from RIS when the RIS
is available ('on-line') again, use the Update from RIS function, see below.

5.4.1 Correcting mismatches

Correcting a mismatch can be done in three different ways:

• Copying the contents of the examination to another examination.

• Moving the examination to another patient.

• Changing examination number.

These options are available in the examination administration wizard that can be
opened by selectingExamination administration in the Examination list pop-up
menu. The examination administration wizard provides guidance when correcting
mismatches. Three options are available in the wizard that appears, and are explained
below.

To copy images

1. Select the Copy command and click Next >.
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2. Enter the correct examination number for the mismatched examination and
click Next >. Alternatively, click the Suggestions... button. This will open up
a dialog listing probable target examinations. Select an examination in the list
and click OK. The examination number will be filled in automatically. Click
Next >.

A search is performed to determine if the target examination exists. If the request
or examination is found, a page with information on what is about to happen
will be displayed.

3. Clicking the Finish button will complete the copying process.

If the request is not found, you re-enter patient data for the target patient. This
is done on the next page in the wizard.

4. First select whether the examination is for an existing or a new patient, and
enter the relevant patient data.

5. Clicking Next > will perform a search for the entered patient data to ensure
that there are no conflicts with existing patients.

Note: If "New patient" is selected and the patient already exists, the patient data will
be changed on the wizard page.

Note: An image is not allowed to exist in more than one examination. Therefore, after
the copying operation has been performed, you must delete the appropriate
image(s) from the original examination and the copy, so that no duplicate
images exist.

To move examinations

1. Select the Move command and click Next >.

2. Enter the correct examination number for the mismatched examination and
click Next >. Alternatively, click the Suggestions... button. This will open up
a dialog listing probable target examinations. Select an examination in the list
and click OK. The examination data will be filled in automatically. Click Next
>.

A search is performed to determine if you are allowed to move the examination
here. If the request is found, a page with information on what is about to happen
will be displayed.

3. Clicking the Finish button will complete the moving process.

If the request is not found, you must re-enter patient data for the target patient.
This is done on the next page in the wizard.

4. First select whether the examination is for an existing or a new patient, and
enter the relevant patient data.
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5. Clicking Next > will perform a search for the entered patient data to ensure
that there are no conflicts with existing patients.

Note: If "New patient" is selected and the patient already exists, the patient data will
be changed on the wizard page.

Note: To read more on how to configure what probable target examinations to show
in the dialog described above, see System Administrator's Guide IDS5.

To change examination number

1. Select the Change examination number command and click Next >.

2. Enter the correct examination number for the mismatched examination and
click Next >.

A search is performed to determine if the target request exists. If the request is
found for the current patient, or if the request is not found, a page with
information on what is about to happen will be displayed.

3. Clicking the Finish button will complete the examination data change.

If the request is found for another patient, you are asked to enter different
examination data that does not conflict with another examination.

Limitations

The examination administration wizard has a number of limitations that it is
important to be aware of.

• An examination that has been archived cannot be changed or moved. It is only
possible to copy images from these examinations to other examinations.
Therefore, only the copy command is available for these examinations.

• The Change examination number command cannot be used to move the
examination to another patient. Hence, the new accession number that is entered
in the wizard, must be non-existent, or belong to the source patient. If an
examination is marked as a mismatch, the personal ID may have been altered
with a suffix. This command can then not be used to change examination
number, since the examination will be connected to a patient with an incorrect
personal ID (i.e. the correct personal ID with a suffix). It is necessary to use the
Move command, and move the examination to a new patient with correct patient
data.

To update an examination from RIS

1. An examination which lacks RIS information is updated by selecting Update
fromRIS in theExamination list pop-up menu. Remember that you may need
to apply Refresh to see the changes.

To reimport an examination

1. An examination can be reimported completely by using the Reimport to...
command that can be added to the Examination list pop-up menu. Enter the
correct examination data in the Reimport dialog and click OK.
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5.4.2 The "Mismatched" worklist

Mismatched examinations are only visible in the built-in "Mismatched" Worklist
in the System Worklist folder. In this way, they can never interfere with the normal
workflow. As in any worklist, all examinations for the patient in question are shown
in the Examination List. The mismatched examinations are denoted with a warning

symbol .

Examinations that lack RIS information can be seen in any worklist.

5.4.3 Troubleshooting

The table below gives guidance on how to remedy the different erroneous scenarios
regarding Examination administration. Use the "IDS5 marking" and "ID status"
to guide you to the correct scenario.

Note: When reading the troubleshooting table below, be sure to consider all possible
cases before implementing a solution. Some scenarios are very similar but need
different solutions.

Explanation to the columns:

• No. — Order number for each scenario, for reference purposes.

• IDS5 marking: Mism. — The examination is marked as "Mismatch" in IDS5.
The marking is shown as a warning triangle in the Examination List of the
Information Window, and as text in the "Import status" column. The
examination is shown only in the "Mismatched" worklist.

• IDS5 marking: No RIS information — The examination is marked as "Missing
RIS info" in IDS5. The marking is shown as an exclamation mark in the
Examination List of the Information Window, and as text in the "Import status"
column.

• ID status: Bad Pat ID — The patient ID is incorrect. It could belong to another
patient.

• ID status: Bad Req ID — The request ID/accession number is totally incorrect.
It could belong to another request.

• ID status: Suffix Req ID — The request ID/accession number is essentially
correct, but has an extra letter at the beginning. A suffix, usually "A" is added
when a mismatch is detected during image import.

• Description — This column describes what has happened before and during
image import, to result in the current situation.

• Example — The Example column gives real-life examples of how the error was
made.

• Remedy — This column gives instructions on how to remedy errors. The
instructions refer to IDS5, unless otherwise specified.
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RemedyExampleDescriptionID status
IDS5
marking

No.

   
Suf-fix
Req
ID

Bad
Req
ID

Bad
Pat
ID

No
RIS
info

Mism. 

• Copy the contents

of the examination

to the correct

patient (P2). The

patient and request

data for P2 should

be added in in the

dialog.

• Delete appropriate

series from both

patients'

examinations.

P1 has had an examination

performed and the technician

forgets to change the user details

at the modality when taking P2's

images.

An examination for patient P1

contains images for both P1 and

another patient P2.

-----1.

• Select the Change

examination

number command

and enter the

correct request

and examination

number.

At the modality, an incorrect request

ID/accession number is given. The

ID conflicts with an existing request

for another patient.

Request R1 has an incorrect

request ID/accession number,

but it is connected to the

correct patient.

-X--X2.

• Use Change

examination

number to correct

the examination

number for E1.

• Use Move to move

E2 to the correct

patient.

At the modality, an incorrect request

ID/accession number is given for

R1. The ID does not conflict with an

existing request for another patient

and therefore the mismatch is not

detected. All data is correct for E2

and its request R2 (for patient P2),

but its request ID/accession

number conflicts with the incorrect

ID of R1.

Request R1 with examination E1

has incorrect request

ID/accession number. No

mismatch has been detected for

E1.The examination E2 is

marked as mismatch, but has

correct request ID/accession

number, apart from a letter

suffix.

X---X3.

• Use Move to move

the examination to

the correct patient.

At the modality, an incorrect patient

ID is given for E1. E1's request R1

is already known in PACS or RIS.

Examination E1 is connected to

the wrong patient or to a

non-existing patient. E1 is

marked as mismatch.

X-X-X4.

• Select Move and

enter correct

examination

number (without

the suffix).

• Enter the correct

patient data.

At the modality, incorrect patient

name or date of birth is entered for

E1. E1's request R1 is already

known in PACS or RIS. The import

process is configured to check for

patient name and date of birth

mismatches.

Examination E1 has correct

request ID/accession number

apart from a letter suffix and is

marked as mismatch. E1's

patient P1 has incorrect name

or date of birth.

X---X5.
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RemedyExampleDescriptionID status
IDS5
marking

No.

   
Suf-fix
Req
ID

Bad
Req
ID

Bad
Pat
ID

No
RIS
info

Mism. 

• Ensure that the

request is created

in RIS.

• Perform the

Update from RIS

function.

Trauma case, where the request

and/or patient is not known in RIS

at the time of the image import to

PACS.

Examination E1 and its request

R1 has correct IDs, but is

marked with "Missing RIS info".

R1 is not known in RIS.

---X-6.

• Perform the

Update from RIS

function.

The RIS connection was down during

image import to PACS.

Examination E1 and its request

R1 has correct IDs, but is

marked with "Missing RIS info".

R1 is known in RIS.

---X-7.

• Ensure that RIS has

correct data.

• Use the Change

examination

number command

and enter a

non-existing request

and examination ID

to temporarily

change the

examination.

• Use the Move

command again to

move the changed

examination back to

the correct ID's and

patient.

• Perform Update

from RIS.

Trauma case, where an unknown

patient is given a new patient ID, and

temporary patient data. The request

number is correct. The patient

already existed in RIS, i.e. the new

patient ID is invalid.

Examination E1 and its request

R1 is connected to the wrong

patient, or to a non-existing

patient. E1 is marked as

"Missing RIS info".

--XX-8.
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RemedyExampleDescriptionID status
IDS5
marking

No.

   
Suf-fix
Req
ID

Bad
Req
ID

Bad
Pat
ID

No
RIS
info

Mism. 

• Wait until the

patient and

examination have

been entered in

RIS.

• Use the Move

command but enter

non-existing

temporary ID's to

move the

examination to the

correct patient.

• Use the Change

examination

number command

to reset the correct

ID's.

• Perform Update

from RIS.

Emergency case, where an unknown

patient is given a new patient ID, and

temporary patient data. The patient

does not yet exist in RIS.

Examination E1 and its request

R1 is connected to a

non-existing patient. E1 is not

known in RIS, and is marked as

"Missing RIS info".

--XX-9.

• Use the Move

command but enter

non-existing

temporary ID's to

move the

examination to the

correct patient.

• Use the Change

examination

number command

to reset the correct

ID's.

• Perform Update

from RIS.

Combination of scenarios 4 and 7.

Incorrect patient ID is given, and the

RIS connection is down during the

import.

Examination E1 is marked as

"Missing RIS info", but is also

connected to the wrong patient.

--XX-10.

• Use the Change

examination

number command,

and enter the

correct request

and examination

number.

• Perform Update

from RIS.

Combination of scenarios 2 and 7.

Incorrect request ID/accession

number is given, and the RIS

connection is down during the

import.

Examination E1 is marked as

"Missing RIS info", but also has

incorrect request ID/accession

number.

-X-X-11.
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RemedyExampleDescriptionID status
IDS5
marking

No.

   
Suf-fix
Req
ID

Bad
Req
ID

Bad
Pat
ID

No
RIS
info

Mism. 

• Select the Change

examination

number command

and enter the

corrrect request

and examination

number.

At the modality, an incorrect request

ID/accession number is given for

R1. The ID does not conflict with an

existing request for another patient

and therefore the mismatch is not

detected.

Request R1 with examination E1

has incorrect request

ID/accession number. No

mismatch has been detected for

E1.

-X---12.

5.5 Scanned documents

This sections describes scanning of documents as well as working with scanned
documents.

5.5.1 Scanning documents

The IDS5 communicates with the physical scanner via a standard TWAIN interface.
This makes it possible to use almost any scanner on the market. If the scanner has
a document feeder it can be used to scan batches of papers unsupervised. For
information on configuration of scanners, please refer to the System Administrator's
Guide IDS5 [1].

To select a scanner

1. Select Select scanner from the Tools menu.

This will display the TWAIN source selection dialog.

2. Select scanner from the dialog.

When a scanner has been selected, the Document Scanner is ready to be used.

To scan a document without barcode

1. Place the document on the scanner glass, or in the document feeder if one is
available.

2. Select the patient and the correct examination to scan the document to.

3. From the pop-up menu for the examination, select Scan document.

The document is now scanned and the document is stored in the PACS.

To scan a document with barcode

1. Place the document on the scanner glass, or in the document feeder if one is
available.
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2. Select Scan requests from the Tools menu.

The document is now scanned, the barcode is read automatically and the
document is stored in the PACS.

3. If a document has no barcode, or the Document Scanner fails to read it, the
Missing ID dialog will be displayed.

Note: This dialog will also appear if a barcode was found that did not correspond to
a known request ID in the PACS, or if there were more than one barcode found
in the document.

Tip: A barcode might be unreadable for a number of reasons, e.g. smudged,
wrinkled paper, low scanning resolution etc. For more information on
configuration of scanners, please refer to the System Administrator's Guide
IDS5 [1]

a. Type the correct ID into the dialog and click OK.

The scanned document will be displayed in the background during this
operation.

b. After typing a request ID manually, the Document Scanner also requests
an extra confirmation by displaying some user data that matched the given
request ID.

To scan a batch of documents

1. Place the documents in the scanner.

2. Select Scan requests from the Tools menu.

Note: When scanning several documents in a batch using a document feeder, it is
possible to mix documents with and without barcodes. This is the same situation
as scanning a batch where a couple of documents have unreadable barcodes.
The Document Scanner handles this by scanning the entire batch and dealing
with all documents with readable barcodes first. Then, as a second step, it
goes through the ones it failed to allocate and requests manual entry of their
request ID's. The same error handling as described above is applied here too.

5.5.2 Working with scanned documents

Scanned documents for the selected examination are displayed in the upper right
corner of the Information window.

To view a scanned document

1. Move the mouse holding the leftmouse button to pan the view of the document.

2. Other tools, such as zooming, are available from the pop-up menu, reached by
right-clicking in the scanned document view.

3. Zooming is also possible using the mouse wheel.
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To view a scanned document in full-screen

1. Double-click in the scanned document view to open up the document in
full-screen mode, making it easier to read.

All mouse interaction in this window is the same as in the Information window.
The Information window is, although visible, disabled while the full-screen
scanned document window is open.

2. Double-click again in the scanned document window to close it.

To delete a scanned document

Note: Deleting scanned documents requires your role to have permission to perform
examination administration.

1. Select Delete document in the scanned document view pop-up menu (made
visible by a right-click).

2. A warning dialog will be displayed and you need to both mark the checkbox
and click OK to confirm the deletion.

Note: Documents in archives are not deleted by this function.

5.6 Import and export

An export may be initiated for a worklist, one or several patients, or one or several
examinations for a patient. It may also be initiated for a stack or for an image in the
Image window. The exported files are similar for all types of export with the
following exceptions:

• Teleradiology does not include anything but the pure DICOM images

• When sending to an e-mail recipient, the viewer is not included

• Images in rejected series are not exported for external teleradiology, CD,
user-defined folder, CD/DVD Production Center or e-mail export. They are
however included for internal teleradiology and IDS5/home.

Export and import can be enabled and configured as described in System
Administrator's Guide IDS5.

During export to a CD, user-defined folder, CD/DVD Production center or to
e-mail, all images in the selected examinations are written to file. Any additional
information, e.g. complementary information added after the date the image was
created, or graphics (annotations or measurements added at the IDS5), will
automatically be included in the export. Complementary information is added to
the DICOM file, graphics are added to the images as overlays.
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You can cancel the export at any time by clicking the Cancel button. When the
export is done, you have to confirm the Export status dialog by clicking the OK
button, which now is enabled.

Note: CDs, like other hard copy medical documents, should be handled according to the
guidelines recommended by HIPAA. In most cases hospitals and/or imaging centers
should follow the same tracking and signing procedures when sending out CDs as
for film and/or reports. The procedures are not very well suited for E-mail, why
we recommend using Password protection or Anonymization when exporting
to e-mail recipients, see details below.

Note: CDs and DVDs should be verified manually after production to make sure that the
media can be read and that the correct information has been exported.

5.6.1 Initiating the Export

The export may be initiated from a worklist, one/several patients or one/several
examinations for a patient:

To export an entire worklist

1. Select the worklist that you want to export.

2. From theToolsmenu,Worklists sub-menu you can select to export all worklist
examinations to a user-defined directory, CD, CD/DVD Production Center
or to e-mail recipient(s).

The Tools, Worklists menu.

To export matching exams for patients

1. Select the worklist you want to export examinations from, or make a search.

2. Select the patient/patients to export matching exams for. Use Ctrl + left mouse
button to select more than one patient.
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3. Right-click on any of the selected items to display a pop-up menu.

4. Select Send worklist examinations to and then select a user-defined directory,
CD, CD/DVD Production Center, e-mail recipient(s) or any other teleradiology
destination that have been set up and are available.

Note: Only the examinations that match the worklist will be exported using this
alternative.

To export selected examinations

1. Select the worklist you want to export examinations from, or make a search.

2. Select the examination(s) you want to export.

3. Right-click on any of the selected items to display a pop-up menu.

4. Select Send to and then select a user-defined directory, CD, CD/DVD
Production Center, e-mail recipient(s) or any other teleradiology destination
that have been set up and are available.

The patient pop-up menu.

5.6.2 Export Options

The general options available for all export modes (except Teleradiology) are
described below. There are specific options for each export type, which will be
described later on.

Anonymize

The patient data is replaced with anonymous data. The values in the anonymized
fields are written in English, and will not be translated to local languages. To indicate
the sex and age of the patient the new name is of the type Anonymous Male 1964.
The patient ID is recalculated and set to a new, patient unique value, ensuring that
the patient gets the same anonymous ID at the next anonymized export.
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The DICOM attributes that are changed are all members of the DICOM group
0010, Patient information. As mentioned above there is a new patient name
(0010,0010) and a new patient id (0010,0020). The patient sex (0010,0040) and the
patient age (0010,1010) are not changed, since this information is vital and cannot
reveal the id of the patient. The two tables below describes the other affected
DICOM attributes. The first table lists the attributes that have been removed
completely, and the other shows the attributes that have been changed to a more
anonymous value.

DICOM attribute idRemoved DICOM attributes

0010,0050Patient's Insurance Plan Code Sequence

0010,1000Other Patient IDs

0010,1001Other Patient Names

0010,1020Patient's Size

0010,1030Patient's Weight

0010,1040Patient's Address

0010,1050Patient's insurance plan id

0010,1080Military Rank

0010,1081Branch of Service

0010,21B0Additional Patient History

0010,21D0Last Menstrual Date

New value
DICOM
attribute id

Anonymized DICOM attributes

anonymous0010,0021Issuer of Patient ID

anonymous0010,0030Patient's Birth Date

anonymous0010,0032Patient's Birth Time

anonymous0010,1005Patient's Birth Name

anonymous0010,1060Patient's Mother's Birth Name

anonymous0010,1090Medical Record Locator

anonymous0010,2000Medical Alerts

anonymous0010,2110Contrast Allergies

anonymous0010,2150Country of Residence

anonymous0010,2152Region of Residence

anonymous0010,2154Patient's Telephone Numbers

anonymous0010,2160Ethnic Group

anonymous0010,2180Occupation

anonymous0010,21A0Smoking Status

0004 (0004 =

unknown)
0010,21C0Pregnancy Status
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New value
DICOM
attribute id

Anonymized DICOM attributes

anonymous0010,21F0Patient's Religious Preference

anonymous0010,4000Patient Comments

Note: Patient information in other DICOM fields are not removed, hence the images that
are exported cannot be guaranteed to be completely anonymous.

Note: All reports and scanned documents are excluded from the export when the
anonymize option is active.

Send only key images

If the image series contains key images, the export will only include these. If there
are no key images, the series will not be exported at all. This is checked for each
series in each examination that is exported.

Send questions and case histories

The questions and case histories, if any, are included in the export.

Send reports

The report text is included in the export. If the report is unsigned the CD export
config file will decide whether the reports will be included or not. Voice clips related
to the report will not be exported. This option is not enabled when Anonymous is
checked.

Send scanned documents

Scanned documents, if any, are included in the export. This option is not enabled
when Anonymous is checked.

5.6.3 Export with Teleradiology

When selecting to export to a teleradiology destination, a dialog appears stating the
selected destination. The dialog also contains a tree view of all the patients and
examinations that are exported. If any of these examinations should not be sent,
they can be deselected by clicking the corresponding checkbox in the tree view.
Click Export when you are ready to start the export.
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The labels for the examinations in the tree view are the same as the collapsed labels
in the Matrix window for examinations, please read section 12.7 Configuring
Windows Properties.

Note: If there are no destinations available in the sub menu, or if your preferred
destination is unavailable, Teleradiology has not been set up properly or is not
available. Please contact your system administrator for further assistance.

The Teleradiology export dialog.

5.6.4 Export to a CD

After selecting to export to CD, a dialog appears with the options described in
section 5.6.2 Export Options. Select the appropriate options before starting the
export. The dialog also contains a tree view showing the selected patients and their
corresponding examinations. You can uncheck the checkboxes for examinations
that should not be exported, to exclude the examinations from the export.
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The labels for the examinations in the tree view are the same as the collapsed labels
in the Matrix window for examinations, please read section 12.7 Configuring
Windows Properties for further information.

Note: When exporting directly to a CD, the CD must be formatted so that IDS5 can write
to it in the same way as it writes to the hard disk. To format the CD, use packet
writing software such as Drag-to-Disc (formerly DirectCD) by Roxio and InCD by
Nero.

The CD export dialog.

Note: CD viewer is included on the exported CD.

5.6.5 Export to a user-defined folder

As an alternative to exporting to CD you can export examinations to any folder
located on the local file system or a remote host, e.g. a USB memory stick.

Export to a user-defined folder

1. Click Tools->Worklists->Export to folder....

2. In the export dialog box, select the appropriate export options, as described in
section 5.6.2 Export Options.

3. The tree view shows the selected patients and their corresponding examinations.
You can clear the check boxes for examinations that should not be exported.

4. Click Export.

5. Select the destination folder to export to.

6. Click OK.
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The exported data will be stored in the selected destination folder.

The exported data will be stored in the selected directory.

Note: When exporting to a user-defined folder make sure the windows user has write
permissions at that destination.

Note: CD viewer is included on the exported folder destination.

5.6.6 Export to a CD/DVD Production Center

After selecting to export to a CD/DVD Production Center, a dialog appears with
the options described in section 5.6.2 Export Options. The options that are not
described above, are listed here:

CD/DVD Production Center This option determines which of the
configured CD/DVD Production Centers that
should receive this order. The default
CD/DVD Production Center can be
configured per role.

Urgent If this option is checked this order will get high
priority. This means that it will be processed
before all orders that has lower or no priority.
(The urgent queue is processed in the order
they were placed in queue.)

Optional CD label This is an optional field that will be printed on
the CD/DVD label by the CD/DVD
Production Center. Each line is separated by
a semicolon (;). For example,
"Address;Hospital;Country" will print:

Address
Hospital
Country

Note: It is recommended to use a maximum of three
lines with approximately 25 characters each.
However, it is possible to have more lines
and/or characters per line, but then smaller
fonts will be used to fit the text on the CD.

The dialog also contains a tree view showing the selected patients and their
corresponding examinations. You can uncheck the checkboxes for examinations
that should not be exported, to exclude the examinations from the export. The labels
for the examinations in the tree view are the same as the collapsed labels in the
Matrix window for examinations, please read section 12.7 Configuring Windows
Properties for further information.
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The CD/DVD Production Center export dialog.

All files that will be included on the CD/DVD, are sent to the CD/DVD Production
Center. The status window tells when the job has been placed, and states the order
number. The CD/DVD Production Center takes care of the order and produces
the CD/DVD. If the production fails after the order has been placed, IDS5 will not
receive any notice of this. On the CD/DVD Production Center host any failed
orders can be opened to see who initiated the export and when. The order on the
CD/DVD Production Center will have a name like order_xxxxxx, where xxxxxx is
the order number given by the IDS5. When an order has been processed and the
CD/DVD is finished, the files will remain at the CD/DVD Production Center host.
Any IDS5 that exports to that CD/DVD Production Center after an order is finished
will remove the files before it places its own order. Even files belonging to failed
orders are removed, except for the order file itself, that states who initiated the
export.

Note: CD viewer is included on the produced CD.

5.6.7 Export to an E-mail Recipient

After selecting to export to a E-mail recipient, a dialog appears. In addition to the
general options described in section 5.6.2 Export Options, the e-mail export can be
password protected.

Password protection A password can be specified to protect the file that is
exported. This password must be delivered to the
recipient, preferably by other means than E-mail.
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Select the appropriate options before starting the export.

The dialog also contains a tree view showing the selected patients and their
corresponding examinations. You can uncheck the checkboxes for examinations
that should not be exported, to exclude the examinations from the export. The labels
for the examinations in the tree view are the same as the collapsed labels in the
Matrix window for examinations, please read section 12.7 Configuring Windows
Properties for further information.
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When the Export button is clicked the export will gather all the files that should
be included. An E-mail is created with the default E-mail program and the files are
included as an attachment.

Note: This export will be carried out on open computer networks and with a well known
standard protocol. This means that it is important to protect patient data. To
ensure patient privacy, make sure to use either Anonymize or Password
protection.

The E-mail export dialog.

Note: Exporting to E-mail requires that the computer has an installed and configured
E-mail program. Please refer to your system's manual for instructions on how to
install and configure the E-mail program. IDS5 will use the default E-mail program
when exporting to E-mail, which makes it important to ensure that the configured
E-mail program is default in Internet Options. Open the Internet Options under the
Control Panel and click the Programs tab. Under this tab the default E-mail program
of the system can be seen.

Note: Export via e-mail is intended for e.g. second opinions on individual images. It is not
suitable to export entire large examinations via e-mail, as they put heavy load on
the e-mail system. Check the size of the files before exporting via e-mail and consult
your system administrator for recommendations. For large files, consider using
telerad instead.

5.6.8 Import from a CD

The contents of a CD may be imported into the PACS.
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Note: A DICOM compliant CD contains an index file called DICOMDIR which keeps track
of all images on the CD. If this file is missing or broken, IDS5 still can try to import
the images. In these cases, IDS5 will display a dialog and let you choose if you want
to try to import the images or not.

Import from a CD

1. Click Tools->Worklists->Import from CD... to start the CD import.

2. In the dialog that appears there is a tree view showing the contents. In this tree
view, information about the patients and examinations can be found. Check the
examinations that are to be imported and click Import.

3. Open the temporary worklist Imported to access the newly imported
examinations.

5.6.9 Import from a user-defined folder

DICOM files located on the local file system or a remote host may be imported
into the PACS.

Note: A DICOM compliant folder contains an index file called DICOMDIR which keeps track
of all images in the folder. If this file is missing or broken, IDS5 still can try to
import the images. In these cases, IDS5 will display a dialog and let you choose if
you want to try to import the images or not.

Import from a user-defined folder

1. Click Tools->Worklists->Import from folder... to start importing from the
desired location.

2. Navigate to the desired folder to import from and click OK.

3. In the dialog that appears there is a tree view showing the contents. In this tree
view, information about the patients and examinations can be found. Check the
examinations that are to be imported and click Import.

4. Open the temporary worklist Imported to access the newly imported
examinations.

5.6.10 Import from E-mail

When receiving an E-mail with an attachment of DICOM images, just double click
the file and the import will start automatically. This requires that an IDS5 is already
running and that a user is logged in. This is to prevent the import from being started
for another user. If needed, a dialog will ask for a password. The import continues
exactly as the Import from a CD. If the attachment is first saved locally, the import
may be started by selecting the Tools->Worklists->Import from E-mail...
command and opening the saved file from the open dialog that is displayed.
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5.6.11 Import from DICOM Query/Retrieve Server

Examinations located on a section 5.1.10 DICOM Query/Retrieve (Q/R) server
are displayed in the information window examination list with archive state Q/R.
Apply the command Import from the pop-up menu in the Information window to
import the examination to WISE. The archive state changes to Original and the
examination is now located both in the WISE and at the Q/R server.

72IDS5, Version 11.1, December 2006 Using the Information Window

Import and export 5.6



6 Using the Matrix Window

The following topics are included in this chapter:

■ Matrix Window Organization

■ Arranging Images

■ Adjusting Image Settings

■ Applying a presentation (manual or DDP)

■ Creating a DDP

■ Creating a Manual Presentation

■ Working with text notes

■ Deleting images

The Matrix Window is used to prepare images for viewing in the Image window.
Preparation normally involves deletion of failed series, adjustment of image settings
(orientation, grayscale, cropping etc), arranging images for comparison between
different examinations or different types of images (another organ or another view
of the same organ) and the such like.

You can use the functionality offered by the Matrix window to perform electronic
hanging of images.

6.1 Matrix Window Organization

The Matrix Window consists of four main parts, the Patient text view, the Recycle
Bin, the miniature screen view and the examination matrix itself.

6.1.1 The Patient Text View

The Patient Text View displays patient ID, patient name, and patient date of birth.
This is purely an information field. The figure below is a snapshot of the Patient
text view.
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The Patient Text View.

6.1.2 The Reject Bin and Recycle Bin

The bin is used for deleting images. There are two types of bins - reject and recycle
bin - but in the common scenario you will only have one of these bins available.

The Reject bin — is used as a temporary storage for images that are to

be deleted from this examination but kept in the system for future reject

analysis.

The Recycle bin — is used as a temporary storage for images that are to

be permanently deleted from the system.

Images may be put in the bin either by using drag and drop, or the commandReject
Series/Delete Series, which is available on images displayed in the matrix. The
Reject bin command,Empty Reject bin, deletes the images from the examination.
The images are now placed in special reject analysis worklists. The Recycle bin
command, Empty Recycle bin, permanently deletes the images from the system.

6.1.3 The Miniature screen view

The Miniature screen view shows screens symbolizing the screens of the computer
where the radiologist will view the images for the current request. The layout of
the screens is determined by the current hanging. There can be more than one
hanging to each examination. You can switch between different hangings by clicking
on the tabs above the miniature screens.

You can change the order of the hangings by drag and drop. Click on one of the
tabs above the miniature screens, and drag it to another tab. The hanging you moved
will be placed before the hanging you dragged it to.
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The Miniature screen view.

6.1.4 The Presentation Selector

The Presentation Selector on the toolbar shows all available presentations for the
current base examination, both manual presentations and DDP's. The presentations
in the list are sorted so that the most relevant presentation is first in the list.

A code is displayed after each presentation's name, indicating what type of
presentation this is. The following codes exist:

(M) - Manual presentation This code means that this presentation has
been manually created by a user. A manual
presentation can be made for a single user, for
a role or for all users in the system.

(TF) - Teaching file This code indicates a manual presentation that
is associated with a specific teaching file. If the
current worklist is the teaching file or
scheduled demonstration, the presentation will
be selected before any other manual
presentations or DDP's.

(DDP) -Default display protocol This indicates a presentation created from a
default display protocol.

The codes (M+) and (TF+) can also be shown, indicating that the presentation is
associated with an examination other than the current base examination. This can
be the case if the workstation has been configured to show presentations for all
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examinations in the current request, or for all examinations that match the worklist
search criteria for the current patient.

Important: For information on warning symbols next to the presentation selector, see
section 6.4 Applying a presentation (manual or DDP).

6.1.5 The Matrix

The Matrix consists of a number of rows, one for each examination in the request.
All rows are sorted so that the latest examination is always on top. The idea behind
the matrix is to have images of the same type in the same column for every
examination. By organizing images in this way, it is easier to compare images from
different examinations.

Note: It is possible to wrap the icons within each examination. If this is done, examinations
may consist of several rows of icons. For examinations with many series this gives
an improved overview of the examination. However, the principle of having images
of the same type in the same column will no longer be valid.

The Matrix.

1. Expand/Collapse button for an expanded examination.

2. Examination Text View.

3. Base examination symbol.

4. Examination part of a presentation.

5. Examination type label.

6. Text Note symbol.

7. Series type label.

8. Expand/Collapse button for a collapsed examination.
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Each row in the matrix begins with an Examination text view showing some data
about each examination (2). If a Text Note is attached to the examination this is
indicated by a small drawing-pin icon (6). Above the Examination text view is a row
that displays additional information about the examination (3, 4, 5). If the
examination is a base examination, this is indicated by an arrow to the left of the
Examination type header (3) and the Examination button has a slightly paler color
than usual (1). If the examination is part of a presentation, this is indicated by a small
symbol showing two overlapping images (4). The text information in the Examination
header describes the examination type (5). To the right of the examination text view
are the Matrix icons, one for each series in the examination. Above each Matrix icon
is a type label that indicates the series type (7).

An examination can either be expanded or collapsed. In the figure above one
expanded examination (1) and one collapsed examination (8) is shown. Which
examinations are expanded and collapsed is determined by the DDP or the manually
selected presentation. Clicking on the Expand/Collapse button manually expands
or collapses an examination. The information displayed in collapsed and expanded
mode is configurable, please read section 12.7 Configuring Windows Properties.

Each Matrix icon contain a series of images. This can either be a single image, a
stack of images, or a collection of images. The figure below shows two matrix icons.

Matrix icons.

1. Current displayed image, and total number of images in a stack or collection.

2. Image symbol - key image.

3. Image symbol - stack.

4. Image symbol - collection.

5. Matrix position.

6. Date and time when the image was produced.

To the upper left corner of each image are two numbers, representing the current
viewed image in a stack or collection and the total number of images in the stack
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(1). In the left Matrix icon above, the first image of twenty is displayed. For single
images the number combination "1(1)" is shown.

Stacks, collections, and multi-frame sequences are identified by the icon in the upper
right corner. The icon to the left contains a stack (3) and the icon to the right

contains a collection (4). Multi-frame sequences are indicated by the symbol .

Important or interesting images can be marked as key images The key image symbol
is shown in the left matrix icon (2).

The date and time when the image was taken is shown to the lower left (6). To the
lower right is a number that indicates the position of the series in the matrix (5).
This position number is also shown in the Image windows, and can be useful when
navigating in the matrix from an Image window.

6.1.6 Delayed and Pending Images

When a worklist spans over one or more DICOM Q/R archives, images may turn
up as black squares containing the word "delayed". This means that the image exists
in the archive, but has not yet been moved to the workstation to avoid unnecessary
delays. To retrieve delayed images for a patient, select Fetch delayed in the patient
pop-up menu. While the image is being transferred from the archive, it will be
represented by the text "pending".

6.2 Arranging Images

Before images are presented in the Image Windows it may be necessary to arrange
them properly in the matrix. This might, for example, include grouping images of
the same type together, defining key images, changing the series type, etc.

6.2.1 Collections

A collection is two or more images that have been grouped together. There are two
main reasons for wanting to create a collection. First, a modality might send a series
of images that are easier handled as stacks, in which case all the images in an
examination can be collected together. Second, there may be a varying number of
images in two different examinations that are compared, in which case images of
the same type are collected to preserve the concept of the matrix, i.e. images of the
same type are placed in the same column. In the Matrix window and Image windows,

collections are always marked with the collection symbol .

To create a collection

1. Hold down the CTRL-key while using the mouse to drag the images that are
to form the collection onto each other. When dropped, the dragged images will
be placed last in the collection. Note that even other collections can be added
to an exisiting collection.

2. Repeat step 1 until all desired images have been placed in the collection.

78IDS5, Version 11.1, December 2006 Using the Matrix Window

Arranging Images 6.2



A new collection of the images that have been dragged together will then be
created.

Note: A collection of images can only be made with images from the same modality,
that has the same bit depth, and the same number of samples per pixel.
Images that have been manually calibrated cannot be added to a collection for
safety reasons. To collect such images, you must first remove any manual
calibration.

To create a collection of all images in an examination

1. From the Patient text view pop-up menu, select Collect all.

All images in an examination will be put into one collection.

Note: The Collect all command will collect "as much as possible". This means that
if there are images in an examination that do not match, they will be put into
different collections. For safety reasons, images that have been manually
calibrated will not be collected.

To split a collection

1. Select the collection you want to split.

2. From the Matrix icon pop-up menu, click Collection and Split.

The images in the collection will be split up.

6.2.2 Key Images

The concept of key images can be used to mark important or interesting images.
From the Image Windows you can use special commands to quickly navigate between
key images. For more information on how you can move between key images, please
read section 7.5 Key Images.

To set or reset the key image tag

1. Place the mouse pointer over the image (matrix icon) that you want to mark as
a key image.

2. From the Matrix icon pop-up menu, click Key Images and Set All to set this
image, stack or collection as a key image. Alternatively, clickReset All to remove
the key image tag.

If a key image tag is set, a key image symbol will be visible in the matrix icon.

6.2.3 Joining Images - basic scoliosis function

The term "joining two images" means that two images are "glued" together to form
a new one. To be able to join two images, they must have the same width in pixels,
same channels, same bit depth and the same photometric details. They must also
both not be in stacks.
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To join two images

1. Hold down the SHIFT-key while using the mouse to drag the images that are
to form the joined image.

The image you are dragging is called the source image, and the other image is
denoted target image. The cursor will change its appearance depending on
where the mouse is positioned over the target image.

If the cursor is on the upper half, the source image will be joined above the

target image and the cursor will look like this:

If the cursor is on the lower half, the source image will be joined below the

target image and the cursor will look like this:

2. Release the mouse-button and confirm the joining operation by clicking the
OK button in the dialog box. Otherwise click the Cancel button. The new
image will be placed last in the collection.

6.2.4 Force Examination Type Matching

If an examination has the wrong examination type, i.e. the Examination type label
does not correspond to the examination being performed, it is possible to force a
change of the examination type.

To force examination type matching

1. From the Examination text view, click Force examination type, and select the
correct examination type.

The examination type label will change to the selected examination type.

To remove a forced examination type matching

1. From the Examination text view, click Force examination type and Remove
forced examination type.

The examination type will change back to its original state.

6.2.5 Force Series Type Matching

If an image in a series has been put in the wrong position in the Matrix, i.e. the type
label does not correspond to the actual image, it is possible to force the image to
change its series type.

To force series type matching

1. Drag and drop the Matrix icon that is in the wrong place, to the cell that has
the correct type label (the type label is shown above each cell).
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When the image is dropped it is automatically matched to the right series type.
If there was an image already occupying the series type, this image will be moved
to the last position in the examination row.

To remove forced series type matching

1. Place the mouse pointer on the series whose forced series type matching you
want to remove.

2. From the Examination row pop-up menu, click Remove forced series type.

The initial images will reappear in their original place.

6.3 Adjusting Image Settings

From the Matrix Window it is possible to perform various kind of image processing.
This includes changing the orientation of the images, cropping, grayscale operations,
etc.

To change the orientation of an image

1. Place the mouse pointer above the image whose orientation you want to change.

2. From the Examination row pop-up menu, click Orientation and select the
operation you want to perform. The following operations are available:

Flip vertical Flips the image vertically, along the horizontal axis.

Flip horizontal Flips the image horizontally, along the vertical axis.

Rotate 90° Rotates the image clockwise a quarter-turn.

Rotate 180° Rotates the image clockwise a half-turn.

Rotate 270° Rotates the image clockwise a three quarter-turn.

To invert the image

Note: Some images contain information about which part of the image is regarded as
the background. If Invert is applied to such an image, only the foreground is
inverted. This significantly enhances the readability of an inverted image.

1. Place the mouse pointer above the image you want to invert.

2. From the Examination Row pop-up menu, click Invert.

To perform cropping, grayscale operations, zooming etc

1. Place the mouse pointer on the image whose image settings you want to change.

2. From the Examination Row pop-up menu, click Open quick window.
Alternatively, you can double-click on an image to bring up the Quick Window
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(unless you have configured that the Image window should be opened for this
operation).

The Quick Window will be opened, in which it is possible to adjust image
settings like cropping, grayscale, zoom etc. When the Quick Window is closed
the miniature image icon will be automatically updated to reflect the new image
settings. For more information on how you use the Quick Window, see chapter 8
Using the Quick Window.

6.4 Applying a presentation (manual or DDP)

When you select an examination in the Information Window a DDP or manual
presentation will automatically be applied. The images in the examination will be
hung according to the selected DDP or presentation. IDS5 selects a DDP or
presentation based on certain rules:

• A manual presentation has higher priority than DDP's. If a manual presentation
exists it will be chosen before any of the DDP's. Manual presentations are sorted
so that the user presentations appear first, then role presentations, and finally
the system presentations.

• Among the DDP's, the one that "uses" as many as possible of the available
examinations for a specific patient, will be applied.

Example: A patient has three examinations prior to the base examination. In this
case, a DDP defined for three prior examinations will therefore have higher priority
than a DDP defined for one prior examination.

The currently selected DDP or manual presentation is shown in the presentation
selector in the toolbar. By clicking in the drop-down list you can manually apply a
specific DDP or presentation.

The following warning symbols may be displayed next to the presentation selector,
indicating that you are not viewing all relevant images:

Important: This symbol indicates that there are images in the current base examination
that are not displayed in the current presentation. If all images in the base
examination are added to the presentation, the symbol will disappear, see
section 6.6 Creating a Manual Presentation.

Important: This symbol indicates that there are more miniature monitors (virtual screens)
in the presentation than physical monitors available for your workstation. Select a
presentation with the correct number of monitors from the presentation selector,
or create a suitable manual presentation, see section 6.6 Creating a Manual
Presentation.

6.5 Creating a DDP

To create a custom DDP you use the DDP editor. In the editor you can define
templates for how images for certain types of examinations should be viewed (i.e.
number of monitors, screen partitioning, zoom level, stack tiling, etc).
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To start the DDP Editor

1. From the Tools menu, select DDP Editor.

The DDP Management dialog appears displaying all available DDP's.

2. Click New to create a new DDP, or select an existing DDP, and click Edit to
edit this DDP.

The DDP editor window will be opened.

The DDP editor window is similar in appearance to the Matrix window, see the
snapshot below. At the top is the Miniature Screen view, and at the bottom the
examination row templates. As this is a template, no images are displayed, just the
examination and series types. In the figure below, the examination type is CR Chest,
and the series types are AP and Lateral. The image being viewed is AP.

The DDP editor.

The normal workflow when creating DDP is as follows:

1. Specify the number of screens that should be used.
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2. Specify the screen partitioning for each screen.

3. Specify which examinations should be used.

4. Specify where each image should be presented, i.e. perform a hanging.

5. Specify image settings.

6. Specify image synchronization groups, i.e. define the behavior of the group
synchronization command.

7. Save the DDP.

6.5.1 Adding and Removing Screens

You can both add and remove screens. The number of screens should be equal to
the number of computer monitors used for image viewing by the radiologist.

To add a miniature screen

1. From the Hanging menu, select Add monitor.

A new miniature screen will be inserted on the extreme right. Up to four screens
are supported.

To remove a miniature screen

1. From the Hanging menu, select Remove monitor.

The screen on the extreme right will be removed.

6.5.2 Determining Screen Layout

Each screen can be partitioned in several different ways. Supported partitioning is
1x1, 1x2, 1x3, 2x1, 2x2, 2x3, 3x1, 3x2 and 3x3. The 1x1 partition means that only
one image appears on the screen. A 1x2 partition means that two images appear side
by side on the screen. A 3x1 partition means that there are three images above each
other.

To partition the screen

1. Place the mouse pointer over the miniature screen whose partition you want to
change.

2. From theMiniature Screen pop-up menu, clickPartition and select the desired
partitioning, i.e. 1x1, 1x2, 1x3, 2x1, 2x2, 2x3, 3x1, 3x2 or 3x3.

You can also specify the stack tiling if stacks or collections are being displayed.

To specify stack tiling

1. Place the mouse pointer over the miniature screen whose stack tiling you want
to change.
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2. From the Miniature Screen pop-up menu, click Stack tiling and select the
desired tile mode, i.e. Stack 1x1, Stack 2x2, Stack 3x3 or Stack 4x4.

6.5.3 Adding Examinations

A DDP can contain one or more examinations. When a DDP is applied to a case,
IDS5 will try to match your DDP with the available examinations.

To add an examination to the DDP

1. From the Examination menu, select Add examination.

A new examination row will be added. To the left of the examination row there
are two drop-down lists.

2. From the upper drop-down list, select which type of examination should be
matched. This can for example be a CR Order, CR Chest or CT Head.

3. From the lower drop-down list, select which examination within a certain type
should be matched. This can for example be the most recent examination, the
oldest examination, etc.

Examinations can be removed by selecting Remove examination from the
Examination Row pop-up menu.

6.5.4 Hanging Images

Image templates can be hanged by dragging the matrix icons from the matrix to the
desired position on the miniature screens. The miniature screens will then be updated
to reflect the images that are to be presented.

6.5.5 Specifying Image Settings

A DDP can apply a number of image settings. Which settings are available depends
on which IDS5 product you are running. More information on some of the settings
can be found in other parts of this document; see the links below. The complete list
is:

• Automatic crop (see section 7.3.4 Cropping)

• Zoom (see section 7.3.2 Zooming)

• Flip (horizontally, vertically or both)

• Rotation (0°, 90°, 180° or 270°. Note that rotation is applied before flipping.)

• Horizontal alignment (the horizontal alignment of the image when it is zoomed
to fit the window)

• Vertical alignment (the vertical alignment of the image when it is zoomed to
fit the window)

• Initial slice (which slice of a stack that initially displayed)
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• Stack tiling (see section 7.4.2 Viewing a Stack)

• Scanogram (see section 7.4.4 Using Scanograms)

• Slab mode (see section 7.16 Slab view, cannot be combined with Clinical
Applications)

• MPR (whether section 7.17 MPR - Multiplanar reconstruction should be started)

• 3D (whether section 7.18 3D - Volume rendering should be started)

• NM control (if the Nuclear Medicine control is to be visible)

• Palette (which color palette that should be applied)

• Clinical Applications (whether a Clinical Application should be started, cannot
be combined with Slab mode)

• Presentation states (whether a DICOM presentation state should be applied)

• Display CAD results (whether a CAD presentation should be displayed)

6.5.6 Specifying Image Synchronization Groups

Group synchronization is designed to make image synchronization more efficient,
as the selection of images to be synchronized can be prepared in a DDP or a manual
hanging. The images that belong to the same synchronization group are then
automatically synchronized when the Group synchronize command is applied.
The alternative would be to manually synchronize the images.

To specify a synchronization group

1. From the Miniature Screen pop-up menu click Group Sync to select a
synchronization group for each screen.

Membership of synchronization groups is used to control the behavior of the
Group Sync command, which is available in the image window.

2. Four synchronization groups are available for each hanging, and the default
value for a screen is none. The synchronization group to which a DDP screen
belongs, is set by selecting one of the available synchronization groups, i.e. Sync
group 1 to Sync group 4 in the pop-up menu that appears when right-clicking
on the DDP screen.

For more information about group synchronization, please read the Group
Sync command description.

6.5.7 Saving a DDP

When you have determined the screen layout and hung the images, save the DDP.
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To save a DDP

1. From the File menu, select Save as... (if you are editing an existing DDP you
can select Save if you want to overwrite the old DDP).

The Save as dialog appears.

2. Type in a name for the new DDP.

3. Select whether the DDP should be saved for personal, role, or system use by
clicking in the drop-down list. Note that if you do not have permission to save
for role or system use, these alternatives will not be displayed in the drop-down
list.

4. Click the Save button.

The DDP is now saved on the server.

6.6 Creating a Manual Presentation

In some cases a presentation based on a DDP is not sufficient. This might be the
case if you, for instance, want to use another screen partitioning than the one offered
by the DDP. In these cases you can create a manual presentation. A manual
presentation gives you full control over how images are hung.

Creating a manual presentation normally involves the following steps:

1. Add or remove miniature screens.

2. Determine the screen partition of each miniature screen.

3. Define which image is to be shown in each partitions area of each screen.

4. Adjust image settings (for more information on how to adjust images settings,
please read section 6.3 Adjusting Image Settings).

5. Save the presentation.

6.6.1 Adding Screens

You can both add and remove screens. The number of screens should be equal to
the number of computer monitors at the installation used by the radiologist for
image viewing.

To add a miniature screen

1. From the Edit menu, select Add monitor.

A new miniature screen will be inserted at the extreme right. Up to four screens
are supported.

To remove a miniature screen

1. From the Edit menu, select Remove monitor.
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The screen on the extreme right will be removed.

6.6.2 Determining Screen Layout

Each screen can be partitioned in several different ways. Supported partitions are
1x1, 1x2, 1x3, 2x1, 2x2, 2x3, 3x1, 3x2 and 3x3. The 1x1 partition means that only
one image appears on the screen. A 1x2 partition means that two images appear side
by side on the screen. A 3x1 partition means that there are three images above each
other.

To partition the screen

1. Place the mouse pointer over the miniature screen whose partition you want to
change.

2. From the Miniature Screen pop-up menu, click the desired partitioning, i.e.
1x1, 1x2, 1x3, 2x1, 2x2, 2x3, 3x1, 3x2 or 3x3.

6.6.3 Hanging Images

Images can be manually hung by dragging the image icons from the Matrix to the
desired position on the miniature screens. The miniature screens will be updated
to reflect the images that are to be presented. Clicking on an image in one of the
miniature screens will invert the corresponding Matrix icon, so that you can see
which image is actually hung. The cursor will look like this before dropping images

on a miniature screen:

6.6.4 Hanging Examinations

Entire examinations can be manually hung by dragging the examination to the
desired position on the miniature screens. The miniature screens will be updated
to reflect the images that are to be presented. New miniature screens will be
automatically added, when required, using the same partition as the previous
miniature screen.

6.6.5 Hanging Key Images

The key images of stacks or collections can be manually hung by pressing the
SHIFT-key while dragging the image icon. The result of this action will be to
present all the key images in the stacks or collections miniature screens on miniature
screens. New miniature screens will be automatically added, when required, using
the same partition as the previous miniature screen. Hanging examinations while
pressing the SHIFT-key hangs all of the examination's key images. The cursor will
look like this before dropping key images or examinations on a miniature screen:
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6.6.6 Start Clinical Application

A manual presentation can also start a Clinical Application automatically. To achieve
this, the Clinical Application should be running in the Image windows when the
presentation is saved. Move to the Image window and start a Clinical Application
for the appropriate images, using the sub-menuClinical applications in the pop-up
menu. Please, see also section 1.5.2 Clinical Applications.

6.6.7 Saving a Manual Presentation

When you have determined the screen layout and hung the images, save the
presentation.

To save a presentation

1. From the File menu, select Save presentation or Save presentation as.... If
you select Save presentation as... you will be given the opportunity to save the
presentation under a new name.

The Save as dialog appears.

2. Type in a name for the new presentation.

3. Select whether the presentation should be saved for personal, role, or system
use by clicking in the drop-down list. Note that if you do not have permission
to save for role or system use, these alternatives will not be displayed in the
drop-down list.

4. Click the Save button.

The presentation is saved on the server. To remove a presentation, select
Remove presentation from the File-menu.

6.6.8 Teaching File Presentations

A teaching file presentation is a presentation that is specific for a certain teaching
file or scheduled demonstration occasion. The presentation will be automatically
selected when you are working in that teaching file or occasion. There are two
possible workflows when using teaching file presentations.

One way is to fill the teaching file or occasion with examinations, see section 5.1.3
Creating a Teaching File. Then create the presentation in the teaching file or
occasion. In this case, presentations are saved just as in an ordinary manual
presentation (see above), where you specify that it should be saved for the teaching
file instead of system, role or user.

An alternative workflow is to arrange the presentation while working with the
examination in another worklist. Then, by adding the base examination to the
teaching file or occasion, see section 5.1.3 Creating a Teaching File, the current
arrangement will be automatically saved as the teaching file presentation.
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6.6.9 Report presentations

A "Report presentation" is presented to users of the IDS5/web product and it is
also exported to DICOM media, while other types of presentations are not.

A presentation becomes a Report presentation if it is saved either by using the Save
report presentation command or by selecting type "Report presentation" in the
Save presentation as... dialog. It is not possible to select a name for a Report
presentation, since there can only be one Report presentation per base examination.

6.7 Working with text notes

Each examination can have a text note with additional information, just like a post-it
note. The note can be removed, added, and edited if you have the necessary privileges
to do this. If an examination has a text note attached to it, the drawing-pin icon is
shown in the upper right corner of the Examination text view (see figure below).

To view a text note

1. Click the text note icon in the upper right corner of the Examination text view.

2. The text note is placed on top of the Examination text view.

3. Close the text note by pressing Escape, or by clicking the cancel icon in the
upper right corner of the text note (see figure below).

To remove a text note

1. Right click the Examination text view to display the pop-up menu, and select
Text note, Remove.
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2. The text note icon will disappear from the Examination text view.

To add a text note

1. Right click the Examination text view to display the pop-up menu, and select
Text note, Add.

A new text note will be displayed, with a default message (see figure below).

2. Type your comment about this examination and click the save icon, i.e. floppy
disc in the upper right corner (see figure below).

The text note will be closed and saved and the text note icon will appear in the
Examination text view.

To edit a text note

1. Right click the Examination text view to display the pop-up menu, and select
Text note, Edit.

2. The text note will now be shown with the text highlighted.

3. Edit the text as necessary, and save your changes by clicking the save icon.

Alternatively ...

4. If you are viewing a text note, right click the note and select Edit from the
pop-up menu.

5. Make the necessary changes and save the note as above.
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6.8 Deleting images

Images are deleted by dragging them to the bin. There are two types of bins - reject
and recycle bin - but in the common scenario you would only have one of these bins
available.

• The reject bin is used as a temporary storage for images that are to be deleted
from this examination but kept in the system for future reject analysis.

• The recycle bin is used as a temporary storage for images that are to be
permanently deleted from the system.

6.8.1 Using the reject bin

Note: To be able to delete images by placing them in the reject bin, you must have the
Reject Analysis Package license and the Reject Series permission. This
permission is available on a per role basis and can be configured in WISE/tools
by your system administrator.

When rejecting series they are deleted from that examination and patient. However,
the rejected series will be available together with a reject reason and comment in
special reject analysis worklists. Series can be rejected from the Matrix window as
well as directly from the Quick or Image windows. It is possible to reject a single
series as well as stacks and collections. When rejecting a stack or a collection all
images will be rejected with the same reject reason and comment.

To reject series

1. Drag-and-drop the image icon to the reject bin or select Reject series... from
the image icon menu.

You can also reject series directly from the Quick window or Image window by
selecting Reject series... from the pop-up menu.

2. In the Reject dialog, select a reject reason for the rejection. You can also enter
a reject comment, which is mandatory if you have selected the reject reason
Other failure.

If your site is not employing reject analysis, please select reject reason "Soft
delete".

3. ClickOK. The series is now placed in the reject bin awaiting confirmation and
you can continue working with the patient.

4. Before leaving the patient, the reject bin must be emptied, i.e. either you must
confirm the rejections you have done or restore the images. From the reject bin
menu, select Confirm all rejections.
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Reject bin containing imagesAn empty reject bin

To undo a rejection before confirmation

Before the rejection has been confirmed it is possible to undo the rejection.

1. Open the reject bin window by double-clicking the reject bin, or by selecting
Open reject bin in the Reject bin menu.

2. Right-click the image icon that you want to restore and select Restore series.
The series will disappear from the Reject bin window and reappear in the
matrix.

Alternatively you can select Restore all series to restore all series in the reject
bin.

3. Click Close to close the reject bin window.

Since rejected series are not actually deleted from the system but only from that
particular examination, it is also possible to restore rejected images after the
rejection has been confirmed. For more information see To restore rejected
images after confirmation.

6.8.2 Using the recycle bin

Note: To be able to delete images by placing them in the recycle bin, you must have the
Delete exam/series permission. This permission is available on a per role basis
and can be configured in WISE/tools by your system administrator.

When deleting series they are permanently removed from the system. Series can
be deleted from the Matrix window as well as directly from the Quick window. It
is possible to delete single series as well as stacks but not collections. A collection
must be split and the images deleted separately.

Note: It is only possible to delete images that have not yet been archived.

To delete series

Warning: Image deletion cannot be undone.

1. Drag-and-drop the image icon to the recycle bin or selectDelete series... from
the image icon menu.

You can also delete series directly from the Quick window by selecting Delete
series... from the pop-up menu.

The series is now placed in the recycle bin awaiting confirmation and you can
continue working with the patient.

2. Before leaving the patient, the recycle bin must be emptied, i.e. either you must
confirm the deletions you have done or restore the series. From the Recycle
bin menu, select Empty recycle bin.

3. Note that image deletion cannot be undone. Confirm the deletion by clicking
in the confirmation dialog checkbox and clicking OK.
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Recycle bin containing imagesAn empty recycle bin

To restore deleted images

Before the recycle bin has been emptied it is possible to undo the deletion.

1. Open the recycle bin window by double-clicking the recycle bin, or by selecting
Open recycle bin in the Recycle bin menu.

2. Right-click the image icon that you want to restore and select Restore series.
The series will disappear from the recycle bin window and reappear in the
matrix.

Alternatively you can select Restore all to restore all series in the recycle bin.

3. Click Close to close the reject bin window.
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7 Using the Image Windows

The following topics are included in this chapter:

■ Image Window Organization

■ Image symbols

■ Operations on Images

■ Operations on Stacks, Collections and Multiframe Sequences

■ Key Images

■ Synchronizing Images

■ Adjust images individually

■ Performing Measurements

■ Putting Annotations in an Image

■ Overlay plug-ins

■ Navigating among Images

■ Fetching Images

■ Image Calibration

■ Viewing Virtual 3D Images

■ Image Addition

■ Slab view

■ MPR - Multiplanar reconstruction

■ 3D - Volume rendering

■ The NM Control

■ Color Palettes

■ Clinical Applications

■ Mammography screening

■ Mammography CAD

■ DICOM Presentation States

■ Compressed images

The Images Windows are used for inspecting and comparing images or stacks. You
can have up to four Image Windows, one on each monitor, showing images from
different examinations or organs from a patient. The layout of images in each Image
Window is determined by the hangings defined in the Matrix Window. In the Image
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Window you also have access to a range of operations for manipulating images, e.g.
different kinds of measurements, zooming, setting grayscale, etc.

This section describes how to use the functionality offered by the Image windows.

7.1 Image Window Organization

Besides the image being viewed, the Image Window also contains an overlay with
status information about the image.

The figure below shows a snapshot of the Image Window.

The Image Window.

1. Patient information.

2. Information from the modality.

3. Current viewed image and the total number of images in a stack or collection.

4. Date and time when the image was produced.

5. Image position in the matrix.

6. Scanogram.

7. Ruler.

8. Side markings.

9. Image symbols, here showing: key image, synchronization and stack symbols.

10. Synchronization group number if member of a synchronization group.
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11. Center and width of grayscale window.

Important: For information on warning symbols next to the presentation selector, see
section 6.4 Applying a presentation (manual or DDP).

Patient information is displayed in the upper left corner, i.e. patient name and ID
(1). Below the patient ID information relating to the modality being used (2). If a
stack or collection is being viewed the position of the current image, along with the
total number of images in the stack or collection will be shown in the lower left
corner (3). Also at the bottom left is the date and time when the image was produced
(4).

In the upper right corner, the center and width of the grayscale window is displayed
(11). If the image belongs to a synchronization group, the synchronization group
number is shown (10). Below this are the image symbols (9), here showing that this
particular image is marked as a key image, that the view is synchronized with another
image view and that we are viewing a stack. All the available image symbols are listed
and described in section 7.2 Image symbols below.

A calibrated image can be supplemented with rulers at the sides (7). Which image
types have rulers and where they are located is specified in the system configuration.
If a ruler is displayed, it is usually 5 centimeters long and has centimeters markings
each centimeter.

To the left of the ruler there is a side marking, indicating the orientation of the
image (8).

Important: The orientation information is taken from the DICOM image and depends on the
correctness of the information in the DICOM image. Thus, if the information is
incorrect in the DICOM image, these side markings should not be used as indicators
for the true orientation of the image.

At the bottom right is a scanogram that is used to show which part of a stack (or
parts if in tile mode), that is currently being viewed (6). The position of the image
in the matrix is also shown in the bottom right corner (5).

To hide/show image information

1. To hide some of the information presented in the Image window select Image
Information from the View menu and select Minimum.

All information is however not hidden. For example, patient name and ID are
still displayed. This information can be hidden by selectingAnonymized image
information. To view all available information again, select Maximum.

7.2 Image symbols

The image symbols are displayed in the upper right corner of the Image
Window [96], giving additional information of the currently viewed image such as
type and view state. The available image symbols are described in the table below:

Adjust images individually
The series is currently being adjusted

individually. The command enables individual
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adjustments of series that are part of a
collection. Image operations are always applied
simultaneously to all slices in a stack. Read
more in section 7.7 Adjust images individually.

Collection
The series is a collection. A collection is a

group of images assembled by the user. Read
more in section 4.7 Collections and section 7.4
Operations on Stacks, Collections and
Multiframe Sequences.

Compression
The image has sometime in the past

undergone some kind of lossy
image-compression. It does not mean that the
image currently is compressed. Read more in
section 7.25 Compressed images.

Cropped image
The image is cropped. Read more in

section 7.3.4 Cropping.

Edge enhancement
The image is edge enhanced. Read more

in section 7.3.6 Edge Enhancement.

Flipped horizontally
The image is flipped horizontally. Read

more in section 7.3.7 Flipping and Rotating
Images.

Flipped vertically
The image is flipped vertically. Read more

in section 7.3.7 Flipping and Rotating Images.

Key image
The image is a key image. Key images are

used to mark important or interesting images.
Read more in section 7.5 Key Images.

Mammography CAD
The examination includes a Mammography

Structured Report with CAD results. Note
that the symbol only indicates the existence of
a Structured Report in the examination, not
that the current image has CAD findings. Read
more about Mammography CAD in
section 7.23 Mammography CAD.

Multiframe
The image is a multiframe. A multiframe

is a single file containing several images
(frames). Film sequences are an example of
multiframe images, but there are other types
as well. Read more in section 7.4 Operations
on Stacks, Collections and Multiframe
Sequences and section 7.4.6 Using Cine loops.
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Overlay plugin running
An overlay plug-in is visible. An overlay

plug-in is a special purpose-built overlay that
is not fully integrated into the IDS5
workstation, but installed separately. Read
more in section 7.10 Overlay plug-ins.

Presentation state available
The image contains presentation states

which can be applied. A DICOM presentation
state describes how the image should be
presented in terms of e.g. annotations,
orientations and window/level. Read more in
section 7.24 DICOM Presentation States.

Presentation state not fully
displayed A presentation state has been applied but

contains unsupported information which is not
displayed. Read more in section 7.24 DICOM
Presentation States.

Rejected Analyzed
The image is rejected and has been

analyzed. Read more in section 10.3 Reject
analysis.

Rejected New
The image is rejected and has not been

analyzed. Read more in section 10.3 Reject
analysis.

Rotated 90°
The image is rotated 90° clockwise. Read

more in section 7.3.7 Flipping and Rotating
Images.

Rotated 180°
The image is rotated 180°. Read more in

section 7.3.7 Flipping and Rotating Images.

Rotated 270°
The image is rotated 270° clockwise, which

is the same as 90° counter-clockwise. Read
more in section 7.3.7 Flipping and Rotating
Images.

Slab mode running
The stack is shown in slab mode. In slab

mode several slices are grouped together into
slabs, resulting in a smaller stack of images
compiled from the original stack. Read more
in section 7.16 Slab view.

Slab mode warning
The stack is unsuitable for slab viewing (it

might not be parallel, contain jumps in location
etc.) Read more in section 7.16 Slab view.

Stack
The series is a stack. A stack is a number

of images taken on the same occasion by the
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same modality. Read more in section 7.4
Operations on Stacks, Collections and
Multiframe Sequences.

Synchronized images
The image views are synchronized with

each other. When an operation, such as
scrolling in a stack, is applied to one of the
synchronized images, the same operation will
be applied to all images that are synchronized
with it. Read more in section 7.6
Synchronizing Images.

Warning - not all images hung
This symbol indicates that there are images

in the current base examination that are not
displayed in the current presentation. The
symbol is displayed next to the presentation
selector. Read more in section 6.4 Applying a
presentation (manual or DDP).

Warning - not all monitors
displayed This symbol indicates that there are more

miniature monitors (virtual screens) in the
presentation than physical monitors available
for your workstation. The symbol is displayed
next to the presentation selector. Read more
in section 6.4 Applying a presentation (manual
or DDP).

Virtual 3D
The stack can be viewed in virtual 3D.

Virtual 3D stacks are created using the Sectra
3D Package and allows you to view the image
set in virtual 3D. Read more in section 7.14
Viewing Virtual 3D Images.

7.3 Operations on Images

IDS5 offers a wide range of image operations in order to give as much support as
possible while viewing images. This section describes how to use these operations.

Ordinary operations such as zoom or pan are provided as so called interaction modes.
A view is set to a certain interaction mode and the functionality of that mode is
always available directly on the left mouse button. Other functionality such as edge
enhancement and the magnifying glass are operations that must be explicitly triggered
from menu options etc.

7.3.1 Interaction modes

The interaction mode of an image view describes which operation to perform when
the mouse is actively used. There are three interaction modes valid on images: Pan,
Zoom and Window/Level. These can be set explicitly from the Image Window
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pop-up menu. The left mouse button is always tied to the current interaction mode.
This means that the user decides what actions left mouse button operations should
correspond to.

The user can change interaction mode on-the-fly by using any of the three modifier
keys CTRL, SHIFT or ALT. When the modifier keys are released, the old
interaction mode will be active again.

Tip: Interaction modes can be applied to several images simultaneously. E.g. zooming
in several images or browsing several stacks. Read more in section 7.6
Synchronizing Images.

It is possible to map a certain mouse button combination to a specific interaction
mode. Read more on how to configure interaction modes.

If you are using a default active command, please see Default active command for
restrictions regarding interaction modes in combination with default active
commands.

To use interaction modes

1. Display the Image Window pop-up menu and select the Zoom interaction
mode.

2. Hold down the left mouse button in the image view.

3. Move the mouse back and forth.

If zooming works properly, you zoom in and out in the image dynamically.

4. Make sure that the image is zoomed in.

5. Select the Pan interaction mode from the Image Window pop-up menu.

6. Hold down the left mouse button in the image view.

7. Move the image back and forth and to the left and to the right.

8. Press the Ctrl key while moving the mouse.

Zoom will be activated and the image will be zoomed.

The other interaction modes work the same way - hold down the left mouse
button and move the mouse.

Zoom Zooms the image continuously. The ALT modifier key activates
the Pan interaction mode. The image might appear slightly
fuzzy when performing zoom. This is normal. Release the
mouse-button and the image will automatically regain its focus.

Pan Pans the image. Note that an image can only be panned if it is
zoomed in. The CTRL modifier key activates the Zoom
interaction mode. The SHIFT modifier key restricts panning
horizontally or vertically.

Window/Level Adjusts the grayscale of the image. Note that this can only be
done for grayscale images. The CTRL modifier key adjusts the
sensitivity of the interaction mode. The SHIFT modifier key
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restricts Windowing/Leveling to affect only the window width
or the window center. The Window/Level functionality can be
configured.

Note: To use the Zoom interaction mode, your computer must have a graphics card that
supports hardware acceleration. If continuous zoom does not work satisfactory on
your workstation, it is very likely that either the graphics card does not support
hardware acceleration, or hardware acceleration in IDS5 is disabled. Please read
section 12.4 Configuring Image Display Properties for further information regarding
hardware acceleration.

Note: There are two additional interaction modes, Browse and Rotate that are only valid
on stacks or collections. Read more in section 7.4 Operations on Stacks, Collections
and Multiframe Sequences.

7.3.2 Zooming

You can use "zoom in" to obtain a close-up view of a part of the image, or "zoom
out" to see more of the image at a reduced magnification.

To zoom an image

1. Zoom by using the Zoom interaction mode.

2. From the Image window pop-up menu, select Zoom and click on the
zoom-operation you want to perform. The following operations are supported:

Zoom in Magnifies the image view by a factor of two.
Note that there is a limit to how much an image
can be magnified depending on the available
memory in the workstation.

Zoom out Reduces the image view by a factor of two.

Zoom to fit window Zooms the image to fit the screen (or screen
part) exactly.

True size (image) Zooms the image so that 1 cm on the screen
corresponds to 1 cm in the image. Note that
both the image and the screen must be calibrated
before you can use this command. Please read
section 7.13 Image Calibration for more
information on how to calibrate an image.

Pixel to pixel (1:1) Zooms the image so that there is a one-to-one
relationship between pixels on the screen and
pixels in the image file. This is to ensure that
you will see exactly what is in the image file, and
all the information in the image will be seen.

Quadrant zoom A single command that zooms the image by a
factor of 1.8 and moves focus to the image
quadrants. Focus is moved to the next quadrant
by activating the same command again. When

102IDS5, Version 11.1, December 2006 Using the Image Windows

Operations on Images 7.3



all quadrants have been displayed, the image
zooms out again .

Toggle Zoom A zoom command that toggles between a
magnification of the image view by a factor of
two, and the zoom factor the image view had
prior to executing the command. The toggle
zoom command also has the ability to zoom in
a specific direction for images that have a defined
laterality, e.g. mammograms. The command will
zoom towards the left side for images with "L"
laterality, to the right for images with "R"
laterality and to the center for other images.

An alternative to zoom with the Zoom interaction mode is to use theZoom control.
The Zoom control is displayed by clicking the Show zoom control command. A
small window is displayed. Move the mouse pointer on top of this window. Click
and hold the left mouse-button while moving the mouse up and down. The mouse
movements will then continuously zoom as described above. The Show zoom
control command is not available in the menus by default. However, it can be added,
as described in section 12.2 Configuring Menus and Toolbars.

7.3.3 The Magnifying Glass

The magnifying glass is at hand when you quickly want to enlarge small parts of an
image. Once you have activated the magnifying glass you move it over an image,
the magnified part of the image will be displayed in the glass. The figure below
displays a snapshot of the magnifying glass.

To use the magnifying glass

1. From the Image window pop-up menu, click Magnifying glass or use the
short-cut CTRL+g. The glass will appear with its center above the point you
chose to activate it.
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• Move the glass over the current image by holding down the left
mouse-button and dragging the glass over the image.

• Increase the magnification in the glass by rotating the mouse-wheel forward
while the mouse pointer is over the glass.

• Decrease the magnification in the glass by rotating the mouse-wheel
backward while the mouse pointer is over the glass.

• Resize the glass by taking hold of the bottom right corner (the small white
square) of the glass. Drag the corner to increase/decrease the size of the
glass and release the button when you are done.

• To freely adjust the grayscale is done in the same way as in the Image
window. When you are done the grayscale setting in the glass will be applied
to the image under glass.

• When you are done, right click on the glass to hide it.

Tip: Magnifying glass operations can be applied to several images simultaneously. Read
more in section 7.6 Synchronizing Images.

7.3.4 Cropping

Cropping means that you cut out some part of the image. This can be useful, if for
example you want to remove white borders in image plate images. Cropping can
be performed either manually or automatically. When an image is cropped it is

marked with the cropped image symbol .

Note: No image data is deleted when an image is being cropped. By performing a reset
you can view the entire image again.

It is also possible to toggle between cropped states.

To perform manual cropping

1. From the Image Window pop-up menu, click Crop and Crop image.

2. Move the mouse-pointer to the upper left corner of the part that is to be cut
out, and click the left mouse-button.

A rectangle will appear, defining the area that is to be cut out.

3. Move the mouse-pointer to the lower right corner of the part that is to be cut
out, and click the left mouse-button.

4. If needed, adjust the rectangle by dragging its edges or corners while holding
down the left mouse-button.

5. Double-click on the image or press RETURN, to crop the image. If you decide
not to crop the image, press DELETE to remove the rectangle without cropping
the image.
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To perform automatic cropping

1. From the Image Window pop-up menu, click Crop and Automatic crop.

The image will be automatically cropped. Automatic cropping is based on
calculating variations in the image statistics. There are two different Autocrop
implementations: an old based on standard deviation calculation, and a new
based on line/edge detection. Which one is currently active is controlled by a
configuration parameter. The default setting is to use the new algorithm for
CR images, and the old one for all other modalities.

The result of this operation depends very much on what the image looks like.
If you try to crop an image that has no "natural" boundaries, the cropping
operation will fail. Note that statistical parameters must be configured for each
modality by the system administrator.

To reset cropping

1. From the Image Window pop-up menu, click Crop and Reset cropping.

The cropping operation will be reset and the whole image will be visible again.

To toggle between crop states

1. From the Image Window pop-up menu, click Crop and Toggle crop state.

The image toggles between the current state and previous crop state.

7.3.5 Setting Grayscale

One very useful operation is adjustment of the image grayscale. This can be done
in different ways:

• Choosing settings in the image, with settings originating from the modality.

• Using the function keys F1 - F12 to select predefined grayscale windows for a
certain type of modality. It is also possible to add predefined grayscale windows
for each modality.

• Repeatedly applying the same step command to step through the predefined
grayscale windows.

• Using interaction modes and freely adjusting the grayscale using the mouse.

To select settings originating from the modality

1. From the Image window pop-up menu, click Window/Level and select the
desired grayscale setting from the modality. The name of these grayscale settings
depends on how they have been set up by the system administrator.

To use predefined grayscale settings

1. From the Image Window pop-up menu, click Window/Level and select the
desired predefined grayscale setting.
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All predefined settings are associated with a function key (F1 - F12) that can be
used as a shortcut. The shortcut key is specified to the right of each command
in the pop-up menu.

To step through predefined grayscale settings

These commands are preferably activated by using shortcut keys. The shortcut keys
are specified to the right of each command in the pop-up menu. Please read
chapter 12 Setting Options for a description of how to define and review existing
shortcuts.

1. On the Image Window pop-up menu, point to Window/Level and then click
one of the following repeatedly:

• Step W/L to begin stepping through the defined grayscale settings as
defined on the function keys. The command returns to the original grayscale
settings when all defined settings have been applied one by one.

• Step all W/L to begin stepping through all the defined grayscale settings
defined both in the displayed DICOM image itself and as defined on the
function keys. The command returns to the original grayscale settings when
all defined settings have been applied one by one.

Note: To be able to use the Step all W/L command you must have the
Mammography license.

To define grayscale settings

1. From the Image Window pop-up menu, click Window/Level and Define....

The Define Window Level Settings dialog appears.

2. In the Modality drop-down list, select for which modality the new setting will
be valid.

3. In the Name field, type in a name for the new setting.

4. In the Width and Center fields, type in the width and center of the grayscale
window.

Note: The Width and Center fields in the dialog contain preset values from the
current image.

5. Click the Add button.

The new setting is added to the Image Window pop-up menu, and a function
key (F1 - F12) is also automatically assigned to the new setting. To remove a
predefined setting, select it in theDefine Window Level Settings dialog, and
click the Remove button.

To freely adjust the grayscale

1. Default for free grayscale adjustment in the Image Window is to use the
Window/Level interaction mode on the middle mouse button. However, this
can be configured differently (Read more in section 12.10 Configuring
Interaction Modes). Moving the mouse while holding the middle mouse-button
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down (Window/Level interaction mode expected), will interactively change the
center, and width of the grayscale window. Pressing CTRL while moving the
mouse will make the grayscale settings change more slowly, thereby making it
easier to make small grayscale adjustments. Pressing SHIFT while moving the
mouse makes it possible to only change either width or center depending on
which direction the mouse is moved first. Mouse movement directions can be
configured using the Options dialog. Please read section 12.5 Configuring Image
Tools Properties for more information. The default setting is the following:

Moving to the left The image gets brighter.

Moving to the right The image gets darker.

Moving up The contrast increases.

Moving down The contrast decreases.

2. An alternative to use the Window/Level interaction mode is to use the W/L
control. The W/L control is displayed by the Show W/L control command.
A small window is displayed. Move the mouse pointer to this window. Click
and hold the left mouse button. Moving the mouse will then correspond to
changing the grayscale as described in the first list item above. The ShowW/L
control command is not available by default in the menus. However, it can be
added, as described in section 12.2 Configuring Menus and Toolbars.

To invert the image

1. From the Image window pop-up menu, selectWindow/Level and select Invert.

The current image is inverted.

Note: Some images contain information about which part of the image is regarded
as the background. If Invert is applied to such an image, only the foreground
is inverted. This significantly enhances the readability of an inverted image.

7.3.6 Edge Enhancement

You can easily enhance the edges in an image by applying the advanced edge
enhancement filter provided by IDS5. Edge enhancement can for example be used
to improve visualization of small blood vessels in the lungs. Images with edge

enhancement are always marked with the edge enhancement symbol .
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The level of edge enhancement can be configured to achieve stronger or weaker
edge enhancement effect, as described in section 12.5 Configuring Image Tools
Properties.

Note: If statistics measurements are performed on an image that has been edge
enhanced, the statistics result will be based on the processed image data and not
on the original image data. The result will most likely differ from the result obtained
if the statistics measurement were done on the unprocessed image.

To perform edge enhancement

1. From the Image Window pop-up menu, select Edge enhance, or use the
short-cut CTRL+e.

The current image is edge enhanced. The edge enhancement symbol is displayed
in the upper right corner of the image, and the pop-up menu option Edge
enhance is tick marked.

To undo edge enhancement on an image

1. From the Image Window pop-up menu, unselect the tick markedEdge enhance,
or use the short-cut CTRL+e.

7.3.7 Flipping and Rotating Images

You can easily change the orientation of images. This can be useful if the image has
been incorrectly read into the PACS. When an image is rotated or flipped, it is
marked with one of the orientation image symbols (see below).

To change the orientation of an image

1. Place the mouse-pointer above the image whose orientation you want to change.

2. From the Image Window pop-up menu, select Orientation and click on the
operation you want to perform. The following operations are available:

Flip horizontal — Flips the image horizontally, along the
vertical axis.

Flip vertical— Flips the image vertically, along the horizontal
axis.

Rotate 90° — Rotates the image clockwise a quarter-turn.

Rotate 180° — Rotates the image a half-turn.

Rotate 270° — Rotates the image clockwise a three
quarter-turn.
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7.3.8 Default Image Settings

If an image state has been altered in some way, such as by a change of grayscale
settings, or a change of orientation, the new state can be made the default setting
for the image.

To set the default state

1. From the Image Window pop-up menu, click Save as default.

The new state is immediately shown in the Matrix window thumbnails and
everywhere in the Image Windows where the image is currently shown.

To perform an image reset

If you have made changes to an image and want to return to the default state you
can reset the image.

1. From the Image Window pop-up menu, click Reset image.

All image settings that you have changed will be reset to the images default
settings. Only settings such as grayscale, orientations, cropping, etc are restored.
Annotations and measurements will not be reset.

7.4 Operations on Stacks, Collections and Multiframe
Sequences

This section describes how to use functions that are specific to stacks and collections.

Note: The operations described in this section are valid for both stacks and collections.
Try to think of the word "stack" as "stack or collection".

Ordinary operations such as zoom or pan are provided as so called interaction modes.
A view is set to a certain interaction mode and the functionality of that mode is
always available directly on the left mouse button. Other functionality such as edge
enhancement and the magnifying glass are operations that must be explicitly triggered
from menu options etc.

7.4.1 Interaction modes

The interaction mode of an image view describes which operation to perform when
the mouse is actively used. There are five interaction modes valid on stacks: Pan,
Zoom, Window/Level, Browse and Rotate. These can be set explicitly from the
Image Window pop-up menu. The left mouse button is always tied to the current
interaction mode. This means that the user decides to what actions left mouse button
operations should correspond to.
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The user can change interaction mode on-the-fly by using any of the three modifier
keys CTRL, SHIFT or ALT. When the modifier keys are released, the old
interaction mode will be active again.

Tip: Interaction modes can be applied to several images simultaneously. E.g. zooming
in several images or browsing several stacks. Read more in section 7.6
Synchronizing Images.

It is possible to map a certain mouse button combination to a specific interaction
mode. Information on mouse configuration is available in section 12.10 Configuring
Interaction Modes.

If you are using a default active command, please see Default active command for
restrictions regarding interaction modes in combination with default active
commands.

To use interaction modes

1. Display the Image Window pop-up menu and select the Zoom interaction
mode.

2. Hold down the left mouse button in the image view.

3. Move the mouse back and forth.

If zooming works properly, you zoom in and out in the image dynamically.

4. Make sure that the image is zoomed in.

5. Select the Pan interaction mode from the Image Window pop-up menu.

6. Hold down the left mouse button in the image view.

7. Move the image back and forth and to the left and to the right.

8. Press the Ctrl key while moving the mouse.

Zoom will be activated and the image will be zoomed.

The other interaction modes works the same way - hold down the left mouse
button and move the mouse.

Zoom Zooms the image continously. The ALT modifier key activates
the Pan interaction mode. The image might appear slightly
fuzzy when performing zoom. This is normal. Release the
mouse-button and the image will automatically regain its focus.

Pan Pans the image. Note that an image can only be panned if it is
zoomed in. The CTRL modifier key activates the Zoom
interaction mode. The SHIFT modifier key restricts panning
horizontally or vertically.

Window/Level Adjusts the grayscale of the image. Note that this can only be
done for grayscale images. The CTRL modifier key adjusts the
sensitivity of the interaction mode. The SHIFT modifier key
restricts Windowing/Levelling to affect only the window width
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or the window center. The Window/Level functionality can be
configured.

Browse Browses a stack. Note that this interaction mode can only be
used for image stacks. The ALT modifier key activates the Pan
interaction mode. The CTRL modifier key activates the Zoom
interaction mode.

Rotate Rotates a virtual 3D stack. Note that this interaction mode can
only be used for virtual3D stacks. The ALT modifier key
activates the Pan interaction mode. The CTRL modifier key
activates the Zoom interaction mode.

Note: To use the Zoom interaction mode, your computer must have a graphics card that
supports hardware acceleration. If continuous zoom does not work satisfactory on
your workstation, it is very likely that either the graphics card does not support
hardware acceleration, or hardware acceleration in IDS5 is disabled. Please read
section 12.4 Configuring Image Display Properties for further information regarding
hardware acceleration.

7.4.2 Viewing a Stack

Images in a stack can either be viewed one at a time, or you can tile the screen to
show several images simultaneously. Partitioning the screen is useful if you want to
compare images in a stack.

To tile a stack

1. From the Image Window pop-up menu, click Stack tile and select the tile mode
you want to use.

The following tile modes are available:

• 1x1 (CTRL+1), only one image from the stack is shown. It is possible to
configure that a mouse double-click combination in any image in any tile
will display that particular image in 1x1 mode. Read more in section 12.5
Configuring Image Tools Properties.

• 2x2Moving down (CTRL+2), 3x3 (CTRL+3) and 4x4 (CTRL+4). Here
four, nine or sixteen images respectively are shown from the stack. Images
are placed so that they fill the new partition from left to right. Example: If
you have a stack containing four images, A, B, C and D, and you view them
using a 2x2 tile. The upper left image will be A, the upper right B, the lower
left C and the lower right will display image D.

2. The image you select the command on will be shown in the upper left corner
of the new tile. For example, if you have a 3x3 tile mode and select the 2x2 tile
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mode on the middle image, the tile mode will change to 2x2 with that image in
the upper left corner of the new tile.

Tip: By using the short-cuts with CTRL+2 to 4 you can browse through a stack in
larger steps than by using the mouse-wheel. For example, if you have a stack
in a 4x4 tile mode and want to browse the stack fifteen images at a time,
position the mouse over the lower right image while repeatedly pressing
CTRL+4. In this way the image in the lower right corner will move to the upper
left corner each time you select the command.

7.4.3 Moving Around in a Stack

The Image Window provides a variety of methods to move around in a stack (i.e.
displaying different parts of the stack).

To move up and down in a stack

1. Use the Browse interaction mode to move around in the stack. The Browse
interaction mode can be mapped to a certain mouse button combination (See
section 12.10 Configuring Interaction Modes) or it can be explicitly selected
from the Image Window pop-up menu to respond to left mouse button actions.
Browse is mapped to the mouse button combination Left + Middle by default.

2. From the Image Window pop-up menu, click Stack navigation and selectPage
up/Page down orLine up/Line down to move up or down in the stack. When
you are viewing a single image from the stack, e.g 1x1 tile mode, the Line and
Page commands have the same effect. When using 2x2 tile mode, for example,
Page Up means moving backwards in the stack four images (i.e. a whole page)
while Line Up means moving backwards two images (i.e. one line).

3. While the mouse pointer is over the stack, roll the mouse-wheel forward or
backward. One step of the mouse wheel correspond to Line up or Line down.

4. A Scroll control is also available. You display the scroll control by selecting the
Show scroll control command. A small window is displayed. Move the
mouse-pointer to this window. Click and hold the left mouse-button. Mouse
movements up and down will then correspond to stack scrolling as in step 3
above. The Show scroll control command is not available in the menus by
default. However, it can be added, as described in section 12.2 Configuring
Menus and Toolbars.

To move to the first or last image in a stack

1. From the Image Window pop-up menu, click Stack navigation and select First
to move to the first image in the stack, or select Last to move to the last image
in a stack.

7.4.4 Using Scanograms

A scanogram is used to show which part of the stack (or parts if in tile mode) is
currently being viewed. If a scanogram is associated with a stack, the scanogram is
shown in the lower right corner of the image.
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There can be more than one scanogram associated with a stack. You can move
between multiple scanograms by clicking on the + and - signs in the upper left
corner of the scanogram.

To move in a stack using a scanogram

1. Click on the slice you want to display.

The selected slice highlighted and the Image window is updated with the selected
slice.

To hide/show scanograms

1. From the Image window pop-up menu, click Scanogram, and then selectHide
scanogram to hide the scanogram, or select Show scanogram to make the
scanogram visible.

7.4.5 Using the Localizer

The Localizer is used for navigating between several stacks in a study, with for
instance axial, sagittal and coronal slices. While one stack is being viewed, it is
possible to activate Localizers in the other corresponding views. If the mouse pointer
is moved to one of the other views, a Localizer for that stack is shown instead.

If the currently viewed stack is shown in tiled mode, several Localizer lines are
shown in the corresponding views. To determine which line belongs to which tile,
make sure that tile zooming is configured to execute on a mouse double-click
combination and use that combination on the tile to enlarge it. The Localizer line
for this tile in the corresponding views will be displayed.

Another feature of the Localizer is the crosshair marker in the viewed stack. The
position of the crosshair is marked by a tick on the corresponding Localizer lines.
Note that there may be many positions in the currently viewed stack image that
correspond to the same tick on a Localizer line. In technical terms, the crosshair
and Localizer line tick are not necessarily the exact same point in 3D space. However,
the tick is always the correct projection of the crosshair.

If the crosshair marker is configured to be used for stack navigation, corresponding
views will update with the closest projection as the crosshair marker changes position.
Note that if a corresponding view is in tile mode, the closest projection is displayed
in the top left tile. The crosshair marker is moved by dragging it with the left mouse
button or by double click in the view while holding down the SHIFT button. Please
read chapter 12 Setting Options to find out how to configure the crosshair marker.

To hide/show Localizer

1. From the Image Window menu, click View and Localizer. Select Hide
localizer to hide the Localizer, or Show localizer to make it visible. Show
simple localizer displays the Localizer lines without the crosshair. It is possible
to configure the default state of the Localizer, please read chapter 12 Setting
Options.
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7.4.6 Using Cine loops

A cine loop is a way to view all images in a stack. The images are shown after each
other like an animation. There are two kinds of cine loops, the cine loop which
restarts from the beginning of the stack when the end is reached and the bounce
loop that plays backwards through the stack again when it reaches the end of the
stack.

To start a cine loop/bounce

1. From the Image Window pop-up menu, click Cine loop or Cine bounce.

To stop a cine loop

1. From the Image Window pop-up menu, click Stop cine.

Important: If you are running a cine loop on a collection of series, and you have already run a
cine loop on one of the series before collecting them, you should be aware that
the cine loop range will be set to the beginning and end of the series where the
cine loop was last run. Looping over the created collection will thus only display
this original series. You can however adjust the loop range to include the complete
collection using the cine tool. Please refer to section 7.4.7 Using the Cine Tool for
more information on setting the loop range.

7.4.7 Using the Cine Tool

The Cine Tool is an extension of the cine loop. If your IDS5 is equipped with the
Cine Tool, it will appear as in the snapshot below, when you start a cine loop or
bounce loop.

The cine functions from top to bottom, left to right:

ECG/Frame indicator ECG/Frame indicator shows the currently
displayed frame, selected range and the ECG
curve. The control is also used to select the
frame to display. If no ECG information is
available a slider for positioning and range
selection is shown instead.

Thumb wheel This control is used for accurate
positioning in the sequence. Drag the thumb
wheel to the right to move forward, or to the
left to move backward in the sequence.

Frame Frame shows the currently displayed frame
number together with the total number of
frames in the sequence.
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Speed control This slider controls the speed and direction of
the animation. The default setting is the true
frame rate, if the image contains such
information.

Speed Shows the current frame rate (FPS=frames per
second). If the true frame rate is below the
selected frame rate, a warning symbol is shown

. The true speed is normally lower than the
selected frame rate while loading the images
in the first run.

Minimize This button minimizes the cine control.
Reset the cine control to its original size by
clicking on the minimized cine control.

Quit This button stops the cine loop and closes
the cine control.

First/Last These buttons jump to the first/last
image in the sequence

Step backward/step forward These buttons steps one frame
backward/forward in the sequence.

Start range/Stop range These buttons selects the animation
range. Start range selects the displayed frame
as the first frame in the interval and Stop
range selects the displayed frame as the last
frame in the interval.

Play/Pause These buttons plays or holds the
sequence respectively.

Reset This button resets the speed to the default
value.

Hide image information This button hides the image information
when playing the sequence. A higher frame
rate can be achieved when the image
information is hidden.

Loop/Bounce This button toggles the animation mode.
Loop runs the sequence in the same direction,
Bounce runs the sequence forward and
backward alternately.

ECG on / ECG off This button shows/hides the ECG. A
higher frame rate can be achieved when the
ECG is turned off.

Position This button moves the control from the
bottom to the top of the image and vice versa,
allowing you to position it where it does not
cover interesting areas of the image.
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The animation is stopped in the same way as a normal cine animation, by clicking
Stop cine in the pop-up menu.

Using Jog/shuttle to control Cine Tool

The multiframe support package supports integration with Contour Design
ShuttlePro jog/shuttle multimedia control. Using the buttons on the control is a
fast way to access needed functionality in the cine tool e.g. when viewing coronary
angiography studies.

More information about the jog/shuttle is available in the PDF-document Jog
shuttle label kit on the Sectra User Web1. Follow the link "Sectra Tools for
Cardiovascular Imaging" at Sectra User Web2.

7.5 Key Images

Images can be marked as key images to indicate that they are important or
interesting. You can set the key image tag both from the Matrix window (see also
section 6.2.2 Key Images) and from the Image Window.

To set/reset the key image tag for an image

1. From the Image Window pop-up menu, clickKey images and select Set to set
the key image tag, or Reset to remove the tag. If you are viewing a stack or
collection, you can use the Set all and Reset all commands to set or reset the
key image tag.

If the key image tag is set, the key image symbol will be visible in the upper

right corner of the image .

It is possible to navigate quickly between different key images in an examination.
There are several different commands that can be used to move between key
images in an examination, and key images in a stack or collection.

To move between key images in an examination

1. From the Image Window pop-up menu, click Key images and Fetch left to
move to the previous key image in an examination, i.e. the closest key image to
the left of the current image in the matrix. Select Fetch right to move to the
closest key image to the right of the current image in the matrix.

To move between key images in a stack or collection

1. From the Image Window pop-up menu, click Key images and select one of
the following commands:

Go to previous Moves up in the stack to the closest key image slice.

Go to next Moves down in the stack to the closest key image slice.

1 http://userweb.sectra.se
2 http://userweb.sectra.se
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Cine to previous Starts a cine animation to the closest upper key image
slice.

Cine to next Starts a cine animation to the closest lower key image
slice.

7.6 Synchronizing Images

Images and stacks can be synchronized. This means that when an operation is applied
on one of the synchronized images, the same operation will be applied to all images
that are synchronized. Images that are synchronized are always marked with the

synchronized image symbol .

Operations that are handled by all synchronized images are:

• grayscale

• zoom

• magnifying glass

• invert

• flip

• rotate

Note: Synchronizing the magnifying glass is optional, and is configurable per examination
type. Read more in section 12.11 Configuring exam type specific settings.

Operations that are handled by all synchronized stacks are:

• page up/down

• line up/down

• cine loop/bounce

• stop cine

• stack tile mode

• reset image

Three different modes can be used when traversing synchronized stacks. Which
traverse mode is used depends on how much information a stack contains and what
we have configured:

Slice number When a synchronized stack is traversed, all other
synchronized stacks will be traversed with the relative change
in slice number.
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Table position When a synchronized stack is traversed, all other
synchronized stacks will, if possible, be traversed with the
relative change in table position.

3D When a synchronized stack is traversed, all other
synchronized stacks will, if possible, be traversed with the
relative three dimensional change in the patient's body.

To synchronize images or stacks

1. From the Image Window pop-up menu, click Synchronize.

The synchronization symbol will be shown in the upper right corner of the
image.

To release synchronization of image or stacks

1. From the Image Window pop-up menu, click Release sync.

The synchronization symbol will disappear, indicating that this image is no
longer synchronized.

To group synchronize images or stacks

Group synchronization is meant to make image synchronization more efficient as
the selection of images to be synchronized can be prepared in a DDP or a manual
hanging. The images that belong to the same synchronization group are then
automatically synchronized when the Group synchronize command is applied.

1. From the Image Window pop-up menu, click Group Synchronize.

Group synchronization is applied to all images and stacks in the current hanging
that are members of synchronization groups. This membership is indicated in
the image information by the text "Sync group:" followed by the number of the
synchronization group. TheGroup Synchronize command is a toggle command
which means that the same command is used for both synchronization and
release. The synchronization state of the image is indicated by the presence of
the synchronization symbol in the upper right corner of the image.

Tip: Group synchronization can be enabled automatically when an examination is opened
if synchronization groups have been defined (either in a DDP or manually). Please
read more in section 12.11 Configuring exam type specific settings. For details
on how to define synchronization groups in a DDP please refer to section 6.5.6
Specifying Image Synchronization Groups.

To specify synchronization groups for image or stack

1. From the Image Window pop-up menu, click Sync group.

2. Select a synchronization group from the submenu.

The image information for the current image is updated to reflect the new
synchronization group settings. These new settings may be stored as a manual
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presentation. For more information on how to create a manual presentation,
please read section 6.6 Creating a Manual Presentation.

Note: When you save a manual presentation you should save it for system use,
otherwise the presentation may not be available to the radiologist that viewing
the case. It is also possible to change an image synchronization group while it
is synchronized but the behavior may be unexpected since synchronization
information will become inconsistent. We therefore recommend that you
'release' synchronization before changing to another synchronization group and
then reapply group synchronization after the modifications have been made.

Tip: Synchronization groups can be defined in a DDP. Please read more in section 6.5.6
Specifying Image Synchronization Groups.

7.6.1 Mirrored synchronization

Note: To be able to use mirrored synchronization you must have the Mammography
license.

In certain reviewing situations it is useful to be able to mirror panning and
magnifying glass operations in synchronized images. This is true for e.g. reading
mammography cases when breast images are hung chest wall to chest wall. Mirrored
synchronization allows you to compare corresponding areas in the left and right
breast with the magnifying glass or by panning the zoomed images.

Note: Synchronizing the magnifying glass is optional, and is configurable per examination
type. Read more in section 12.11 Configuring exam type specific settings.

Sample workflow

1. Configure mirrored synchronization for examination types of your choice, e.g.
mammography examinations, as described in section 12.11 Configuring exam
type specific settings.

2. Open a mammography examination and hang two breast images chest wall to
chest wall.

3. From the Image window pop-up menu, select Synchronize in both images.

4. Zoom in and pan in the right breast image.

Both images are zoomed. The panning is mirrored in the left breast image, as
compared to the right breast image, and allows you to compare corresponding
areas in the two breasts.
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Mirrored synchronization

7.7 Adjust images individually

When working with images in a collection, each image operation normally affects
all images simultaneously. If Adjust images individually is selected, subsequent image
operations will affect one image at the time.

WhenAdjust images individually is deactivated, subsequent image operations will
again affect all images simultaneously, and possibly override previous individual
adjustments.

If the collection consists of stacks, Adjust images individually will adjust the
different stacks individually in relation to each other. This means that image
operations are always applied simultaneously to all images in a stack.

The symbol indicates that Adjust images individually is selected.
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7.8 Performing Measurements

You can easily perform various kinds of measurements in an image, i.e. measure the
distance between two points, or determine the area of some part of an image. You
can also measure grayscale statistics in an image.

Note: In certain IDS5 products the use of measurements is restricted. To create
measurements, the "Image view" module is needed (the available modules are
found by selecting About... in the Help menu of the Information Window). The
measurements created are temporary and will disappear at logout unless the
"Measurements" module is available. If your workstation has the Nuclear Medicine
option, two additional measurement methods are displayed in the Image window
pop-up menu: NM Statistics area and NM Statistics circle. In addition to the
statistics Standard deviation and Mean value, the NM statistics also provide max.
pixel value, min. pixel value, total pixel sum, number of pixels and (for NM Statistics
area) area.

Note: In ultrasound images, it is only possible to undertake distance and area
measurements within the tissue or color flow region.

Note: If there is no calibration information in the image, a message stating "Not calibrated"
will appear on the screen when trying to perform measurements. IDS5 marks
images that have been manually calibrated with an annotation reading "Image
manually calibrated". Please read more about how to calibrate an image in
section 7.13 Image Calibration.

Warning: You should always verify that the current image calibration is valid when reading
measurements, since the readouts of the measurements are dynamically calculated
based on the current calibration. Note that IDS5 does not automatically compensate
for the image magnification factor when the image is calibrated. Please read more
in section 7.8.1 About calibration and pixel spacing.

Warning: Distances and areas should normally not be measured in virtual 3D stacks, as
these show 3D views with perspective, i.e. if two objects are the same size in
reality but one appears in front of the other in the Virtual 3D view, the back one
will look smaller. Virtual 3D stacks may be calibrated manually to enable
measurements, but please keep the perspective in mind when measuring.

To measure distances

1. From the Image Window pop-up menu, click Measure, and select Distance.

2. Click in the image to select the starting point for the distance to be measured.

A line will be drawn from the starting point to the mouse pointer.

3. Click in the image to set the end point for the distance to be measured.

4. If necessary, adjust the line by clicking and dragging its start or end point while
holding down the left mouse button.

The distance between the start and end point will be displayed.
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To measure angles

1. From the Image Window pop-up menu, click Measure, and select Angle.

2. Click four times to put two lines on the screen. Alternatively hold down the
CTRL-key and click three times in the image to create the desired angle by
respectively placing the end of the first leg, the base, and the end of the second
leg.

The angle will be calculated between the extensions of the two lines.

To measure areas

1. From the Image Window pop-up menu, click Measure, and select Area.

2. Mark the area you want to measure by defining the corners of a polygon. Each
time you click the left mouse button, a new corner is added to the polygon.

3. Quit defining the area by double-clicking.

The area of the specified polygon will be displayed.

To measure statistics in a circular area

1. From the Image Window pop-up menu, click Measure, and select Statistics
circle.

2. Click in the image to specify the center of the circle to be drawn.

3. Drag the mouse to define the radius of the circle and click the left mouse-button
when a suitable radius is reached.

The grayscale mean value and deviation within the circular area will be displayed.

To measure statistics in a circular area and display a histogram of the grayscale
values

1. From the Image Window pop-up menu, clickMeasure, and selectHistogram
circle.

2. Click in the image to specify the center of the circle to be drawn.

3. Drag the mouse to define the radius of the circle and click the left mouse button
when a suitable radius is reached.

The grayscale mean value and deviation, total number of pixels and the histogram
of the grayscale values within the circular area will be displayed.

To measure statistics in an area defined by a polygon

1. From the Image Window pop-up menu, click Measure, and select Statistics
area.

2. Mark the area you want to measure by defining the corners of a polygon. Each
time you click the left mouse button, a new corner will be added to the polygon.

3. Quit defining the area by double-clicking.
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The grayscale mean value and deviation in the polygon will be displayed.

To measure statistics in an area defined by a polygon and display a histogram
of the grayscale values

1. From the Image Window pop-up menu, clickMeasure, and selectHistogram
area.

2. Mark the area you want to measure by defining the corners of a polygon. Each
time you click the left mouse button, a new corner will be added to the polygon.

3. Quit defining the area by double-clicking.

The grayscale mean value and deviation, total number of pixels and the histogram
of the grayscale values in the polygon will be displayed.

To measure a single pixel value

1. From the Image Window View menu, select Show pixel value.

A display next to the mouse pointer will continuously show the grayscale value
of the single pixel it is pointing at. This display can be turned off by selecting
Show pixel value again.

To move or remove a measurement

1. Measurements in the image can always be moved to another place. To move a
measurements, select it by clicking on it and dragging it to the desired position
using the mouse.

2. To remove a measurement from an image, select it by clicking on it and press
Delete.

Note: There are some restrictions on removing measurements as described below.

The grayscale statistics and pixel value measurements are calculated using the actual
pixel values. If these measurements are performed on an image that has been edge
enhanced or on an image from slab mode, the statistics result is based on the
processed image data and not on the original image data. The result will most likely
differ from the result obtained if the statistics measurement is done on the
unprocessed image. In the same way the results will vary for an image with different
zoom level, differently sized image views, for monitors with different resolutions
and for printed images.

Measurements shown in gray cannot be changed or deleted. This gray coloring is
used when only temporary measurements are available. Existing permanent
measurements are therefore displayed in gray, as are archived measurements.
Permanent measurements that exist when an image is archived, will also be archived.
Measurements created on an IDS5/dx.net or an IDS5/qa.net cannot be changed on
an IDS5/cl.net . On an IDS5/cl.net workstation, you must also have the necessary
permission to save the measurements, i.e. creating permanent measurements. These
privileges can be configured by a system administrator. If you can create permanent
measurements, you can also change and save existing permanent measurements.
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7.8.1 About calibration and pixel spacing

In order to perform measurements in an image, the physical size of a pixel must be
known. This is commonly referred to as an image's pixel spacing. The pixel spacing
is either available in the image's DICOM header or via manual calibration. An image
may be tagged with several DICOM tags providing pixel spacings based on different
assumptions.

In particular in projection radiography, a measurement may return different results
depending on the pixel spacing it is calculated from. When this is the case, as in the
example below, two measurement results will be displayed where the first result is
an estimate of the in-patient measure and the second result is the measurement on
the image plate.

IDS5 selects what measurement(s) to display according to the ranking order of
priority recommended in the DICOM standard documentation. This is described
in the table below.

To find out the base for a measurement

1. Place the pointer over a measurement.

A tooltip will appear describing how the measurement was calculated. The
tooltip disappears when the pointer is moved away from the measurement.

Measurements calculated from pixel spacings generated from manual calibration or
the DICOM tags Pixel Spacing (0028, 0030) and Estimated Radiographic
Magnification Factor (0018, 1114) will reflect estimates of in-patient measures,
while measurements calculated from pixel spacings generated from the DICOM
tag Imager Pixel Spacing (0018, 1164) will reflect measures on the image plate.

Measurements are performed based on the information provided in the image. This
means that they can never be more accurate than what the actual image allows,
which in turn will influence both the number of displayed decimals and grayscale
statistics. The number of decimals that is displayed is also dependent on how the
image is zoomed and what the actual pixel size is. For example if the pixel size is
0.15 mm and the image is zoomed 1:1 it will result in one decimal being shown
when measuring distance, but two decimals when measuring area, since 0.15 * 0.15
= 0.0225. If the image is zoomed in, the precision will increase and the measurements
can be displayed with more decimals. Angle measurements are always presented
with one decimal digit. Grayscale statistics measurements are presented without
decimals.
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Ranking order of priority between different pixel spacings:

Pixel spacing information used for measurementPixel spacing information availableRank

Manual calibration. The image will be marked with an

annotation reading "Image manually calibrated".

Manual calibration1.

Ultrasound DICOM tags (0018, 6011/6014/602C/602E)Ultrasound DICOM tags (0018,

6011/6014/602C/602E)

2.

Two results are displayed:

1. Pixel Spacing (0028, 0030)

2. Imager Pixel Spacing (0018, 1164)

If the results are identical, only one is displayed.

Pixel Spacing (0028, 0030)

Imager Pixel Spacing (0018, 1164)

Estimated Radiographic Magnification Factor (0018,

1114)

3.

Two results are displayed:

1. Quotient of Imager Pixel Spacing (0018, 1164) and

Estimated Radiographic Magnification Factor (0018,

1114)

2. Imager Pixel Spacing (0018, 1164)

If the results are identical, only one is displayed.

Imager Pixel Spacing (0018, 1164)

Estimated Radiographic Magnification Factor (0018,

1114)

4.

Pixel Spacing (0028, 0030)Pixel Spacing (0028, 0030)5.

Imager Pixel Spacing (0018, 1164)Imager Pixel Spacing (0018, 1164)6.

A message reading "Not calibrated" is shown when you try

to perform a measurement.

No calibration information available7.

7.9 Putting Annotations in an Image

Annotations (graphics or text) can be used to mark or comment interesting parts of
an image. There are two kinds of text annotations. Text written with the Text
command can easily be deleted or hidden. Text written with the Text mark
command, on the other side, is more difficult to delete, and cannot be hidden. When
an examination is archived, text annotations can no longer be altered or removed.

The idea behind these alternatives is that text written with the Text command
should be used for ordinary comments, while text written with the Text mark
command should be used for very important text, such as side markings, which
should always be visible.

Unlike the side markings that display the image orientation, annotations can be
used as absolute indicators for the image orientation. Although the side markings
display the orientation information from the DICOM image, there is no guarantee
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that this information is correct. Instead, annotations should be used in order to
indicate true image orientation and position.

Note: In certain IDS5 products the usage of annotations is restricted. To create
annotations, the "Image view" module is needed (the available modules are found
by selecting About... in the Help menu of the Information window). Annotations
created on an IDS5/dx.net or an IDS5/qa.net cannot be changed on an
IDS5/cl.net .

Note: The created annotations are temporary and will disappear at logout, unless the
"Annotations" module is available. On an IDS5/cl.net workstation, you must have
the necessary privileges to be able to save annotations. Privileges can be configured
by a system administrator. For patient safety reasons, the Text and Text mark
annotations are not available as temporary annotations. If you can create permanent
annotations, you can also change and save existing permanent annotations.

Annotations shown in gray cannot be changed or deleted. This gray coloring is used
when only temporary annotations are available. Existing permanent annotations
are therefore displayed in gray, as are archived annotations. Permanent annotations
that exist when an image is archived, will also be archived.

It is also possible to view DICOM overlays in the images. Note that only DICOM
overlays that are stored in the image's pixel data is supported.

To create a text annotation

1. From the Image Window pop-up menu, click Annotate, and select Text or
Text mark (see description above for an explanation of the differences between
these two commands).

2. Click in the image at the position where you wish to place the text.

3. Type in the text.

The text will be displayed as you write. If you want to edit an existing text, click
on the text that you want to modify and make the necessary modifications. To
move the annotation to a different position, click on the text once. The text will
be surrounded by a broken rectangle. Move the mouse-pointer to the broken
rectangle and press the left mouse-button. The text will now be surrounded by
a solid rectangle. While holding the left mouse-button down, drag the annotation
to the desired new position.

To create a predefined annotation

1. For information on how to create or modify a predefined annotation, please
read section 12.5 Configuring Image Tools Properties.

To use predefined annotations

1. From the Image window pop-up menu, click Annotate, and select Text or
Text mark (see description above for an explanation of the difference between
these two commands).

2. Click in the image at the position where you wish to place the text.

3. Scroll the mouse-wheel to select a predefined annotation
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The predefined annotation will be displayed by updating the contents of the
edit text rectangle. This function may also be used to erase text quickly by
selecting the empty text choice which is available as one of the predefined texts.

4. Type in additional text (if necessary).

To remove a text annotation

1. Click on the text you want to remove.

The text annotation will be surrounded by a broken rectangle.

2. Click on the broken rectangle.

The text annotation will be surrounded by a solid rectangle.

3. If the text you want to remove was created with the Text command, press
DELETE. If the text you want to remove was created with the Text mark
command, press SHIFT+CTRL+DELETE.

Note: It is not possible to remove text marks for examinations that have been
archived.

To create a line annotation:

1. From the Image window pop-up menu, click Annotate, and select Line.

2. Click in the image to define the starting point for the line.

A line will be drawn from the starting point to the mouse-pointer.

3. Click in the image to define the end point for the line.

4. If necessary, adjust the line by clicking and dragging its start or end point with
the left mouse-button.

If you want to delete a line annotation, click on the line and press DELETE.

To create a polyline annotation

1. From the Image window pop-up menu, click Annotate, and select Polyline.

2. Click in the image to define the starting point for the first line.

3. Click in the image again to define a corner and the starting point for the next
line.

4. When the last line has been drawn, double-click to define its endpoint.

5. You can move the lines and corners by clicking and dragging them to new
positions.

If you want to delete a polyline annotation, click on the annotation and press
DELETE.
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To create a circle annotation

1. From the Image window pop-up menu, click Annotate, and select Circle.

2. Click in the image to define the center point for the circle.

3. Move the mouse-pointer to adjust the circle radius. Click on the left
mouse-button when you are ready.

4. The circle position and radius can be changed by clicking and dragging the
center point and circle.

If you want to delete a circle annotation, click on the annotation and press
DELETE.

To create an ellipse annotation

1. From the Image window pop-up menu, click Annotate, and select Ellipse.

2. Click in the image to define the center point for the ellipse.

3. Move the mouse pointer to adjust the size of the ellipse. Click on the left
mouse-button when you are ready.

4. The ellipse position and radius can be changed by clicking and dragging the
center point or corner points of the ellipse.

If you want to delete an ellipse annotation, click on the annotation and press
DELETE.

To create a point annotation

1. From the Image window pop-up menu, click Annotate, and select Point.

2. Click in the image to define where the point shall be placed.

If you want to delete a point annotation, click the annotation and press
DELETE.

To show/hide DICOM overlays

1. From the Image window pop-up menu, click Annotate, and select Show
DICOM overlays (white) to show DICOM overlays in white color or select
Show DICOM overlays (black) to show overlays in black.

To hide the overlays, select Hide DICOM overlays.

7.10 Overlay plug-ins

Overlay plug-ins are special purpose-built overlays that are not fully integrated into
the IDS5 workstation, but installed separately. When such an overlay is visible, the

image is marked with the following symbol: .
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To show/hide overlay plug-ins

1. From the Image window pop-up menu, clickOverlay plugins, and select Show
overlay plugins to show or hide the installed overlay plug-ins. A checkmark
next to the menu item indicates when the overlays are visible.

7.11 Navigating among Images

From each Image window you can easily browse through the images belonging to
a patient without leaving the window. From theView-menu, selectMove up,Move
down,Move left orMove right.The latter two commands have alternativesMove
left (monitor) andMove right (monitor). Please see below for more information.
By using these commands you can choose to display images positioned to the left,
right, above or below the currently displayed images. The position of each image
(or stack of images) always refers to the position the images have in the matrix, i.e.
the layout in the Matrix window.

The example in the figure below illustrates the relationship between the Move
Right command and the position the images have in the matrix.

Suppose that there are two examinations in the request being processed. These are
positioned in the matrix with the new examination above the previous examination.
Both examinations have two images showing frontal (1), and lateral (2) views of the
body part being examined. The new frontal view (image A) is viewed on the left
screen, and the previous frontal view (image C) is viewed on the right screen. By
issuing the Move Right command the frontal views will switch to lateral views
instead. The new lateral view (image B) will appear on the left screen, and the
previous lateral view (image D) will appear on the right screen.

Moving to the right in the matrix from an Image window.

The Move left and Move right navigation commands apply to all screens. The
other move commands (up/down/left (monitor)/right (monitor)) apply only to the
current screen.
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It is also possible to display images from the same series type as the current image,
from a newer or prior examination. This is done by clicking with the right
mouse-button in the image and selecting Fetch newer/prior in the pop-up menu.
The Fetch newer/prior commands only affect the current series.

Note: Fetch newer and/or Fetch prior commands may be inactive (i.e. shown in gray
and impossible to select) if there are no newer or prior images with the same
series type as the current image.

To move between images in different cases, use thePrevious/Next case commands
that are available on the View menu. If, for example, you select Next case, the
images for the next matching examination in the worklist will be displayed.

Note: If examination wrapping is used, the series icons may be wrapped onto several
rows within each examination. However all series icons within a single examination
should be regarded as located on the same matrix row, even though they may be
wrapped onto several physical rows. Thus the Move up and Move down commands
will select the corresponding image in the previous and next examination respectively
- not the image on the previous or next row of series icons within the same
examination.

7.12 Fetching Images

It is possible to fetch an image from the Matrix window directly. This is an easy
way of hanging any image shown in the Matrix window in the current position in
the Image window. From the Image window pop-up menu, click Fetch image. (If
there is no image where you try to display the pop-up menu, the Fetch image
function will apply automatically.) The Fetch image dialog is presented, as shown
in the snapshot below.

130IDS5, Version 11.1, December 2006 Using the Image Windows

Fetching Images 7.12



The Fetch image dialog is a view of the examinations in the Matrix window. The
examinations that are expanded in the Matrix window, are expanded in the dialog,
and vice versa. If examination wrapping is used, the examinations in the fetch image
dialog will also be wrapped.

To fetch an image to the Image window, click the image in the dialog. To cancel
the 'fetch', click the Cancel button at the bottom of the dialog.

7.13 Image Calibration

To be able to measure a distance in an image, the image has to be calibrated.
Normally, images are calibrated by, or at the modality. If you try to measure a
distance and receive a "Not calibrated!" message, the image has not been calibrated,
or the calibration is wrong. In this case you will need to undertake a manual
calibration.
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Image calibration is a global operation that sets the same calibration on all slices in
a stack (or frames in a sequence).

Warning: Image calibration should never be performed on stacks or sequences which include
mixed image resolutions.

Image calibration is associated with making measurements. If measurements cannot
be created, then no calibration is available. If the measurements made are temporary,
so is a new calibration or calibration change. Please read section 7.8 Performing
Measurements for more information on when the use of measurements is restricted.

Note: Manual calibration is not exported when an image is exported by teleradiology to
a DICOM destination or when it is exported to a CD or an E-mail recipient. Please
read section 5.6 Import and export for more information about exporting images.
In these cases the exported image will contain the original calibration information,
as received from the modality. However, measurements are exported, and the
result of the exported measurements are based on the (manual) calibration that
prevailed the last time the image was displayed.

Note: In ultrasound images, calibration is only possible within the tissue or color flow
region.

Warning: Measurements created before an image is manually calibrated are not updated
with the new calibration until they are displayed on screen. If images are exported
after a manual calibration, be aware that measurements created before the
calibration will not have been updated according to the new calibration if the images
have not been displayed on screen.

To manually calibrate an image

1. From the Image window pop-up menu, click Calibration, and select Manual
calibration.

2. Determine two reference points in the image where you know the exact distance
between.

3. Move the mouse-pointer to the first reference point and click the left
mouse-button.

4. Move the mouse-pointer to the second reference point and click the left
mouse-button.

A line will be drawn between the two reference points.

5. Type in the length of the line in millimeters, and press RETURN.

The image is now recalibrated, and all related distances and areas are recalculated
automatically. A warning label will appear on the screen as a reminder that the
image is now recalibrated. The label cannot be deleted unless the calibration is
reset, but it can be moved to a different position.

To reset the calibration

1. From the Image window pop-up menu, click Calibration, and select Reset
calibration.
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To copy calibration

1. From the Image window pop-up menu or the matrix icon window pop-up menu,
click Calibration, and select Copy calibration.

The current calibration of the image will be copied into a buffer that later can
be used to paste the calibration into other images.

To paste a calibration

1. From the Image window pop-up menu or the matrix icon window pop-up menu,
click Calibration, and select Paste calibration.

The calibration currently in the copy buffer will be applied to the image or
stack. Note that this is entirely controlled by the user, the command itself is
not intelligent. The pixel size in the copied image is directly applied to the target
image.

To paste a calibration to all images of an exam

1. From the Examination Text View pop-up menu, click Calibration, and select
Paste calibration.

The calibration currently in the copy buffer will be applied to all the images in
the exam. Note that this is entirely controlled by the user, the command itself
is not intelligent. The pixel size in the copied image is directly applied to the
target images.

7.14 Viewing Virtual 3D Images

Using the Sectra 3D Clinical Application it is possible to generate a set of images
for Virtual 3D viewing. The Virtual 3D icon is displayed in the image window and

in the matrix window when Virtual 3D viewing is available .

When a Virtual 3D image is displayed in the image window (indicated by the icon
above), the default interaction mode is Rotate. Drag the mouse while holding down
the left button to rotate the 3D volume. Move the mouse sideways to rotate the
volume around its vertical axis, and move the mouse away from or towards yourself
to rotate the volume around its horizontal axis. Please note that a limited set of
views are available, as was specified when the Virtual 3D images were generated
using the Sectra 3D Clinical Application. The number of available views is shown
in the Matrix window icon views and as image information in the Image view.
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Virtual 3D images can be zoomed, panned, and annotated as regular images.

Warning: Distances and areas should normally not be measured in Virtual 3D images, as
these show 3D views with perspective (i.e. if two objects are the same size in
reality but one appears in front of the other in the Virtual 3D view, the back one
will look smaller). Virtual 3D images may however be calibrated manually to enable
measurements, but please keep the perspective in mind when measuring.

If the Virtual 3D image has been zoomed in and you want to pan the image, press
and hold down the ALT-key and move the mouse holding down the left
mouse-button (Rotate interaction mode assumed).

7.15 Image Addition

Image Addition is only available with the Nuclear Medicine option.

To superimpose two or more images, i.e. to merge an image containing radioactive
position markers with an actual patient image, first group the images into a collection,
unless they are already a stack. Then select Image Addition->Add from the Image
window pop-up menu. This will add the images, pixel by pixel. Grayscale settings
are not automatically changed, which means that some manual adjustments may be
required to obtain a usable image. All images in the group or stack must have the
same size (in pixels).

Similarly, selecting Image Addition->Averagewill compute the arithmetic average
of all images in a stack, or a collection.

When images are added, all annotations present on any of the images are shown on
the resultant image. No new annotations can be created, and any setting changes
while images are merged will not be saved.

To turn off 'Addition', and return to normal viewing, select Image Addition->None.

7.16 Slab view

The slab viewer contains functionality to use a current stack to recalculate a new
stack, with images created from merged groups of slices from the original stack.
The new stack might get a different number of images. This way a large stack can
be reduced to a smaller stack directly in IDS5, or details only showing up in one
slice can be made easier to detect. You can set the slab width and also the incremental
step. A smaller incremental step than the slab width will result in overlapping slabs,
while having the same incremental step, as slab width, will result in a smaller stack.
A larger incremental width than slab thickness is not allowed.

134IDS5, Version 11.1, December 2006 Using the Image Windows

Image Addition 7.15



The image to the left describes slabs where the thickness and increment is the same.
The image to the right describes slabs where the increment is smaller than the
thickness. A and C are thickness whereas B and D are increment.

To start Slab view, from the Image window pop-up menu, click Slab mode, and
select Slab mode. When the slab view is started the slab control dialog is displayed,
which gives you control of the slab functionality. At first the actual slab stack is not
calculated to prevent unnecessary computer load. Change the properties; increment,
thickness, and mode, and finally turn on slab viewing by clicking the On button.
Click the Save button to create a new stack for this examination, with the slab
images. No changes are done to the original stack. Also, a checkbox is available,
enabling you to lock the two slider controls to each other so that they always use
the same value. If the thickness and increment default values are the same, the
checkbox will automatically be checkmarked.
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Thickness Defines the thickness of each slab in the new stack.

Increment Defines the distance between each slab in the new stack.

Mode Defines how each slab is calculated from the original stack. The
available modes are Average, MIP, MinIP.

The different modes that are available have the following functionality:

Average Computes the arithmetic average of all images in each slab.

MIP Uses Maximum Intensity Projection through the slab, i.e. use the
maximal pixel value.

MinIP Uses Minimum Intensity Projection.

The stack is recalculated whenever you click the On button, and any of the sliders
have been changed, or you select a new mode. An active Slab mode is indicated by

a icon in the Image window .

If the stack is in some way not suited to be viewed in this mode (it might not be

parallel, contain jumps in location etc.), this will be indicated by a warning icon .

To exit Slab mode, click the Off button, or close the control dialog by clicking the
X button in the extreme upper right corner of the dialog.

The Slab view can be started automatically, using a DDP. Please read section 6.5
Creating a DDP. Slab view is also a part of a presentation. If Slab view is being
shown when a presentation is saved, Slab view with the same settings will be shown
whenever the presentation is applied.

Only stacks where all images have the same size and format can be displayed in Slab
view. Slab view recalculates the stack according to your settings, and the stack will
be temporarily available until you open a new stack or close the Image window. If
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you want the stack to be permanently available, click Save to save the stack as a Slab
view stack.

In all cases the annotations from all original slices in a slab will be merged and
inserted into the slab image.

7.17 MPR - Multiplanar reconstruction

MPR is only available with the MPR Package.

MPR can be used for single CT and MR image stacks or for collections of them.
To read the complete MPR User´s Guide, start MPR and click the Help button in
the MPR toolbox.

To start MPR

1. From the Image Window pop-up menu, select MPR.

7.18 3D - Volume rendering

3D is only available with the 3D Package.

3D can be used for single CT and MR image stacks or for collections of them. To
read the complete 3D User´s Guide, start 3D and click the Help button in the 3D
toolbox.

To start 3D

1. From the Image Window pop-up menu, select 3D.

7.19 The NM Control

The NM control is only available with the Nuclear Medicine option.

The NM control is intended for situations, such as when viewing nuclear medicine
(NM) images, where you want exact control of grayscale settings, and their relation
to the histogram of values in the image. The control is turned on and off by clicking
Window Level->NM Control in the Image window pop-up menu. The control
state (on or off) is saved as part of a presentation, and the control can be turned on
automatically for some images using a DDP.
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The NM control has the following components:

1. Lowest pixel value — This number is the lowest pixel value (after Modality
LUT or rescaling) present in the image.

2. Lower grayscale limit — Any pixels with this value or lower are shown as black
(or as the lowest color palette entry). New values can be entered by clicking
inside the box and typing in the desired value.

3. Lower grayscale limit spin button — Clicking on the up or down arrows will
increase or decrease the lower grayscale limit by one step.

4. Image histogram.

5. Grayscale or palette — Shows how the grayscale relates to the histogram.
Dragging the black boxes at the ends of the scale with the mouse will change
the lower or upper grayscale limits. Dragging the white box in the middle will
move the entire grayscale range up or down.

6. Upper grayscale limit spin button — Similar to the lower limit spin button, but
moves the upper grayscale limit.

7. Highest pixel value — This is the highest pixel value present in the image.

8. Upper grayscale limit — Any pixels with this or a higher value will be displayed
as white (or as the highest color palette entry).

Clicking the right mouse-button anywhere in the NM-control, will display a menu
with the following choices:

Percent Changes the display of pixel values from absolute numbers to
percentages of the highest pixel values in the image. When percent
is selected, the highest and lowest pixel values will be displayed as 0%
and 100% (by definition), and the lower and upper grayscale values
will be displayed as a percentage.

Absolute Change the display of pixel values to absolute numbers.

0-100% Sets the lower grayscale limit to the lowest pixel value present in the
image, and the upper grayscale limit to the highest pixel value.

Palette Selects a color palette to apply to the image.

Close Closes the NM control.
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7.20 Color Palettes

Color palettes are only available with the Nuclear Medicine option.

It is sometimes desirable to add artificial colors to a grayscale image, e.g. to make
small differences stand out more clearly. To do this, clickWindow Level->Palette
from the Image window pop-up menu, and select one of the available palettes. The
palette will be applied following the grayscale settings, i.e. any pixels that would
normally have displayed as black are assigned to one end of the palette scale, and
any pixels that would have displayed as white are assigned to the other end of the
palette scale, and pixels between these extremes are interpolated over the palette
range.

The selected palette is saved along with other presentation information. For some
images it is also possible to select a palette automatically, using a DDP.

For more information on how to install palettes, please refer to System
Administrator's Guide IDS5 [1].

7.21 Clinical Applications

A Clinical Application is an application which is independent from IDS5, i.e. a
medical device released and labeled separately from the IDS5. Such an application
can be started from the Image window, using the image as an input. A banner
containing the name of the Clinical Application will be displayed in the upper part
of the Image window to indicate that a Clinical Application is running. The range
of available Clinical Applications vary from installation to installation. In the event
of any problems related to a Clinical Application, please contact the supplier of the
Clinical Application in question, directly. Clinical applications are found in the
Clinical applications menu of the Image window pop-up menu. Most clinical
applications have their own help system. For help on IDS5 Orthopedic Package,
click IDS5/ortho User's Guide... in the Help menu of the Image window.

7.22 Mammography screening

Mammography functions are only available with the mammography module. In this
section we describe the specific commands and examination statuses that are available
in the mammography workflow. For a sample mammography screening workflow,
please see section 11.3 A radiologist Views a Mammography Case.

7.22.1 Commands and examination statuses

There are a number of functions that streamline the workflow for reading
mammograms in a screening situation. There are special examination statuses,
namely "1 Code", "2 Code", and "3 Code". The first is used by the first reading
radiologist, the second is for double reading. The third can, for instance, be used
for a final reading when the first two differ. The possible values for the mammo
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codes are: -, Technical repeat, OK, Finding, and Assessment. There are also
examination fields for the names of the first and second reading radiologist.

A reading result is entered through one of the commands in the Status menu, e.g.
in the Image window. There are a number of commands that automatically figures
out if this is the first or second reading by looking for the first empty reading
radiologist slot, they are all marked "1/2". One example is the command OK 1/2
that sets the mammo code to OK for either "1 code" or "2 code", and sets the current
user's name as either first or second reading radiologist. There are also sequence
commands that combine these functions with the Next status and Next case
commands. Finally, other commands are available that are connected either to only
the first reading or only the second reading. These commands are marked "1" or
"2", as opposed to the "1/2" commands described above. A full list of the
mammography commands are given in the Reference Manual IDS5 [4].

In the typical mammography screening workflow these statuses are set with the
dedicated keypad.

7.22.2 Using BIRADS codes in Sectra PACS

Sectra PACS supports setting result codes according to the BIRADS standard. These
are codes from 0 to 6 indicating the severity of findings for each side and are used
instead of the OK/Findings/Assessment codes described in section 7.22.1 Commands
and examination statuses. The BIRADS codes are available on the Status menu in
any of the windows of IDS5/mx.net, see below.

The BIRADS codes can be set for Reader 1 and Reader 2

To set status codes according to BIRADS

1. On the Status menu, point to BIRADS and current reader.

2. Point to the correct code for the right breast (Dx).

3. Click the correct code for the left breast (Sin).
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The example in the image above will set code 3 on the right breast and code 0
on the left breast, for the first reader.

7.23 Mammography CAD

This section describes how to work with mammography CAD overlays.

7.23.1 Working with CAD overlays

Note: To be able to use the functionality for mammography CAD you must have the
Mammography CAD license.

If mammography CAD results are available for an examination, all images in the
examination will be marked with the mammography CAD symbol.

CAD results can be displayed by a DDP, see section 6.5 Creating a DDP and
section 6.5.5 Specifying Image Settings. CAD results can also be displayed manually.

To manually display CAD results

1. In the Image window, click View->Display CAD results (CTRL-SHIFT-4).

Any CAD markers are displayed at the default detail level. Please refer to System
Administrator's Guide IDS5 [1] for information on how to configure the default
detail level.

2. To hide the CAD results, click View->Display CAD results again.

CAD markers indicating findings. You can double-click a CAD marker to increase the level of detail for

it.

To step through available detail levels

1. With CAD results displayed, click View->Next CAD presentation in the
Image window.
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The next available detail level is displayed. If there are several CAD presentations
for same image, this command will step through each detail level in each
presentation.

Tip: Double-click an individual CAD marker to increase the level of detail for it.

Double-clicking executes other actions if the individual CAD marker is not hit.
This is configured in the Options dialog.

To select a specific detail level to display

1. On the image pop-up menu, click Select CAD presentation.

A dialog box listing all available presentations and detail levels is displayed.

2. Select the desired presentation and detail level and click OK.

7.23.2 About CAD overlays

When a CAD application analyzes an image set, it typically creates a DICOM
Mammography CAD Structured Report with information about the type and location
of any findings in the images. This report is sent to Sectra PACS that matches it to
the images it was created for and creates a CAD presentation. The CAD presentation
consists of overlays with markings that indicate the findings at the specified
coordinates in each image. Since most findings in CAD reports are represented in
several detail levels, a CAD presentation contains multiple detail levels that can be
displayed when the images are reviewed.

Two kinds of overlays are used when displaying results from a Mammography CAD
Structured Report: The result overlay displays information about the CAD
manufacturer and how many findings there are. The finding overlay represents the
individual findings as one or several outlines. Manufacturer specific symbols are
used in addition to outlines at sparse detail levels. Three factors differ CAD overlays
from other overlays in IDS5:

1. CAD overlays cannot be moved or deleted.

2. CAD finding overlays can be double-clicked in order to change the detail level
of a specific finding.

3. CAD finding overlays has a tooltip that appears when the pointer is placed on
top of the overlay. The tooltip contains information about the specific finding.

7.24 DICOM Presentation States

DICOM presentation states provide a standardized way of transferring image display
settings and annotations between different systems. Settings from IDS5 are exported
as DICOM presentation states when images are exported, and IDS5 can use
presentation states generated by other systems. An image that contains presentation

states which can be applied is marked with the symbol .
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7.24.1 Apply a presentation state

To manually apply a presentation state to an image, select Reset to presentation
state from the image window pop-up menu. A dialog box will appear, listing all
available presentation states. Highlight the desired one by clicking on it, and click
OK to confirm.

Presentation states can also be applied automatically using a DDP. In this case, the
DDP specifies a presentation state name. If there is a presentation state in the system
with that name, and it can be applied to the image under scrutiny, then that specific
presentation state will be used.

If, however, an applied presentation state contains unsupported information, only
as much as possible of the presentation state will be applied, and this warning symbol

will appear in the image: .

7.24.2 Toggle presentation state annotations

Note: This function requires a license for the Mammography option.

Select Toggle PS annotations from the Image window pop-up menu to toggle
between the original image and the image with the presentation state applied. This
command is also available in the Image window Viewmenu, affecting all images in
the hanging. The configurable default presentation state in the DDP is selected if
more than one presentation state is applicable.

Note: When toggling off presentation states for all images in the current hanging,
presentation state information in images currently obscured by other windows,
e.g. the Information window, will also be toggled off. E.g. annotations may become
hidden in an image not currently visible. The user must take care when switching
to such an obscured image and make sure that there isn't any image information
that has been toggled off previously.

7.24.3 Import presentation state overlays

The IDS5 normally associates annotations with an image. Therefore, because
DICOM presentation states associate annotations (graphics and text) with a
presentation, annotations from presentation states must be treated specially by IDS5.
Annotations from a presentation state are shown in gray and cannot be changed.

143IDS5, Version 11.1, December 2006 Using the Image Windows

DICOM Presentation States 7.24



They can, however, be converted to “ordinary” IDS5 annotations by selecting
Import presentation state overlays from the Image window menu.

Note: If annotations are imported, and the presentation state is subsequently re-applied,
either manually or by a DDP, annotations will be duplicated. One instance will be
the imported version of the annotation, and the second instance will be the one
from the presentation state.

7.25 Compressed images

DICOM images can be compressed using different types of jpeg-compression or
Sectra RAID compression method. If the compression algorithm is non-reversible
(lossy compression), this is indicated by a DICOM attribute ((0028,2110) Lossy
Image Compression). This does not mean that the image is currently compressed,
only that sometime in the past it has undergone some kind of lossy

image-compression. In the Image window, this is indicated by the symbol .
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8 Using the Quick Window

The following topics are included in this chapter:

■ Special Commands in the Quick Window

The Quick Window is used for applying image settings (orientation, grayscale,
cropping, etc) on a single image. The operations that can be performed from the
Quick Window are exactly the same as in the Image window, and are described in
section 7.3 Operations on Images.

The normal workflow when using the Quick Window is as follows.

To adjust image settings using the Quick Window

1. Double-click on the image thumbnail whose image settings you want to change
in either the Information window or the Matrix window. (This works unless
you have configured that the Image window should be opened for these
operations.) If you are in the Matrix window you can also select Open Quick
window from the Matrix icon pop-up menu.

The Quick window appears.

2. Make the necessary adjustment (please read section 7.3 Operations on Images
for more information on how to make adjustments).

3. Click Close to save changes, and return to the previous window.

The matrix icons in the Matrix window, and the series thumbnails in the
Information window, will be updated to show the new state of the image.

8.1 Special Commands in the Quick Window

Some commands are only available from the Quick window. These are described
below.

8.1.1 Sorting stacks

Stacks and collections of images can be sorted on either table position, acquisition
time, slice number, echo time, temporal position identifier or slice location.

The default sort order depends on the import parameters used when stack arrived
to the PACS.

To sort a stack or collection

1. Double-click on the stack or collection in the Matrix window.
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The Quick Window appears.

2. From the Quick window pop-up menu, select Sort and then the desired sort
command. There are 12 sort commands available to sort stacks and collections
on any of the parameters in either ascending or descending order.

It is also possible to sort the stack using two parameters. Do this by selecting
Custom... from the Sort child menu. A dialog will be opened where you may
select what parameters that should be used to sort the stack.

In this dialog you may enter a primary sort criteria and a subcriteria. When the
sorting is done the stack will be sorted on the primary criteria. If a group of
images within the stack contain the same value for the primary parameter, these
images will be sorted according to the subcriteria.

Note: If the image import has been configured to sort stacks on a certain value and
not all images in the stack contain the necessary information, then the Quick
Window pop-up menu might show a sort option though it actually isn't sorted.
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9 Using the Stack Tool

The Stack Tool is used for creating new stacks with images from an existing stack.
The existing stack will be referenced as the original stack, and the new stacks that
you create will be called virtual stacks. The virtual stacks will contain a subset of
the images from the original stack.

Start the Stack Tool

1. Select a stack that contains the images you want to use for your new stack(s).

2. If the stack is in the Matrix window, select Stack tool from the Matrix icon
pop-up menu.

3. If the stack is in the Image window, select Stack tool from the Image window
pop-up menu.

The Stack Tool dialog appears (see below).

The Stack Tool.
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The Stack Tool consists of the following elements:

Menubar Commands are available via drop-down menus in the menubar.

Toolbar The configurable toolbar contains icon short-cuts to some of
the commands available via the drop-down menus in the
menubar.

Stacks window This window shows buttons that correspond to the different
stacks you are working with. The caption on this window is
"Stacks".

Image window This window shows the images in the currently selected stack.
The caption on this window is "Images - <stackname>".

To create a new virtual stack

1. Do one of the following:

• Select New stack from the File menu.

• Click the New stack icon on the toolbar.

• Press CTRL+n

A new button will be displayed in the Stacks window to indicate that a new stack
has been created.

To delete a virtual stack

1. Activate the virtual stack you want to delete by clicking the corresponding button
in the Stacks window, and do one of the following:

• Select Delete stack from the File menu.

• Click the Delete stack icon in the toolbar.

The button in the Stack window corresponding to this stack disappears.

To select images in a stack

1. Activate the stack that contains the images you want to select, and do one of
the following:

• Select the images by clicking on them and using CTRL, SHIFT and
CTRL+SHIFT, just as in Microsoft Explorer.

• Select Select from the Edit menu. A dialog will appear, in which you can
type the range of images you want to select (the default range is from the
first image to the last), and what interval you want to use. The default
interval is one, if every image in the range is to be selected, and two if every
other image is to be selected, etc.

• You can select all images in the stack by selecting Select all from the Edit
menu, or by pressing CTRL+a.
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You can also invert a selection, by selecting Invert selection from the Edit
menu, or by pressing CTRL+i. A selection in the original stack could look
something like this (see below)

To copy images to a virtual stack

1. Activate the source stack (either the original stack or another non-empty virtual
stack) that contain the images you want to copy.

2. Select (please see To select images in a stack above) the images that you want
to copy from the source stack.

3. Drag and drop the images from the source stack to the button in the Stacks
window that correspond to the stack where the images are to be copied to.

Note: You cannot have multiples of the same image in a stack. Thus, if you copy an
image several times, it is only copied once. Also note that you cannot drag and
drop images from a stack to itself, nor to the original stack.

To delete images in a virtual stack

1. Activate the virtual stack that contains the images you want to remove.

2. Select (please see To select images in a stack above) the images you want to
delete.
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3. Either select Delete images from the Edit menu, or click the Delete images
icon in the toolbar.

Note: You can only delete images in a virtual stack, not in the original stack.

To change the image size

You can choose between two different sizes of the images in each stack. If you have
a very large stack you might want the images presented at a smaller size (default),
and if you have a small stack, have them shown at a larger size.

1. Select Small images and Big images respectively, from the View menu.

To save the new stacks

1. When you have finished creating your stacks, and want to save them, close the
Stack Tool dialog. You will be asked if you want to save these new stacks. Click
Yes if you want to, or click No if you do not want to, and click Cancel to close
the dialog and return to the Stack Tool dialog.
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10 Additional Functionality

The following topics are included in this chapter:

■ Park and restore

■ Printing images

■ Reject analysis

■ Dimming windows

This section describes additional functionality of the workstation.

10.1 Park and restore

You can use the 'park', and 'restore', feature if you are interrupted and are called
away to do something else. 'Parking' causes the IDS5 to store your current settings,
so that they can be restored later. Observe, however, that restoring will not bring
you back to the exact same view as when you 'parked'. This is because the first
hanging is always selected when the system is restored.

To park your workstation

1. From the Tools menu, select Park.

A dialog appears, confirming that you are 'parked'. The current state is now
saved, and can be restored whenever you like.

The 'parked' state is available for you on every workstation connected to the
same WISE server. You can 'park' as often as you like, but the most recent park
state will always be the first park state to be recalled.

Note: Only the last three 'parks' are saved when you log out. Hence it is important
to remember that if you have 'parked' the workstation, say 5 times in succession
without restoring, then the first two are only temporarily stored in memory.

To restore a 'parked' state

1. From the Tools menu in the toolbar, select Restore.

10.2 Printing images

Images can be printed from both the Matrix window, and the Image windows. The
Print command is generally found in pop-up menus opened by clicking the right
mouse-button. When the Print command is activated, the image or images are
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selected in the Print Previewer where print-outs can be previewed and/or edited
before sending them to a printer.

Tip: By configuring default partitionings for all modalities and always having automatic
partitioning and printing enabled, the printing process at your department can be
standardized and more or less automatic. There will be little or no need to open
the Print Previewer, except in special cases. Read more about configuration in
System Administrator's Guide IDS5 [1]

Note: Printed images, like other hard copy medical documents, should be handled within
the recommended guidelines of HIPAA. In most cases hospitals and/or imaging
centers should follow the same tracking and signing procedures when sending out
printed images as for film and/or reports.

Note: If grayscale statistics or pixel value measurements have been done to the image
to be printed, the remarks in section 7.8 Performing Measurements apply.

10.2.1 Printing Images from the Matrix window

From the Matrix window, you can select to print everything from single images to
all the images in an entire examination.

To print an entire examination

1. From the Examination Text View pop-up menu, clickPrint and select Print
to print the entire examination (i.e. all series in an examination), or select Print
key images to print only those images that have the key image tag set.

The images are now sent to the Print Previewer.

To print a single image or a stack

1. From the Matrix Icon pop-up menu, click Print and select Print to print the
image (or stack of images), or select the Print key images to print only those
images in a stack or collection that has the key image tag set.

The image or images are now sent to the Print Previewer.

10.2.2 Printing Images from an Image Window

From an Image Window you can choose to print the current view, single images,
or stacks and collection of images.

To print an image

1. From the Image window pop-up menu, clickPrint. If the images you are viewing
are part of a stack or a collection, you can select what kind of images you want
to print.

The following options are available:

• Select Print tile to print only the images that are currently visible.
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• Select Print stack to print an entire stack.

• Select Print key images to print all images in a stack that have the key
image tag set.

The image or images will be sent to the Print Previewer.

To print images as they appear on the screen

1. From the File menu, select Print page.

The images in the current view will be sent to the Print previewer.

10.2.3 Working with the Print Previewer

To print images

1. From the Windows menu in the Matrix- and Image Window, select Print
preview.

2. From theViewmenu select the preferred partition. Alternatively selectEnable
automatic partitioning from the Print menu to perform an automatic
partitioning based on the modality of the first image.

3. Optionally manipulate the image(s) with any of the image window commands
available in the pop-up menu you reach by right-clicking in the image part. You
can zoom, crop, change the orientation and the window/level settings of the
image, and make annotations in the image. Read more about image window
commands in section 7.3 Operations on Images.

Apart from the image window commands there are two more pop-up menu
entries, Clear and Delete. Clear erases the image in this image part whereas
Delete removes the whole image part and adjusts the positions of the following
images. If there are images waiting, they will be shifted in to fill the empty parts.

Tip: From the View menu you can choose to display image information on three
levels in the print-outs: minimum, maximum or anonymized. When the
anonymized level is selected, no patient information is displayed on the printed
images.

4. Select the preferred printer from the Printer selection box

5. Optionally configure your Windows printer by pressing theConfigure button.

6. Start the actual printing by selecting Print->Print. Alternatively select
Print->Enable automatic printing to start printing with the image area is full.
The image is considered to be full in three cases:

• Every part of the image area contains an image

• Images from another patient were selected into the Print Previewer

• A stack was selected into the Print Previewer. This requires some
configuration, read more in System Administrator's Guide IDS5 [1]
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To stop printing

1. Select Cancel printing from the Print menu.

To remove images

1. Select Delete film from the Edit menu. This removes all images from the
image area and allows any images in the queue to be shifted in. Alternatively
selectDelete all films from the Editmenu. This removes all images including
those in the queue.

10.3 Reject analysis

Note: To be able to perform reject analysis and the tasks described in this section, you
must have the Reject Analysis Package license and the Reject Analyze Series
permission. This permission is available on a per role basis and can be configured
in WISE/tools by your system administrator.

Authorized users can select and display images that have been rejected due to poor
quality or images taken for quality control purposes. The same user can also unreject
images.

10.3.1 Required configuration

For information on required configuration of reject analysis, see System
Administrator's Guide IDS5 [1].

10.3.2 Key concepts — reject analysis

Reject bin

The first key concept when working with reject analysis is the use of the reject bin
instead of the recycle bin. When deleting series by placing them in the reject bin,
they will disappear from that examination and patient. The series will, however, not
be deleted from the system but will be available for analysis at a later time. For more
information see section 6.8 Deleting images.

Reject mode

The second key concept when working with reject analysis is the workstation mode
reject mode. When the workstation is placed in reject mode, rejected series will
be displayed alongside with the existing series for the originating patient and
examination in all windows.

When in reject mode, it is possible to create presentations as usual using also rejected
series. If a presentation containing rejected series is viewed when the workstation
is not in reject mode, places where the rejected series are hung are left empty (black).
There are no special "rejected presentations".

154IDS5, Version 11.1, December 2006 Additional Functionality

Reject analysis 10.3



DDP matching is done as usual when working in reject mode with the difference
that the default DDP will be used by default, not the best matching DDP.

To toggle between reject mode and normal viewing

When selecting a reject worklist, the workstation is automatically placed in reject
mode. It is also possible to manually switch to reject mode.

1. From the View menu, select Show rejected series.

The menu option is marked with a checkmark to indicate that you are in reject
mode. Rejected series are now shown alongside with non-rejected series in all
windows. You can perform any tasks of the workstation as usual.

2. To return to normal viewing mode, hiding all rejected series, select Show
rejected series from the View menu again. When selecting another worklist
that is not a reject worklist, the mode will be set to normal viewing mode
automatically.

Reject status

A series can have the following reject statuses:

Non-rejected Non-deleted series. The vast majority of all series in the
system will be original. These series are visible both when
the workstation is in normal viewing mode and in reject
mode.

Rejected New Non-approved rejected series. These series have been
rejected (deleted) and are awaiting approval. A rejected
series is only visible when the workstation is in reject
mode.

Rejected Analyzed The final status for a rejected series. These series have
been rejected (deleted) and approved in the rejection
analysis. A rejected series is only visible when the
workstation is in reject mode.

10.3.3 Sample workflows

This section describes the main workflows related to reject analysis.

To perform reject analysis

Series have previously been deleted from examinations using the reject bin. This
procedure describes how to analyze these rejected series.

1. Open a reject analysis worklist in the Information window. Reject analysis

worklist are identified by the worklist icon: .

2. All examinations that meet the worklist definition and have the reject status
"Rejected new" are listed. As usual, all other examinations belonging to each
patient are displayed as well, though they are not marked as matching
examinations.
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The workstation is now automatically placed in Reject mode, meaning that
rejected series are displayed alongside with existing series in all windows. Any
rejected series is marked with one of the reject icons.

You can now work with the rejected images in the Matrix, Quick or Images
window in the ordinary way.

3. In the Matrix window, select a non-approved rejected series. Hover with the
mouse pointer over the image icon to display the reject reason and comment

.

4. You can also use the Quick window or Image window to inspect the series more
in detail and to compare them with non-rejected series. To display the reject
reason and comment in the Quick and Image window, select Show reject
information from the pop-up menu.

5. If the reject reason is incorrect or the comment insufficient, you can change the
reject reason or comment. SelectChange reject reason from the icon, or image
pop-up menu.

6. When done, you want to approve the rejection. In the Matrix window, from
the icon menu, selectReject analyze. The reject status changes from "Rejected

New" to "Rejected Analyzed" and the reject icon changes to: .

Alternatively, you can change the reject status directly from the Quick or Image
window by selecting Reject analyze in the pop-up menu.

Tip: It is possible to give the Rejected Analyzed status for all series in an examination
by selecting Reject analyze all series on the examination information pop-up
menu.

7. Continue with the next rejected series in the examination. When done with the
current examination, click Next case to continue to the next examination
containing non-approved rejected series.

To change reject reason

If a user realizes he/she set the incorrect reject reason or comment after confirming
the rejection, an authorized user can edit the reject reason. This procedure describes
how.

1. Make sure the workstation is in reject mode, either by selecting a reject worklist
or by selecting Show rejected series from the View menu.

2. Find the patient using the search function or any worklist.

3. In the Matrix window, select Change reject reason from the icon pop-up
menu.

4. Make your changes in the Change reject reason dialog and click OK.

To restore rejected images after confirmation

If a user realizes he/she made a mistake deleting a series after confirming the
rejection, an authorized user can restore the series.
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1. Make sure the workstation is in reject mode, either by selecting a reject worklist
or by selecting Show rejected series from the View menu.

2. Find the patient using the search function or any worklist.

3. In the Matrix window, select Unreject series from the icon pop-up menu.

Alternatively, you can unreject series from the Quick or Image window by
selecting Unreject series from the pop-up menu.

4. In the Unreject series confirmation dialog, click Yes.

The reject icon disappears and the series is restored. The incorrect reject
information will no longer be available.

Radiographer education

Rejected series are useful for visualizing errors that can be made when operating
the radiology equipment, for example motion blur, poor positioning and different
kinds of artifacts.

1. From the View menu, select Show rejected series.

2. Find interesting cases. Use a reject worklist to find examinations containing
rejected series. For more information, see section 5.1.2 Creating reject worklists.

Rejected worklists are identified by the worklist icon: .

3. Prepare the interesting cases. You can create presentations as usual, for example
comparing rejected and non-rejected series for the same patient.

Tip: Create a teaching file for the interesting cases and use image information level
Anonymized.

4. At the teaching occasion the workstation must be in reject mode.

10.4 Dimming windows

Note: To be able to use the automatic dim function you must have the Mammography
license

You can dim the brightness of the Information window and/or the Matrix window.
This is useful as the light from the windows may disturb the reading of images in a
dark environment.

The workstation can be configured so that the windows are either dimmed when
not in focus (i.e. when the mouse cursor does not point in the window) or always
dimmed. The workstation can also be configured not to dim the windows.
Configuration is done on a per window basis. With the default configuration the
Information window is dimmed when not in focus, and the Matrix window is not
dimmed. For information on the configuration, please refer to the System
Administrator's Guide IDS5 [1].
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Dimming is inactivated or re-activated by the command Automatic dim on a per
window basis. If the workstation is configured to never dim any of the windows,
this command will be unavailable.

To inactivate/re-activate dimming

1. From the View menu in the Information or Matrix window, select Automatic
dim. The check mark indicating that the automatic dim function is active
disappears and the window will not be dimmed.

2. From the View menu in the Information or Matrix window, select Automatic
dim. The check mark indicating that the automatic dim function is active
re-appears and the window will be dimmed in accordance with the configuration
made for the workstation.

158IDS5, Version 11.1, December 2006 Additional Functionality

Dimming windows 10.4



11 Sample Workflows

The following topics are included in this chapter:

■ A technician Prepares a New Examination

■ A radiologist Views a Case

■ A radiologist Views a Mammography Case

This section presents a number of sample workflows. The purpose of these samples
is to give you an idea of how to perform common tasks in IDS5.

11.1 A technician Prepares a New Examination

The following describes how IDS5 is normally used by a technician (nurse), to
prepare a series of images for viewing by a radiologist.

Sample workflow for preparing a new examination

1. Images will initially be held on the modality. For images to be available in IDS5
you must first import them to the PACS.

2. In the Information window, select the worklist that corresponds to the case you
are preparing, by clicking on the relevant worklist in the Worklist View.

The Patient list is updated with all patients for which there are one or more
examinations that match the worklist search criteria.

3. If the new examination is not present in the Examination list it may be necessary
to force a new search ("refresh"). To force a refresh, click Refresh worklist in
the View menu.

All views in the Information window will be updated to include the newly
imported images.

4. In the Patient list, select the patient that you are currently working with.

The Examination list will be updated with all the available examinations for the
selected patient.

5. In the Examination list, select the examination that was created when you
imported the images.

You are now ready to inspect the newly imported images. This is done using
the Matrix window.

6. From the View menu, click Open matrix.

The Matrix window will appear.
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7. Check that the new examination has been given the right type label. The type
label is written at the top of each examination row in the matrix. For more
information on how to change the examination type, please read section 6.2.4
Force Examination Type Matching.

8. In the Examination row, check that all imported images have the correct series
type (the type label is written above each matrix icon). For more information
on how you change the series type for an image, see section 6.2.5 Force Series
Type Matching.

It is now time to check the quality of the images. This is done from the Quick
window.

9. Move the mouse over the first image in the newly created examination. Then,
from the Matrix Icon pop-up menu, clickOpen quick window. It is also possible
to double-click on the image icon.

The Quick Window will appear, displaying a full screen version of the selected
image.

10. If necessary, make various adjustment on the image (this might include adjusting
grayscale, performing cropping, changing the orientation etc). For more
information on how you use the Quick window to make image adjustments,
please read chapter 8 Using the Quick Window.

11. Move to the next image in the examination by clickingMove right in theView
menu.

The next image in the examination (the images to the right of the current image
in the matrix), will be displayed.

12. Repeat steps 10 and 11 until you have inspected all images in the examination.

13. From the File menu, click Close.

The Quick window will be closed, and you will return to the Matrix window.

14. Check that the DDP applied by the system is satisfying. If not, you can create
a manual presentation. For more information on how to create a manual
presentation, please read section 6.6 Creating a Manual Presentation.

Note: When you save a manual presentation, you should save it for system use. If
you do not do this, the presentation may not be available to the radiologist that
views the case.

11.2 A radiologist Views a Case

The following is a description of how IDS5 can be used by a radiologist to view a
case. This assumes that IDS5 has been started, and that the Information window
has been activated.
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Sample workflow for viewing a case, or set of cases

1. In the Information window, select the worklist that contains the cases you want
to view, by clicking on the relevant worklist in the Worklist view.

The Patient list will be updated with all patients for which there are one or
more examinations that match the worklist search criteria.

2. Select the case you want to view by either clicking on a patient and an
examination in the Patient- and Examination lists, or use the case navigation
commands that are available in the View menu. From the View menu, select
Previous case to move to the previous matching examination, or select Next
case to move to the next matching examination.

The Series list, and the Request and Report views, are updated to show
information about the selected case.

3. View the images for the selected case by clicking Open Images in the View
menu.

One or more Image windows will open, showing the first hanging. Most cases
have presentations that include several hangings. You can browse through all
hangings from an Image window, by selecting Next hanging or Previous
hanging from the View menu. This action will move you to the next or to the
previous hanging in the presentation. These commands may be interchanged
with versions that wrap around when the last or first hanging has been reached.
Please read chapter 12 Setting Options for a description of how to make new
commands available in IDS5.

Normally a presentation is based on a DDP that is automatically chosen by
IDS5. However, if a manual presentation has been prepared by the technician,
this presentation will be chosen instead of that from the DDP. You can also
manually select which type of presentation to use by clicking in thePresentation
Selector that is available in the toolbar.

4. When you have finished viewing the images, it may be necessary to change the
status of the examination to indicate that it has been dealt with. To change the
examination status, select the new state from the State menu in the Image
window.

5. Move on to the next case by selecting Next case from the View menu.

The Information window will be updated with information from the next
matching examination in the worklist. If you want to go back to a previous case,
select Previous case from the View menu.

11.3 A radiologist Views a Mammography Case

This is a description of how IDS5 can be used by a radiologist to view mammography
cases in a screening situation. Parts of the workflow are available only with the
mammography module. The workflow assumes that IDS5 has been started, that
the Information window has been activated and that the dedicated keypad is used.
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Sample workflow for viewing a mammography case

1. Using the Information window, select the worklist that contains the cases you
want to view, by clicking on the relevant worklist in the Worklist View, e.g.
Unread.

The Patient list is updated with all patients for which there are one or more
examinations that match the worklist search criteria; e.g. all unread cases that
are to be reviewed.

2. Select the first case in the Patient list, and double-click on it to open the images.

One or more Image windows will open, showing the first hanging. Most cases
have presentations that include several hangings. The first hanging is often an
overview of all the images. Go either to the next hanging using the Next
hanging button on the key pad, or to previous hanging using the Previous
hanging button.

3. Click the Zoom button to see a magnified image of the image. The zoom
function magnifies the image approximately 2 times and will pan the image to
upper right or upper left corner, depending on laterality of the image. Click the
Zoom button again, and again, to see the other quadrants. The 5th time you
click the Zoom button, will return the image to its initial state.

4. Click theWin/Lev button to switch between predefined window level settings.

5. When you have finished viewing the images, it will be necessary to change the
review status, and to decide if the case is normal or otherwise. Do this by pressing
theOK button on the key pad, for a normal case, or theDiscussion button on
the key pad, for a suspicious case. This action will also save the current user as
the reading Radiologist, either as the first reviewer or the second reviewer,
depending on how the key pad is programmed.

6. Move to the next case by pressing Next case on the key pad.

The Information window will be updated with information from the next
matching examination in the worklist. If you want to go back to a previous case
you can select this on the key pad.
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12 Setting Options

The following topics are included in this chapter:

■ Configuration structure

■ Configuring Menus and Toolbars

■ Configuring General Properties

■ Configuring Image Display Properties

■ Configuring Image Tools Properties

■ Configuring Stack Viewing Properties

■ Configuring Windows Properties

■ Configuring Search Properties

■ Configuring License Properties

■ Configuring Interaction Modes

■ Configuring exam type specific settings

■ Configuring dictation

IDS5 contains a large variety of options that can be used to customize the application.
For example,it is possible to configure which commands that should be available in
menus, and toolbars. The configuration is setup in the Options dialog, which you
open by selecting Options from the Tools menu.

If you are an IDS5 administrator, a dialog box will appear where you can select
whether to modify your own configuration, or the configuration for a certain role.
To do this, select the role (or yourself) from the list box in the dialog and click the
Continue button. If you save configuration for a role, that configuration will be
applied to all users who have their preferred role set to this role. This is a way to
set default values for a group of users.

12.1 Configuration structure

The configuration structure is divided into several items, each stored separately.
This means that the set of configuration items used when logging in to IDS5 can
be a combination of items from both the user, and from the user's roles.
Configurations cannot be merged inside an item, i.e. the most appropriate
configuration item that is found will be used in it entirety.

Most settings in theOptions dialog are treated as separate configuration items. For
menus and toolbars the configuration items are:

Menubar configuration The menu labels in the IDS5 windows' menubars.
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Menu configuration The commands in each menu of the menubars.

Pop-up configuration The commands in each pop-up menu/toolbox.

Toolbar configuration The commands in the IDS5 toolbars.

Shortcut configuration The shortcuts for all commands.

When logging in to IDS5, the system searches for configuration items in the
following order:

1. Configuration item for the current user

2. Configuration item for the current user's preferred role (the preferred role is
defined in WISE/tools)

3. Configuration item for the current user's other roles (in random order)

As soon as a configuration is found, IDS5 looks no further. This means that if there
is a user configuration of a certain item, this configuration will always be used. In
the same way, configurations for the preferred role will override configurations for
other roles.

12.2 Configuring Menus and Toolbars

As with many Windows-based applications, you can change the configuration of
the toolbar in the IDS5. Changing menu/toolbar configuration is done in a similar
way that in, for example, Microsoft Word and Internet Explorer. The main difference
here is that the workstation employs a user/role concept.
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1. This list shows the current configuration and commands that are assigned to a
shortcut.

2. This list shows the commands that are available but not used.

3. The path to the currently selected menu or window is displayed in the path box.

4. Define a shortcut for a command by typing in the shortcut combination in the
edit box. The entered shortcut is checked to see if it is already assigned to a
command.

To configure menus and toolbars

1. Select the Menus & Toolbars tab in the Options dialog.

This dialog contains a list of configurable options on the left side, and a list of
possible commands for the given options on the right side.

2. Select the option you wish to change from the area on the left. For example,
you can select Quick window->Menubar->&File. This will enable you to
configure the File menu, in the menubar displayed in the Quick window.

3. Select any options on the right that you wish to add to the configuration, and
click the Add button.

4. Select any options on the left that you wish to remove from the configuration
and click the Remove button.
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5. It is possible to change the order of any commands by selecting the command,
and clicking either the Up or Down buttons. The selected command will then
be moved up or down.

6. Apply any changes you have made to the configuration by clicking the OK
button.

To configure shortcuts:

1. Select the command that you want to give a new or updated shortcut to, by
double-clicking the list on the left side. For instance, you can select Quick
window->Menubar->&File->Close to select the Close command.

2. Select the shortcut edit box.

3. Type in a shortcut sequence with the keyboard. Shift and/or CTRL keys can
be used in a shortcut sequence.

4. A check is made to see whether the command is already assigned to a command,
in which case the name of that command is displayed.

5. Save the changes by clicking on the Assign button in the shortcut frame.

Note: Command activation through the use of shortcuts requires that the command
in question is accessible from a menu. A toolbar command must therefore
also be present in a menu, to enable shortcuts to the command.

12.3 Configuring General Properties

IDS5 offers some general configuration parameters that may be used to personalize
the behavior of IDS5. Most parameters in this dialog is only possible to configure
on system level. These parameters will be disabled when configuring for a user or
role.

166IDS5, Version 11.1, December 2006 Setting Options

Configuring General Properties 12.3



The general configuration dialog shows the current configuration.

My language You can configure your preferred language.
This is configurable on user level.

Create new examination A default station name can be set. This station
name is used when creating a new examination
in IDS5. This is configurable on system level.

Examination time from RIS In the frame Examination time from RIS you
can choose whether or not the examination
time should be affected by the command
Update from RIS. This configuration is valid
on system level.

In addition, it is possible to configure the
examination time on a machine level. For
further information, please read System
Administrator's Guide IDS5 [1].

Presentations Depending on the workflow it may be
beneficial to show/use presentations for other
examinations than the current base
examination. This is useful for instance when
multiple examinations exist for the same
request, or if you are not interested in using
base examination when creating a presentation.
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It is possible to show different manual
presentations by switching between the
following modes:

• The current base examination only (the
default mode).

• All examinations for the current request.

• All of the current patient's examinations
that matches the worklist search criteria.

It is possible to turn off DDP
rematch/refresh, which otherwise is applied
automatically when the exam type change
because new images arrives. A command
RematchDDP is available to perform manual
DDP rematch.

This is configurable on system level.

Select base examination on
single-click

Base examination is normally selected when
an examination in the information window is
double-clicked. However, in certain workflows
it may be beneficial to select the base
examination on a single mouse click.

Always select patient upon
RIS/PACS sync

If the RIS does not explicitly send which
examination to select in IDS5, it is possible to
let IDS5 select the only patient in the worklist,
which automatically selects the latest exam and
shows the images if the image windows are
opened. It is important to notice that this may
result in IDS5 showing a different exam than
what is selected in the RIS.

Auto select patient (After
search)

If it's undesirable that a patient becomes
selected automatically after a search in the
Information Window, it is possible to turn off
this behaviour. This is configurable on system
level.

Register referring units It is possible to register names of referring
units. Registered referring units can then be
connected to specific clinical demonstration
worklists. This is configurable on system level.

Report sort order It is possible to change the order in which
reports are shown in the IDS5 and IDS5/web.
This setting can be found on the General tab
in the Options dialog.

Note: This is configurable on system level only.

Possible settings are:
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Chronological Reports are shown in chronological order, starting
with the oldest report.

Reverse chronological Reports are shown in reverse chronological order,
starting with the newest report. This is perhaps the
most useful configuration since it shows the most
recent report by default.

Unsorted order Reports are not sorted. Use this mode only if your
workflow requires the old sorting algorithm.

To configure general parameters

1. Select the General tab in the Options dialog.

2. Select a preferred language from the My language drop down box.

3. If you are configuring for the system level: Type in a new default station name
in the corresponding edit box of the Create new examination frame.

4. If you are configuring for the system level: Choose whether or not the
examination time should be affected by the command Update from RIS by
selecting Yes or No in the frame Examination time from RIS.

5. If your current workflow benefits from selecting base examination on single
clicks, check the Select base examination on single-click checkbox.

6. If you are configuring for the system level: Select if IDS5 should always select
a patient on RIS sync by selectingYes orNo in the frameAlways select patient
upon RIS/PACS sync.

7. If you are configuring for the system level: Select if IDS5 should automatically
select a patient after a search by selecting Yes or No in the frame Auto select
patient (After search).

8. If you are configuring for the system level: Select if connected examinations'
manual presentations are to be shown in the Presentations frame.

9. If you are configuring for the system level: Register referring units in the
Register referring units frame by clicking the Add... button and type in the
name in the following dialog. Units can be removed by using theDelete button.

10. Apply the changes to the user configuration by clicking the OK button.

12.4 Configuring Image Display Properties

IDS5 offers several configuration parameters regarding the Image Display.
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The image display configuration dialog shows the current configuration.

Hardware acceleration Hardware acceleration can be disabled for one
type of graphics board. Select the correct type
in the list and use the checkbox to disable
hardware acceleration for this board type.
Please contact your system administrator for
configuring more advanced hardware settings,
such as real-time software resampling.

Annotations default state The default setting is to always show
annotations. However, when performing
secondary review it may be of importance to
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disable automatic display of annotations. This
may be configured per role or user.

Note: The radiologist must be fully aware of this
configuration, so that no annotations are
unintentionally missed. Automatically hidden
annotations should only be used by the
secondary reviewer. Likewise should care be
taken when using the command Hide
annotations in the Image window View menu
(Annotations sub menu). This command
affects all Image windows including windows
currently obscured by e.g. the Information
window. The Radiologist should be aware of
this fact so that any previously hidden
annotations are not unintentionally missed
when switching to a previously obscured view.

Select network If your client is an IDS5/cl.net client, and the
server you are connected to uses JPEG2000
compression, you can select what network you
are using. In the combo-box in the Net type
frame you can select between three different
net types and one default setting. The
configuration is done for a role.

To configure image display

1. Select the Image Display tab in the Options dialog.

2. Select the preferred configuration.

3. Select the net type that best matches your network (use the default if you are
connected to a high bandwidth network).

4. Apply the changes to the configuration by pressing the OK button.

12.5 Configuring Image Tools Properties

IDS5 offers several configuration parameters regarding the tools connected to
general image viewing.
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Default active command It is possible to configure a command, to be
automatically active in the Image window or
Quick window. The drop-down list contains
all Image window commands that can be active
by default, i.e. mouse controlled commands.
The image command that is active by default
will be automatically executed each time the
left mouse button is clicked on an image.
Technicians will probably prefer to have the
crop command active while radiologists might
want to have some measure command as their
default command.

It is also possible to configure the default
command to be automatically updated to the
last mouse activated command. This

172IDS5, Version 11.1, December 2006 Setting Options

Configuring Image Tools Properties 12.5



functionality is selected by checking the
checkbox.

Note: The default active command will only be active
provided that pan is the current interaction
mode and the image is zoomed out. In other
cases (if the image is zoomed in or if any other
interaction mode than pan is selected) the
interaction mode will be the active command.

Predefined annotations Predefined annotations may be activated as a
dynamic Image View command, accessed from
the Image View pop-up menu. The defined
annotations will be displayed with their label,
and the configured annotation text will be
inserted in the image, when the command is
selected. The list shows all available predefined
annotations. The annotations are accessible
when writing an annotation, by scrolling the
mouse-wheel (middle button). For more
information please read To use predefined
annotations. Annotations are created or
modified in a text edit dialog:

Pixel value display You can configure to show or hide the pixel
value display, see To measure a single pixel
value, by selecting the checkbox. Applying the
command in the Image Window View menu
will also change the default state, in other
words it is the same thing as setting this
configuration on user level.

Edge Enhancement Level The edge enhancement level is displayed in
percentage, and is altered by moving the slider
to the left or right. The slider is moved in the
same manner as other mouse drag-and-drop
operations. Stack precomputation is used to
improve performance when viewing stacks that
have some image processing, such as edge
enhancement, applied to it. Stack image
precompute is enabled by selecting the
checkbox.

Window/Level settings The grayscale setting can be done in different
ways and this can be configured using the list
in the Window/Level settings frame. The
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figure shows how mouse movement in different
directions correspond to how the grayscale
settings change.

Mouse double-click action It is possible to configure what action to be
executed when a mouse double-click is
performed. It is possible to have different
actions depending on the state of the modifier
keys CTRL and SHIFT. Available actions are
zooming of selected tile (Zoom tile), zooming
of selected partition (Zoom partition), a
combination of zooming the selected tile and
partition (Zoom tile/partition) and moving
the crosshair marker (Move crosshair). See
below for a description.

Zoom tile Zooms the selected tiled image so that it covers the
whole partition, i.e. toggle to 1x1 tile mode. Use the
double-click combination again to return to previous
tile mode.

Zoom partition Zooms the selected partition so that it covers the
whole image window, i.e. toggle to 1x1 partitions. Use
the double-click combination again to return to
previous partitions.

Zoom tile/partition Zooms the selected tile and partition, i.e. the selected
tile will be enlarged to cover the whole image window.
Use the double-click combination again to return to
the previous tile and partition.

Move crosshair Moves the crosshair to the current mouse position.

Note: The crosshair must be turned on.

To configure image tools properties

1. Select the Image Tools tab in the Options dialog.

2. Select a default active Image View command by opening the Default active
command drop-down list, and clicking on one of the list items.

3. Add, modify, or delete predefined annotations by clicking on the New, Edit,
or Delete buttons in the Predefined annotations frame.

4. Set edge enhancement level by adjusting the slider. Select whether to use stack
precomputing by checking or unchecking the checkbox in the same frame.

5. Select mode for grayscale setting in the list box of theWindow/Level settings
frame.

6. Select commands for different double-click actions in theMouse double-click
command frame.

7. Apply the changes to the configuration by clicking the OK button.
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12.6 Configuring Stack Viewing Properties

The Stack Viewing property page is used to configure the behavior of functions
connected to viewing of image stacks.

Slab view properties The slab properties page is used to configure
the default values that should be applied when
the slab viewer is started.

In the configuration dialog the user can set the
default settings for slab view mode, i.e. thickness,
increment, maximum values, and mode. For a
more detailed description of these please read
section 7.16 Slab view. When the slab view mode
is started, the settings are applied. When
changing the settings in the slab view mode, no
adjustments are made to the default settings.

Localizer default state The default state for displaying the Localizer
can be set here. Use the list box to set the default
state: hidden, shown in simple mode (no
crosshair), or shown completely.

Crosshair navigation The navigation mode of the localizer crosshair
can be configured here. If checked, the crosshair
position will be used to update related views with
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the projection closest to the crosshair position.
If unchecked (Default), the crosshair position
will not affect the content in related views. Note
that if a corresponding view is in tile mode, the
closest projection is displayed in the top left tile.

Cine tool startup mode The default start up mode for displaying the
Cine Tool can be set here. Use the list box to
set the default mode: Full size, or Minimized.

Initial slice What slice that should be displayed by default
when a stack is hung can be set here. The
available alternatives are first, middle or last
slice. If no changes are made the first slice will
be used. If the initial slice has been configured
in a DDP the DDP settings should have
precedence over the default configuration.

Stack navigation The setting "Force display of every slice"
controls whether all slices are displayed or not,
when navigating through a stack. When turned
off, all slices are not necessarily shown if the user
is scrolling quickly enough. When turned on,
every slice is completely drawn before moving
to the next one.

To configure stack viewing properties

1. Select the Stack Viewing tab in the Options dialog.

2. Set default values for Slab view (thickness, increment, unit, and mode) in the
edit and list boxes of the Slab view properties frame.

3. If the slab view control should automatically appear for large stacks check the
check box and type in a size limit in the lower edit box of the Slab view
properties frame.

4. Select default state for the Localizer in the list box of the Localizer default
state frame.

5. Select the default mode of the Cine tool in the list box of theCine Tool startup
mode frame.

6. Apply the changes to the configuration by clicking the OK button.

12.7 Configuring Windows Properties

The Windows properties page is used to configure behavior and appearance of
windows in IDS5.
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Matrix window examination
information

The Matrix window examination information
section controls the information displayed for
an examination in the Matrix Window. The
left part concerns the information for a
collapsed examination, and the right part
concerns expanded examinations. To change
either configuration, click the corresponding
Change... button. Then you are presented
with the following dialog:

In this dialog you can set up to three
examination attributes to be displayed. The
check boxes on the extreme left enables an
attribute selection. In the Attribute list box,
select the attribute to display. Each attribute
information for a collapsed examination can
be limited to a certain number of characters.
This is set in the Number of characters list
box. These list boxes are disabled for expanded
examinations.
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Information window list
columns

Here you can select which columns you would
like to see in the Patient list and Examination
list. The changes will take effect directly after
you exit the options dialog. Any new columns
will be put to the right of the existing.

Note: Columns can only be configured for the current
user. The configuration will also be unavailable
the first IDS5 session, log out and in again to
access it.

Columns can be renamed by double-clicking
on the name in the list, a dialog appears where
a new name can be assigned.

After returning to the options dialog the
original name will be in parenthesis.

Note: Change of column names will not appear in
the Information Window until the next time
start up or login to IDS5.

Hide tool area This configuration decides if your menubar
and toolbar should be covered with black in
the Image window and Quick window.

Warning dialogs Additional warning dialogs may be enabled or
disabled. These settings are configured per
role. The configuration checkbox is disabled,
as displayed above, when the options are
configured for a specific user. The
configuration checkbox is enabled when the
options dialog is opened for configuration of
a role.

Wrap series icons Checking this option will enable wrapping of
the series icons in the Matrix, Fetch image,
Recycle bin and Reject bin windows. This
means that instead of placing all icons of an
examination on a single row, icons placed to
the right of the right edge of the window will
be wrapped onto additional rows within the
same examination.

Open Image window from icons Checking the "Double-click on Matrix icons
and Information window thumbnails opens
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Image window" checkbox will cause the Image
window to be opened when the user
double-clicks an icon in the Matrix window or
a thumbnail in the Information window.

To configure windows properties

1. Select the Windows tab in the Options dialog.

2. Select which information that should be displayed for collapsed, and expanded
examinations in the Matrix window in the Matrix window examination
information frame.

3. Select whether to hide image windows tool areas using the checkbox in the
Hide tool area frame.

4. Select whether to activate examination wrapping using the checkbox in the
Wrap series icons frame.

5. Select whether double-clicking an icon in the Matrix window or a thumbnail
in the Information window opens an Image window or the Quick window by
using the checkbox in the Open image window from icons frame.

6. If you are configuring for a role: Check the check box in the Warning dialogs
frame to enable extra warning dialogs.

7. Apply the changes to the configuration by clicking the OK button.

12.8 Configuring Search Properties

The search properties page is used to configure how different searches are performed
in IDS5.
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The default search criterion controls the behavior of IDS5 search functions, i.e. the
selected criterion will always be selected when opening a search dialog.

The extended patient search options controls the behavior of the IDS5 extended
patient search function. The selected servers will be used by the command to search
for more examinations relating to patients. The patient search attribute determines
how patients are searched for on the selected servers. For instance, if you select
patient by personal ID, all examinations for patients with matching patient personal
ID's will be found.

WISE servers selected for extended patient search can also be used for RIS
synchronization. If this feature is enabled, IDS5 will use the WISE servers selected
in the extended search list when synchronizing with a RIS in order to find patient
data that is not located on the home WISE server. If this feature is disabled, only
the home WISE server will be used when synchronizing with a RIS. Observe that
this feature is only available for remote WISE servers, not for DICOM Q/R servers.

To configure search properties

1. Select the Search tab in the Options dialog.

2. The default search criterion can be changed by selecting the attribute from the
Default search criterion drop-down box.

3. Select the servers to be used when performing an extended patient search, by
selecting them in the server list.

180IDS5, Version 11.1, December 2006 Setting Options

Configuring Search Properties 12.8



4. Check theUse selectedWISE servers for RIS sync checkbox in order to use
the selected servers for RIS synchronization.

5. Select the patient search attribute to be used by extended patient search, by
selecting appropriate attribute in the drop-down box.

6. Apply the changes to the user configuration by clicking the OK button.

12.9 Configuring License Properties

The license properties page is used to configure the "Roaming Desktop" properties.
Please see section 4.9 Concurrent User Engine and section 4.10 Roaming Desktop
for more information. This configuration can also be performed using WISE/tools.

When you log on, the IDS5 associated with your role, will start. A system
administrator configures which role uses what type of IDS5. For instance, whenever
a user using the role "technician" logs on, an IDS5/qa.net will start, and if a user
using the "radiologist" role logs on, an IDS5/dx.net will start.

If the Basic product list box is active, you are able to switch to whatever type of
IDS5 you wish. If the list box is inactive you do not have the permission to switch
products. Only users with system administrator privileges are allowed to switch
IDS5 products.
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The Add-on packages box allows selecting the add-on packages to be available in
IDS5 when you log on.

12.10 Configuring Interaction Modes

The Interaction modes property page provides the possibility to configure which
interaction modes that will be applied for certain mouse button combinations. It is
also possible to configure the default interaction mode available on the left mouse
button for different image types.

Note: Some interaction modes might be inactive for certain image types. For example,
the Browse action is not available for single images.

The default settings are:

• Left + Right — None

• Left + Middle — Browse

• Right + Middle — None

• Middle — Window/Level

• Mouse wheel scroll — Browse
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• Default left mouse button for single images — Pan

• Default left mouse button for stacks — Pan

The Default settings button will apply the default settings.

12.11 Configuring exam type specific settings

The tab Exam type specific settings is used to configure settings for different exam
types. The type label is written at the top of each examination row in the matrix.
For more information on how to change the examination type, please read
section 6.2.4 Force Examination Type Matching.

You change the configuration by marking an existing exam type from the list and
then check or uncheck the checkbox at the property you want to change for that
exam type.

You can configure the following properties for each exam type:

• Edge enhancement

• Cine loop

• Magnifying glass synchronization
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• Group synchronization

• Mirrored synchronization

Note: If an examination matches any of the exam types that have been configured with
e.g. edge enhancement, the images of this exam will be shown with edges
enhanced.

Note: To be able to use mirrored synchronization you must have the Mammography
license.

Note: It is not recommended to automatically enable group synchronization on large
stacks, as it may affect the time to next case.

12.12 Configuring dictation

The Dictation page is used to configure different properties of the communication
between IDS5 and an external dictation system. All properties are configurable at
system level.

Dictation start status By setting this property a specific status is
automatically set on examinations when
dictation starts. If the status No status is
chosen, no status change will be made. If Set

184IDS5, Version 11.1, December 2006 Setting Options

Configuring dictation 12.12



changes on base exam only is checked then
only the base exam will be affected.

Set next status By setting this property the next available status
will automatically be set on examinations when
dictation ends.

Set specific status By setting this property a specific status is
automatically set on examinations when
dictation ends. If the status No status is
chosen, no status change will be made. If Set
changes on base exam only is checked then
only the base exam will be affected.

Set reading radiologist By setting this property the logged in user is
set as reading radiologist on examinations when
dictation ends. If Set changes on base exam
only is checked then only the base exam will
be affected.

Move to next case By setting this property the next case in the
current worklist will automatically be selected
when dictation ends.

Set changes on base exam only By setting this property status changes and
setting of reading radiologist will only affect
the base examination. If not set these changes
will affect all examinations related to the
current request. This setting has no effect
when dictating on multiple examinations at the
same time.

Enable dictation on multiple
examinations

By setting this property it will be possible to
dictate on multiple examinations at the same
time.

To configure dictation properties

1. Select the Dictation page.

2. Select a status in the list Dictation start status that should automatically be
set when dictation starts. Select the status No status if no status should be set.

3. Select if the next available status should be set when dictation ends by checking
Set next status. If a specific status should be set check Set specific status and
also select a status in the list Dictation end status.

4. Select if reading radiologist should be set when dictation ends by checking Set
reading radiologist.

5. Select if changes to status and reading radiologist are to be made on the base
examination only by checking Set changes on base exam only.

6. Select if it should be possible to dictate on multiple exams at the same time by
checking Enable dictation on multiple examinations.
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A What's new IDS5

The following topics are included in this appendix:

■ What´s new 11.1

The intended reader of this appendix is the Sectra PACS end user. For a complete
description of every change made in 11.1, please refer to Release Notes IDS5 [5].

A.1 What´s new 11.1

This chapter describes new functionality added in version 11.1 of the IDS5 family,
as compared to version 10.2 P1.

A.1.1 New features in IDS5

Some general areas of the IDS5 have been further improved.

Easy to export and import to a user-defined folder (e.g. USB)

As an alternative to exporting to CD, you can now export and import examinations
to and from any folder located on the local file system or a remote host, e.g. a USB
memory stick.

Export examinations to a USB memory stick

• Change proposal: PCR-SKOZ-6HKE53 released in IDS5_11_1.

• For more information on exporting to a user-defined folder, please refer to
section 5.6 Import and export.

• Exporting to a user-defined folder is enabled in cd_import_export.def.
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CD export and import improved

The format of the content to be exported to CDs from IDS5 has been improved,
now supporting more CD burning programs.

The time it takes to export examinations including the CD viewer to CD has been
reduced, as has the startup time of the CD viewer when viewing the CD.

The import of CDs has been improved to support a workflow where a very large
number of CDs are imported to the local PACS, and where these CDs not always
are fully compliant with the DICOM standard. A DICOM compliant CD contains
an index file called DICOMDIR which keeps track of all images on the CD. If this
file is missing or broken, IDS5 can still try to import the images.

In addition the user can easily select whether an examination imported to Sectra
PACS via CD, folder, e-mail or teleradiology, should be archived or not.

Details

• Change proposal: PCR-PSJN-6EEGPW, PCR-SMIS-6E3GRT,
PCR-SMIS-6DUEQH, released in IDS5_10_2_P3.

• Change proposal: PCR-ABOT-6F5BAH for improved performance, released
in IDS5_11_1.

• For more information on supported CD burning programs, please refer to
System Requirements Sectra PACS.

• For more information on importing CDs, please refer to section 5.6 Import
and export.

Improved teleradiology functionality

Sending examinations using teleradiology has undergone several improvements to
make it easier to use, configure and maintain.

E.g. the column destination has been added to the IDS5 Queue window making
teleradiology easier to troubleshoot. This is for instance useful if someone from the
receiving clinic contact you because an examination has not arrived. You can then
easily find the requested examination by sorting the Queue window on destination.

The performance of teleradiology has also been improved.

Details

• Change proposal: NOWE-5V8AWA, released in IDS5_11_1.

• For more information on exporting examinations using teleradiology and the
IDS5 Queue window, please refer to section 5.6 Import and export and
section 3.6 The Queue Window.

Worklist subscription between ImageServer/s servers

In release 11.1, Sectra PACS offers the ability to automatically route images to
another ImageServer/s within the same PACS. This is useful in a distributed scenario,
for automatically sending the examinations from e.g. a remote imaging center to
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the main hospital for reading. Hence, there is no longer a need for a user to manually
send the worklist with teleradiology.

Worklist subscription was previously only available for IDS5/home destinations.

Details

• Change proposal: AÖSM-5MQMBN, released in IDS5_11_1.

• For more information on configuration of ImageServer/s worklist subscription,
please refer to System Administrator's Guide WISE.

Improved integration with RIS/HIS using HL7

Sectra PACS now supports bi-directional HL7 RIS integration. This enhances the
RIS integration capabilities by adding bi-directional data flows. You now have the
possibility to send items from PACS to RIS, such as double reading results (code,
reader and status) in a mammography screening reading session.

The examination prefetch from the long-term archives for examinations scheduled
via HL7 has also been improved. The prefetch mechanism previously retrieved all
archived prior examinations for the patient. It has now been refined to perform
prefetching on the following criteria:

• Minimum and maximum number of examinations to prefetch

• Maximum examination age

• Examination matching based on modality, body part and examination code of
the scheduled examination

Details

• Change proposal: PCR-JYNN-69QGH9, PCR-ABRN-6AYAWW released in
IDS5_11_1.

• This functionality requires server add-on HL7 RIS Interface.

• For configuration of the HL7 interface, please refer to System Administrator's
Guide HL7 RIS Interface.

Cancel scheduled HL7 examinations in IDS5

Examinations scheduled using HL7 are protected from deletion in the PACS. To
remove a scheduled examination from Sectra PACS it must be cancelled. This is
usually performed by the RIS/HIS which sends a cancel message, but that is not
always possible depending on the integration.

You can now cancel such scheduled examinations directly from the examination list
in the IDS5 Information window.

The existing command Delete examination has been renamed to Delete online

examination to better describe its functionality.
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Details

• Change proposal: PCR-HMAN-6EWCBD, released in IDS5_11_1.

• This functionality requires server add-on HL7 RIS Interface.

• For more information, please refer to section 5.3 Working with Examinations.

Searchable and printable user's guide

The online user's guide for IDS5 is now available in a new improved format from
the IDS5 Help menu allowing you to search the online help efficiently.

In addition, the User's Guide IDS5 is now available as PDF together with the Sectra
PACS documentation. The PDFs have clickable links and bookmarks, and are
suitable for A4-printing.

Details

• Change proposal: PCR-MLIT-6FRHBL, released in IDS5_10_2_P3.

• This change only applies to U.S. English and Swedish.

Search the online user's guide, or print it out, to learn about IDS5

Exam administration improved

The examination administration wizard in IDS5 allows the user to move and copy
images between examinations and requests. The actual entering of the new
examination and request ID can now be done semi-automatically. Highly reducing
the risk for manual errors and making the workflow more efficient.

The user can select the proper examination and request IDs from an administration
list, and the selected IDs will be automatically entered in the examination
administration wizard.

Details

• Change proposal: PCR-SMIS-6DUGMA, released in IDS5_10_2_P3.
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• For more information on performing exam administration, please refer to
section 5.4.1 Correcting mismatches.

• For configuration of the administration list, please refer to System
Administrator's Guide IDS5.

Synchronized magnifying glass

Magnifying glass operations can now be applied to several images simultaneously
using synchronization.

The setting is selected in the IDS5 Options dialog, Exam type specific settings tab.

Details

• Change proposal: PCR-MSTK-6J2HVN, released in IDS5_10_2_P3.

• For more information on working with the magnifying glass and synchronization,
please refer to section 7.3 Operations on Images.

• For configuration of synchronized magnifying glass, please refer to section 7.6
Synchronizing Images.

Synchronize the magnifying glass

Automatic synchronization

If synchronization groups are defined in the presentation, they can now be
automatically enabled.

This is very useful in for example the mammography reading scenario, where the
reader no longer needs to press the Sync button for each hanging in order to perform
e.g. the quadrant zoom.

Details

• Change proposal: MKLN-64CB9Y, released in IDS5_10_2_P3.

• For more information on working with synchronization groups in DDPs and
manual presentations, please refer to section 6.5 Creating a DDP and section 7.6
Synchronizing Images.

• The setting is selected in the IDS5 Options dialog, Exam type specific settings
tab.
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Anonymized print

You can choose to display image information on three levels in print-outs: minimum,
maximum and anonymized. When the anonymized level is selected, no patient
information is displayed on the printed images.

The anonymized option is useful for teaching and demonstration purposes.

In addition, the workflow when printing to a DICOM printer has been improved.
The DICOM printer can now be automatically selected, instead of the default
Windows printer, reducing the number of required clicks.

Details

• Change proposal: FOLN-59PK54, PCR-DCOR-6H4N3A, released in
IDS5_10_2_P3.

• For more information on printing images, please refer to section 10.2 Printing
images.

Anonymize printed images

A.1.2 New features in IDS5/mx.net

The double reading for mammography screening in IDS5/mx.net has been improved.

Extended support for multiple window/level settings in DICOM
header

You can quickly step through all defined window/level settings for an image. The
new command Step All W/L applies any settings defined in the image DICOM
header, as well as the IDS5 grayscale presets (as defined in window_level.def).
The window/level settings will be applied in the order they are listed in the image
pop-up menu.
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In earlier releases there was only a command for stepping through the IDS5 grayscale
presets (Step W/L), hence any useful window/level settings given from the modality
in the image DICOM header were previously missed.

Details

• Change proposal: PCR-HLIK-6BV9S2, released in IDS5_11_1.

• When installing an IDS5/mx.net using the mammography utility, no further
configuration is required. The old command Step W/L (CTRL-W) with
automatically be replaced by the new command Step All W/L (CTRL-W) in
the image pop-up menu.

• For more information on stepping through all predefined grayscale settings,
please refer to section 7.3 Operations on Images.

Mirrored synchronization

In certain review situations it is useful to be able to mirror panning and magnifying
operations in synchronized images. This is true, for example, in reading
mammography cases in which breast images are hung chest wall to chest wall.
Mirrored synchronization allows the user to compare corresponding areas in the
left and right breast with the magnifying glass or by panning the zoomed images.

Details

• Change proposal: PCR-HLIK-69UKH3, released in IDS5_10_2_P3.

• For more information on working with mirrored synchronization, please refer
to section 7.6 Synchronizing Images.

• For configuration of mirrored synchronization, please refer to section 12.11
Configuring exam type specific settings and System Administrator's Guide
IDS5.

Mirrored synchronization for efficient comparison

Mammography CAD support in IDS5

The IDS5 will be able to use the content of a Mammography CAD Structured
Report, extract the necessary data and display the findings and, if applicable, to
display more than one layer. IDS5 also displays the name of the CAD vendor, the
SW version and other CAD data.
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A new image symbol notifies the user if any CAD objects are present for the image.
The display function is a simple toggle command controlled from the dedicated
keypad.

Details

• Change proposal: ESEE-53JD76, released in IDS5_10_2_P3.

• For more information on working with double reading and mammography
screening, please refer to section 7.22 Mammography screening and section 7.23
Mammography CAD, Operator's Guide for Sectra Breast Imaging PACS and
Installation guide for Sectra Breast Imaging PACS.

Mammography CAD markers displayed in IDS5

Darker non-image windows

The recommendation for a mammography reading room is that it should be dark
without too much ambient light and disturbing light sources. All bright areas in the
information and matrix windows are disturbing to the reader. This feature will
automatically dim the brightness of the information and matrix windows.

It is possible to configure the darkness of the dim effect and also whether it should
be always on, always off or automatically on when the pointer is moved from the
window.

Details

• Change proposal: PSJN-4UKB25, released in IDS5_10_2_P3.

• For more information on working with dimmed information and matrix window,
please refer to section 10.4 Dimming windows.

• For configuration of dimmed information and matrix window, please refer to
the System Administrator's Guide IDS5.

True blind double reading

IDS5/mx.net now supports true blind double reading, a common scenario in the
mammography screening workflow. This usually means that a second reader should
not be able to see any annotations made by the first reader. Annotations will be
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visible for the creator and users with a specific role only. Typically, the specific role
is a third reader, who will be able to see all annotations created for an examination.

Details

• Change proposal: PCR-ABRN-6EXHB6, released in IDS5_10_2_P3.

• For more information on working with double reading and mammography
screening, please refer to section 7.22 Mammography screening, Operator's
Guide for Sectra Breast Imaging PACS and Installation guide for Sectra Breast
Imaging PACS.

Intelligent double and triple reading commands

Previously, the mammography commands required that the user knew if he/she was
the first or second reading radiologist. Now, there is a new set of commands that
automatically register if the reading result is for the first or second reading.

Also new for this release is support for triple reading. A third code is available
together with new commands and new worklists.

In addition, the mammography commands no longer need to be installed on the
server.

Details

• Change proposal: PCR-ABRN-6AKH4J, released in IDS5_10_2_P2.

• For more information on working with double reading and mammography
screening, please refer to section 7.22 Mammography screening, Operator's
Guide for Sectra Breast Imaging PACS and Installation guide for Sectra Breast
Imaging PACS.

New commands for an improved double reading workflow

A.1.3 Reject Analysis Package

The new workstation package Reject Analysis Package enables the following
functionality.

Reject analysis

IDS5 provides a facility for the user to reject images as an alternative to full delete
of images. Rejected images are stored in the PACS where they are hidden for the
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normal user, but available to authorized users for the purpose of reject analysis.
When performing the reject analysis, the authorized user can view images that have
been rejected due to e.g. poor quality, or images taken for quality control purposes.

Images are rejected by placing them in the reject bin. The user name and the reason
for rejection are stored with the rejected image.

When rejected images are visible to the authorized users, they are marked with the
"Rejected" icon. Authorized users are able to analyze, modify, delete and unreject
images.

Details

• Change proposal: ABRN-5D7HQS, released in IDS5_10_2_P2.

• For more information on working with reject analysis, please refer to section 10.3
Reject analysis.

• For configuration of reject analysis, please refer to System Administrator's Guide
WISE.

Reject bin for rejecting images and worklists for performing reject analysis

Soft delete of images

IDS5 offers functionality that prevents images to be deleted from the system, referred
to as soft delete. Soft delete works as a delete from a user perspective, but images
can be reviewed by an authorized user and either restored or fully removed from
the system. Images are soft deleted by placing them in the reject bin.

Details

• Change proposal: ABRN-5YFQ4N, ABRN-5D7HQS, released in
IDS5_10_2_P2.

• For more information on deleting and restoring images, please refer to
section 6.8 Deleting images.

• For configuration of soft delete, please refer to System Administrator's Guide
WISE.
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B Command short-cuts

The following topics are included in this appendix:

■ General short-cuts

■ Information window short-cuts

■ Matrix window short-cuts

■ Image window short-cuts

■ Quick window short-cuts

■ Stack Tool short-cuts

B.1 General short-cuts

• CTRL + h — Help index

• CTRL + o — On context help

• CTRL + u — Undo

• CTRL + SHIFT + o — Options

B.2 Information window short-cuts

B.2.1 Menubar

• CTRL + f — Search

• F5 — Refresh worklist

• F6 — Fetch RIS data

• F11 — Toggle dictation system

• F12 — Dictate new report

B.2.2 Report pop-up menu

• CTRL + s — Save report

• SHIFT + CTRL + s — Sign report
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B.3 Matrix window short-cuts

B.3.1 Menubar

• NUM 0 — Next hanging

• NUM , — Previous hanging

• SHIFT + c — Unread 1

• SHIFT + d — For discussion 1

• SHIFT + k — OK 1

• SHIFT + m — Set me as reading radiologist

• SHIFT + r — Set me as reading radiologist 1

• SHIFT + s — Select 1

• CTRL + SHIFT + c — Unread 2

• CTRL + SHIFT + d — For discussion 2

• CTRL + SHIFT + r — Set me as reading radiologist 2

• CTRL + SHIFT + k — OK 2

• CTRL + SHIFT + s — Select 2

B.3.2 Icon pop-up menu

• CTRL + c — Copy to clipboard

• CTRL + e — Reset to original

• CTRL + i — Invert

• CTRL + q — Open Quick window

• CTRL + NUM / — Key images: Set all

• CTRL + NUM * — Key images: Reset all

B.4 Image window short-cuts

B.4.1 Menubar

• CTRL + UP ARROW — Move up in the matrix

• CTRL + DOWN ARROW — Move down in the matrix

• F11 — Toggle dictation system
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• F12 — Dictate new report

• NUM 0 — Next hanging

• NUM , — Previous hanging

• SHIFT + c — Unread 1

• SHIFT + d — For discussion 1

• SHIFT + k — OK 1

• SHIFT + m — Set me as reading radiologist

• SHIFT + r — Set me as reading radiologist 1

• SHIFT + s — Select 1

• CTRL + SHIFT + c — Unread 2

• CTRL + SHIFT + d — For discussion 2

• CTRL + SHIFT + k — OK 2

• CTRL + SHIFT + r — Set me as reading radiologist 2

• CTRL + SHIFT + s — Select 2

• LEFT ARROW — Move left

• RIGHT ARROW — Move right

• CTRL + LEFT ARROW — Move left (monitor)

• CTRL + RIGHT ARROW — Move right (monitor)

• UP ARROW — Move up to same series type

• DOWN ARROW — Move down to same series type

B.4.2 Pop-up menu

• CTRL + 1 — 1 x 1 tile mode

• CTRL + 2 — 2 x 2 tile mode

• CTRL + 3 — 3 x 3 tile mode

• CTRL + 4 — 4 x 4 tile mode

• CTRL + a — Automatic crop

• CTRL + b — Toggle crop state

• CTRL + c — Copy to clipboard

• CTRL + d — Save as default

• CTRL + e — Edge enhance
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• CTRL + f — Fetch image

• CTRL + g — Magnifying glass

• CTRL + i — Window/Level: Invert

• CTRL + k — Stop cine

• CTRL + l — Cine loop

• CTRL + m — MPR

• CTRL + n — Adjust images individually

• CTRL + r — Reset image

• CTRL + t — 3D

• CTRL + w — Window/Level: Step W/L

• CTRL + z — Zoom in

• CTRL + NUM / — Key images: Set all

• CTRL + NUM * — Key images: Reset all

• CTRL + NUM + — Group synchronize

• CTRL + NUM - — Release all synchronization

• CTRL + SHIFT + l — Cine bounce

• CTRL + SHIFT + w — Window/Level: Step all W/L

• CTRL + SHIFT + z — Zoom out

• F1 — Window/Level: Min-Max

• F1 — Window/Level: Bone

• F2 — Window/Level: Tumour tissue

• F3 — Window/Level: Coagulated blood

• F4 — Window/Level: Gray brain substance

• F5 — Window/Level: White brain substance

• F6 — Window/Level: Scanogram

• NUM 1 — Key images: Cine to next

• NUM 3 — Key images: Go to next

• NUM 4 — Key images: Fetch left

• NUM 6 — Key images: Fetch right

• NUM 7 — Key images: Cine to previous

• NUM 9 — Key images: Go to previous
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• NUM / — Key images: Set

• NUM * — Key images: Reset

• NUM + — Synchronize

• NUM - — Release synchronization

• SHIFT + q — Quadrant zoom

• SHIFT + z — Toggle zoom

• SHIFT + PAGEUP — Page up

• SHIFT + PAGEDOWN — Page down

• HOME — First image

• END — Last image

• UP ARROW — Fetch newer

• DOWN ARROW — Fetch prior

• PAGEUP — Line up

• PAGEDOWN — Line down

B.5 Quick window short-cuts

B.5.1 Menubar

• ESC — Close Quick window

• LEFT ARROW — Move left

• RIGHT ARROW — Move right

B.5.2 Pop-up menu

• CTRL + 1 — 1 x 1 tile mode

• CTRL + 2 — 2 x 2 tile mode

• CTRL + 3 — 3 x 3 tile mode

• CTRL + 4 — 4 x 4 tile mode

• CTRL + a — Automatic crop

• CTRL + b — Toggle crop state

• CTRL + e — Reset to original

• CTRL + g — Magnifying glass
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• CTRL + i — Window/Level: Invert

• CTRL + k — Stop cine

• CTRL + l — Cine loop

• CTRL + n — Adjust images individually

• CTRL + r — Reset image

• CTRL + z — Zoom in

• CTRL + SHIFT + l — Cine bounce

• CTRL + SHIFT + z — Zoom out

• CTRL + NUM / — Key images: Set all

• CTRL + NUM * — Key images: Reset all

• F1 — Window/Level: Min-Max

• F1 — Window/Level: Bone

• F2 — Window/Level: Tumour tissue

• F3 — Window/Level: Coagulated blood

• F4 — Window/Level: Gray brain substance

• F5 — Window/Level: White brain substance

• F6 — Window/Level: Scanogram

• NUM 1 — Key images: Cine to next

• NUM 3 — Key images: Go to next

• NUM 4 — Key images: Fetch left

• NUM 6 — Key images: Fetch right

• NUM 7 — Key images: Cine to previous

• NUM 9 — Key images: Go to previous

• NUM / — Key images: Set

• NUM * — Key images: Reset

• HOME — First image

• END — Last image

• PAGEUP — Line up

• PAGEDOWN — Line down

• SHIFT + q — Quadrant zoom

• SHIFT + z — Toggle zoom
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• SHIFT + PAGEUP — Page up

• SHIFT + PAGEDOWN — Page down

B.6 Stack Tool short-cuts

• CTRL + a — Select all

• CTRL + i — Invert selection

• CTRL + n — New stack

• CTRL + s — Save & exit

• CTRL + x — Exit
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C Workstation test specification IDS5

The following topics are included in this appendix:

■ Disclaimer

■ Test information

■ Introduction

■ Testing instructions

■ Comprehensive tests

■ Workstation specific tests

■ Testing additional services

■ Testing auxiliary equipment

C.1 Disclaimer

These criteria need to be fulfilled, or the product's CE mark will be invalid:

• tests performed according to this specification must have passed

• the completed test protocol has been sent to Sectra for registration

Else, continued use of the product will waive all guarantees by Sectra of a safe and
effective operation.

Store the completed test record.

C.2 Test information

________________________________________________
Document number (will be filled in

by Sectra):

 [All fields below are mandatory]

________________________________________________Computer-ID:

________________________________________________Name of tester:

________________________________________________Phone (tester):

________________________________________________Test date:

________________________________________________Signature (tester):
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[All fields below are mandatory when performing a new installation of Sectra
IDS5. If the PACS environment has been changed, only state the changes in
hardware and software.]

_______________________________________________________CPU:Hardware

_______________________________________________________
RAM

memory:
 

_______________________________________________________
Graphics

card:
 

_______________________________________________________
Operating

system:
Software

_______________________________________________________
Service

pack:
 

_______________________________________________________

Web

browser

(version):

 

_______________________________________________________
Other

applications:
 

_______________________________________________________  

_______________________________________________________  

_______________________________________________________  

_______________________________________________________  

C.3 Introduction

This document describes the tests mandatory after changing the Sectra PACS
environment. The tests may also be used to verify a new installation of a Sectra
workstation.

The purpose of the tests is to guarantee that the PACS product functions as intended,
i.e. safely and effectively.

The functions of the PACS product needs to be verified whenever a change has
been made to the platform, in order to keep the validity of the CE mark. The PACS
products platform or environment refers to the hardware it has been installed on,
the operating system and all other software. Any peripheral equipment not connected
via a network, e.g. a local laser printer, also counts as part of the platform.

Please note that if tests performed according to this specification hasn't passed, the
product's CE mark is no longer valid. Continued use of the product will waive all
guarantees by Sectra of a safe and effective operation.
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C.4 Testing instructions

This chapter explain how the tests should be performed, and states the test data
needed.

C.4.1 Test user

The user performing the tests must be allowed to perform examination
administration to be able to complete the workstation specific tests for IDS5/dx.net,
IDS5/qa.net and IDS5/send. Contact your system administrator if the test user lacks
this permission.

C.4.2 Independent test data

Note: Access to independent test data is a precondition to be able to complete the
installation tests. Please turn to your system administrator if you need help collecting
independent test data.

If the Sectra test image belonging to patient "Sectra, Sandra" isn't imported and
accessible in the system, import it using the command dcmsendim, as user "wise",
on the WISE host. If you run a Sectra PACS Enterprise Edition HP-UX the image
can be found at /var/opt/sectra/img/, and if you're running Sectra PACS Enterprise
Edition Win or Sectra PACS Clinical Edition the image can be found at
%SECTRA%\WISE\images typically C:\Program Files\Sectra\WISE\images.

If the patient "Sectra, Sandra" isn't available in the system, create this patient and
import an image, which can be modified in a lot of different ways. Create a test
patient with this data:

Sectra, SandraName:

123456-7890Personal ID number:

SEC000001Request number:

1Examination number:

C.4.3 Test method

Perform the tests according to this method:

• Enter the necessary information on the test protocols pages before the table of
contents.

• Follow the instructions in the order described in section C.4.4 Testing order.
Start with test case #1 and continue in due order until all test cases have been
performed.

• In those cases where the 'In data' column has information, enter the in data as
specified in the 'In data' column.

205IDS5, Version 11.1, December 2006 Workstation test specification IDS5



• For every test case, compare the result with the expected result (see the column
'Expected result').

• If the result is correct, check the 'Ok' column.

• If the result is not correct, write 'FAIL' in the 'Ok' column.

• If all applicable tests have the result 'Ok', the equipment is safe to use.

• Sign the test protocol and send it to Sectra (the address can be found at the top
of the document).

C.4.4 Testing order

IDS5/dx.net, IDS5/qa.net,
IDS5/cl.net and IDS5/send

Always start with section C.5 Comprehensive
tests, continue with the correct item in
section C.6 Workstation specific tests,

IDS5/home Start with the correct item in the section C.6
Workstation specific tests, continue with
section C.5 Comprehensive tests and finish
with the remaining sections if it's applicable
for the current workstation.

IDS5/doc.net Start with the correct item in the section C.6
Workstation specific tests, and finish with the
remaining sections if it's applicable for the
current workstation. The "Comprehensive
tests" test is not applicable for IDS5/doc.net.

C.5 Comprehensive tests

CommentsOkExpected resultIn dataTest caseNr.

The examinations that show up in

the list match the search criteria.

Modality = CR

Date = <today's date>

Name = Today's CR

Create a user level worklist with the

following criteria. Then open the

worklist.

1

The examinations that show up in

the list match the search criteria.

Log out and then log in again. Open

the worklist.
2

The folder "Test" should be found

beneath "User worklists".
Test

Create a user level folder by

right-clicking on "User worklists" in

the worklist view, and selecting "New

folder" from the pop-up menu. Name

the folder "Test".

3

The worklist should be found in the

folder "Test" and contain the same

patients as above.

Move the newly created worklist to

the folder "Test" by dragging the

worklist and dropping it in the folder.

4

The "Test" folder and the worklist

"Today's CR" should not be found.
Delete the worklist and the folder.5
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CommentsOkExpected resultIn dataTest caseNr.

The patient's examination(s) and

request(s) are visible in the

Information window.

Submit part of the

patient id using the

criteria "contain", e.g.

"1115" from the

previous example.

Open the search dialog and search

for an existing patient (any patient)

that has one or more examinations

including requests in the system.

E.g. 19731115-1612.

6

All examinations for today should

be visible in the Information

window.

Open the search dialog and perform

a search for today's date.
7

The search should be successful.

Patient's names

available in the system

containing å, ä, ö or

other local characters.

Search for patients whose names

contain local characters (e.g. for

Swedish: å, ä and ö), which differs

from the English language. E.g.

Patient name = Åber*.

8

The Information window and the

patient Sectra, Sandra should be

in focus. The examination should

contain one thumbnail image.

Search for 'Sectra, Sandra' in the

search dialog.
9

The image should be visible.
Open the Matrix window with Sectra,

Sandra selected.
10

The Quick window should open and

the image should be visible.

In the Matrix window; doubleclick the

image icon.
11

The light and contrast should

change in the image.

Change the image's light and

contrast using the mouse wheel.
12

The Information window and the

patient Sectra, Sandra should be

in focus.

Close the Quick window and return

to the Information window.
13

The image should be visible in the

Quick window, with the new

window/level settings .

Double click the thumbnail image for

Sectra, Sandra, to open the Quick

window.

14

The image now contains several

annotations.

Insert Text, Text mark and Line

annotations in the image. Also,

memorize the location of these

annotations, e.g. put them down on

a piece of paper. You will need them

later.

15

The Information window should be

in focus.
Close the Quick window.16

A hanging is now available and

contains the image.

Open the Matrix window and create

a hanging (one monitor 1x1)

containing the image belonging to

Sectra, Sandra.

17

A manual presentation named

Sectra should be saved.

Name = Sectra

Type = User

Save the presentation on the user

level.
18
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CommentsOkExpected resultIn dataTest caseNr.

The measurements should be

visible in the image, as well as the

annotations inserted in the Quick

window. Check that the position of

the annotations has not changed.

Open the image belonging to Sectra,

Sandra in the Image window. Make

some measurements.

19

Make sure that the annotations

and measurements have been

saved and are in the same places

as when they were created.

Change patient and then switch back

to Sectra, Sandra and the Image

window.

20

Make sure that the annotations

and measurementshave been

saved and are in the same places

as when they where created.

Log out from IDS5 and then log in

again. Open the annotated image,

belonging to Sectra, Sandra, in the

Image window.

21

The DDP Editor window should be

in focus.

Open the DDP Editor window from

menu Tools in the Information

window. (Not available in

IDS5/send.)

22

The User's guide should be in

focus.

Close the DDP Editor window and

open the on-line User's guide from

the Help menu.

23

The Log in dialog should be in

focus.

Close the User's guide and log out

from IDS5.
24

C.6 Workstation specific tests

C.6.1 IDS5/dx.net

CommentsOkExpected resultIn dataTest caseNr.

Continued from the comprehensive

tests

The IDS5 starts and the

Information window should be in

focus.

Log in using the same user name

as in above test. (See

Comprehensive tests)

1

The patient Sectra, Sandra should

pop up containing a thumbnail

image.

Request number =

SEC000001
Search for patient Sectra, Sandra.2

The examination has a

presentation, Sectra(M) with one

monitor 1x1.

Open the Matrix window.3
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CommentsOkExpected resultIn dataTest caseNr.

The Image window should open

containing the image for Sectra,

Sandra. The image should contain

the annotations and measurements

made in the section Comprehensive

tests above.

Open the Image window.4

The Key image mark (a flag) should

pop up in the upper right corner.

Set the image to Key image using

Key images/Set from the pop-up

menu.

5

The Information window should be

in focus.
Close the Image window.6

The dialog Examination

Administration is displayed.

Select the first examination for

Sectra, Sandra in the Information

window. Right-click on the

examination and choose the

command Administration/

Examination administration from the

pop-up menu to create a new

examination.

7

A new examination is created for

patient Sectra, Sandra who now

has two examinations, each with

one image.

Request number =

SEC000001

Examination number =

2

Select to copy the contents of

examination 1 to a new examination

for Sectra, Sandra.

8

The Quick window opens containing

the image for Sectra, Sandra. This

image should contain the same

annotations and measurements as

the original image.

Select examination 2 and

double-click the thumbnail image.
9

The light and contrast changes in

the image.

Change light and contrast in the

image using the mouse wheel.
10

The Information window should be

in focus.
Close the Quick window.11

The Image window should be

opened. The light and contrast

settings from previous test case

should be saved for the image in

examination 2.

Double-click on examination 2 in the

examination list to set it as base

examination.

12

Examination 2 should be marked

as base examination and be

expanded.

Open the Matrix window.13

A System presentation should be

saved for examination 2.

Hang the image in examination 2

and save as System presentation.
14

The Image window should open and

contain a system presentation with

the changed window/level settings.

Log out from IDS5 and then log in

again. Find Sectra, Sandra and

double-click on examination 2.

15
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CommentsOkExpected resultIn dataTest caseNr.

The image in examination 2 is

deleted.

Open the Matrix window and delete

the image in examination 2 by

dragging it from the matrix and

dropping it in the Recycle bin. Don't

forget to empty the Recycle bin.

16

The Image window should be

opened and contain the original

image (manual presentation). The

image should be marked as a key

image.

Open the Information window and

select examination 1 as base

examination.

17

The key image flag should no longer

be visible.

Reset the key image by right-clicking

in the image, and selecting Key

image - Reset from the menu.

18

The Information window should be

in focus. Examination 1 should be

base examination.

Close the Image window.19

The examination is deleted and only

one examination remains for

patient Sectra, Sandra

(examination no 1).

Delete examination 2 using the

command Administration/ Delete

online examination.

20

The Report view is editable.

Select examination 1. Create a new

report for the remaining examination

by right-clicking in the Report View

and selecting "Create new report".

21

The new report is now visible in the

Report View of the Information

window.

Write some text and save the

report.
22

It should be possible to see images

on all monitors.

Open the Matrix window and create

a hanging using as many monitors

as there are on the workstation.

Open the Image window.

23

C.6.2 IDS5/qa.net

CommentsOkExpected resultIn dataTest caseNr.

Continued from the comprehensive

tests (above)

The IDS5 starts and the

Information window should be in

focus.

Log in using the same user name

as in the Comprehensive tests test

above.

1

The patient Sectra, Sandra should

pop up containing a thumbnail

image.

Request number =

SEC000001
Search for patient Sectra, Sandra.2
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CommentsOkExpected resultIn dataTest caseNr.

The examination has a

presentation, Sectra (M) with one

monitor 1x1.

Open the Matrix window.3

The Image window should open

containing the image for Sectra,

Sandra. The image should contain

the annotations and measurements

made in the section Comprehensive

tests above.

Open the Image window.4

The Information window should be

in focus.
Close the Image window.5

The dialog Examination

Administration is displayed.

Select the first examination for

Sectra, Sandra in the Information

window and choose the command

Administration/ Examination

administration to create a new

examination.

6

A new examination is created for

patient Sectra, Sandra who now

has two examinations, each with

one image.

Request number =

SEC000001

Examination number =

2

Select to copy the contents of

examination 1 to a new examination

for Sectra, Sandra.

7

The Quick window opens containing

the image for Sectra, Sandra. This

image should contain the same

annotations and measurements as

the original image.

Select examination 2 and

double-click the thumbnail image.
8

The light and contrast changes in

the image.

Change light and contrast in the

image using the mouse wheel.
9

The Information window should be

in focus.
Close the Quick window.10

The Image window should be

opened. The light and contrast

settings from previous test case

should be saved for the image in

examination 2.

Double-click on examination 2 in the

examination list to set it as base

examination.

11

Examination 2 should be marked

as base examination and be

expanded.

Open the Matrix window.12

A System presentation should be

saved for examination 2.

Hang the image in examination 2

and save as System presentation.
13

The Image window should open and

contain a system presentation with

the changed window/level settings.

Log out from IDS5 and then log in

again. Find Sectra, Sandra and

double-click on examination 2.

14
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CommentsOkExpected resultIn dataTest caseNr.

The image in examination 2 is

deleted.

Open the Matrix window and delete

the image in examination 2 by

dragging it from the matrix and

dropping it in the Recycle bin. Don't

forget to empty the Recycle bin.

15

The Image window should be

opened and contain the original

image (manual presentation).

Open the Information window and

select examination 1 as base

examination.

16

The Information window should be

in focus. Examination 1 should be

base examination.

Close the Image window.17

The examination is deleted and only

one examination remains for

patient Sectra, Sandra

(examination no 1).

Delete examination 2 using the

command Administration/ Delete

online examination.

18

The Report view is editable.

Select examination 1. Create a new

report for the remaining examination

by right-clicking in the Report View

and selecting "Create new report".

19

The new report is now visible in the

Report View of the Information

window.

Write some text and save the

report.
20

C.6.3 IDS5/cl.net

CommentsOkExpected resultIn dataTest caseNr.

Continued from the comprehensive

tests (above)

The IDS5 starts and the

Information window should be in

focus.

Log in using the same user name

as in the Comprehensive tests test

above.

1

The patient Sectra, Sandra should

pop up containing a thumbnail

image.

Request number =

SEC000001
Search for patient Sectra, Sandra.2

The examination has a presentation

(Sectra) with one monitor 1x1.
Open the Matrix window.3

When using a two-monitor system

it should be possible to see both

the image and the Matrix window.

The image should contain the

annotations made in the section

Comprehensive tests above.

Open the Image window.4
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C.6.4 IDS5/home

CommentsOkExpected resultIn dataTest caseNr.

The IDS5 starts and the

Information window should be in

focus.

Log in using the same user name

as in the Comprehensive tests test

above.

1

The images should not be visible

but the image icon should say

'Remote image'.

Select an examination and open the

Matrix window.
2

The examinations can be opened

on the workstation and the

image(s) should be visible (in the

Image window).

Return to the Information window

and retrieve examinations using the

command 'Fetch remote images'.

3

The examinations can be opened

on the workstation and the

image(s) should be visible (in the

Image window).

Retrieve an examination using

Teleradiology.
4

The patient Sectra, Sandra should

be available on your IDS5/home

workstation.

Retrieve to the workstation,

examination 1 for patient Sectra,

Sandra.

5

The examinations including added

changes are available in the

system, i.e. they should be visible

using another IDS5.

Create a hanging, add annotations

and set the image as key image.
6

Continue with the section

comprehensive tests above.

C.6.5 IDS5/send

CommentsOkExpected resultIn dataTest caseNr.

Continued from the comprehensive

tests (above)

The IDS5 starts and the

Information window should be in

focus.

Log in using the same user name

as in the Comprehensive tests test

above.

1

The patient Sectra, Sandra should

pop up containing a thumbnail

image.

Request number =

SEC000001
Search for patient Sectra, Sandra.2

The examination has a

presentation, Sectra (M) with one

monitor 1x1.

Open the Matrix window.3
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CommentsOkExpected resultIn dataTest caseNr.

The Image window should open

containing the image for Sectra,

Sandra. The image should contain

the annotations and measurements

made in the section Comprehensive

tests above.

Open the Image window.4

The Information window should be

in focus.
Close the Image window.5

The dialog Examination

Administration is displayed.

Select the first examination for

Sectra, Sandra in the Information

window and choose the command

Administration/ Examination

administration to create a new

examination.

6

A new examination is created for

patient Sectra, Sandra who now

has two examinations, each with

one image.

Request number =

SEC000001

Examination number =

2

Select to copy the contents of

examination 1 to a new examination

for Sectra, Sandra.

7

The Quick window opens containing

the image for Sectra, Sandra. This

image should contain the same

annotations and measurements as

the original image.

Select examination 2 and

double-click the thumbnail image.
8

The light and contrast changes in

the image.

Change light and contrast in the

image using the mouse wheel.
9

The Information window should be

in focus.
Close the Quick window.10

The Image window should be

opened. The light and contrast

settings from previous test case

should be saved for the image in

examination 2.

Double-click on examination 2 in the

examination list to set it as base

examination.

11

Examination 2 should be marked

as base examination and be

expanded.

Open the Matrix window.12

A System presentation should be

saved for examination 2.

Hang the image in examination 2

and save as System presentation.
13

The Image window should open and

contain a system presentation with

the changed window/level settings.

Log out from IDS5 and then log in

again. Find Sectra, Sandra and

double-click on examination 2.

14

The image in examination 2 is

deleted.

Open the Matrix window and delete

the image in examination 2 by

dragging it from the matrix and

dropping it in the Recycle bin. Don't

forget to empty the Recycle bin.

15
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CommentsOkExpected resultIn dataTest caseNr.

The Image window should be

opened and contain the original

image (manual presentation).

Open the Information window and

select examination 1 as base

examination.

16

The Information window should be

in focus. Examination 1 should be

base examination.

Close the Image window.17

The examination is deleted and only

one examination remains for

patient Sectra, Sandra

(examination no 1).

Delete examination 2 using the

command Administration/ Delete

online examination.

18

Examination 1 now contains two

images.

Open the Matrix window and scan

an image for examination 1.
19

Verify that the examination has

arrived at the teleradiology

destination and contains two

images. One of the images should

contain annotations and

measurements.

Return to the Information window.

Choose to send examination 1 to the

system (server) using Teleradiology.

20

C.6.6 IDS5/doc.net

CommentsOkExpected resultIn dataTest caseNr.

Verify that the scanned requests

are visible and are visually correct.

Scan several requests for Sectra,

Sandra.
1

C.7 Testing additional services

The functions below might not be installed and configured on your system. If the
functions should be available, make sure that they are available on the workstation
you use for this test. Information about additional services can be obtained from
your system administrator.

C.7.1 CAI (Clinical Applications Interface)

CommentsOkExpected resultIn dataTest caseNr.

Verify that they start as expected.

Start the externally connected

additional services (Clinical

Applications).

1
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C.7.2 DICOM Print

CommentsOkExpected resultIn dataTest caseNr.

The image should be printed with

an acceptable quality.

Open the image belonging to Sectra,

Sandra in the Image window and

print it.

1

C.7.3 Document scanner

CommentsOkExpected resultIn dataTest caseNr.

Verify that the request ends up

with the correct patient and is

properly formatted.

Scan a valid request with a correct

barcode.
1

C.7.4 Multi monitor system

CommentsOkExpected resultIn dataTest caseNr.

Verify that the images pop up on

all the monitors.

Open an examination with hangings

for more than two monitors.
1

C.7.5 Image scanning

CommentsOkExpected resultIn dataTest caseNr.

The Patient Sectra, Sandra should

have at least one empty

examination.

Personal ID nr =

123456-7890

Name = SECTRA,

SANDRA

Request-ID =

SEC000001

Examination-ID = 2

Create an empty examination for

Sectra, Sandra.
1

The scan should work as expected

and the image should pop up as an

image icon in the Matrix window.

Open the Matrix window and scan

an image for examination 2.
2

C.7.6 The MPR module

CommentsOkExpected resultIn dataTest caseNr.

The MPR module should open as

expected.
Open a stack using the MPR module.1

Scrolling should work as expected.Scroll a couple of times in the image.2
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C.7.7 The Orthopedic module

CommentsOkExpected resultIn dataTest caseNr.

The Orthopedic module should start

and it should be possible to add

and adjust a template.

Open an image of a hip using the

Orthopedic module. Add a template

and adjust it to fit.

1

The template is still attached to the

correct image.

Change patient and then back again

to the image with the template, see

above.

2

The image is returned to its original

state.

Delete the template and return the

image to its original state.
3

C.7.8 CD Export

CommentsOkExpected resultIn dataTest caseNr.

A worklist (teaching file list) is

available with at the most five

examinations.

Create a worklist (teaching file list)

containing at the most five

examinations.

1

The patients are exported to the

CD.
Perform a CD-export.2

The correct patients and

examinations should be available

on the CD.

Verify the contents of the CD.3

Verify that the correct patients and

images are available and can be

viewed in the opened CD viewer

application.

Click the file run_cdviewer.exe which

should be available on the CD.
4

C.7.9 Teleradiology

CommentsOkExpected resultIn dataTest caseNr.

The annotations and patient

information should be available

where they where annotated.

If it hasn't been done before, create

some annotations for the image

belonging to Sectra, Sandra. Send

the image to a recipient.

1
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C.8 Testing auxiliary equipment

C.8.1 Microphones

CommentsOkExpected resultIn dataTest caseNr.

The dictation should be saved and

it should be possible to play it.

Use the microphone and save a

dictation for the patient Sectra,

Sandra.

1

C.8.2 Scanners

CommentsOkExpected resultIn dataTest caseNr.

The scanned image(s) and/or

request(s) should be available in

the system.

Scan image(s) and/or request(s).1

C.8.3 Printers

CommentsOkExpected resultIn dataTest caseNr.

It should be possible to print

images.
Print image(s).1

C.8.4 Alternative login devices

CommentsOkExpected resultIn dataTest caseNr.

You should be logged into the IDS5

and the Information window should

be in focus.

Register a new user and tie the log

in to the device, e.g. fingerprint

reader or swipe card.

1

You should automatically be logged

in and the Information window

should be in focus.

Log out and log in using the device.2

C.8.5 Barcode reader

CommentsOkExpected resultIn dataTest caseNr.

The Search dialog forms should be

completed and the search a

success.

Open the Search dialog and search

for request number. Use the

barcode reader and scan an existing

request.

1
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C.8.6 Hardware accelerated graphics cards

CommentsOkExpected resultIn dataTest caseNr.

The hardware acceleration is set

correct if continuous zoom is

working satisfactory.

Open an image in the Image window

and do a continuous zoom (CTRL +

left mouse button, drag mouse

up/down).

1
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